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Preface 

Welcome to the A/UX® 2.0 operating system on your Macintosh® 
computer. A/UX 2.0 brings the Macintosh interface to the traditional 
UNIX® environment. It weds Macintosh ease of use to UNIX standards, 
power, and programmability. 

This book, AJUX Essentials, presents the basic skills you need to use 
A/UX 2.0. Many of the chapters contain tutorials to help you learn the 
essential techniques and concepts. You can read through this guide in 
sequence or go directly to the information you need. However, if you are 
unfamiliar with A/UX, you should go through the first four chapters before 
proceeding on your own. 

This chapter contains the following sections: 

• What is A/UX 2.0? 

• Who should use this guide? 

• How to use AJUX Essentials 

• Conventions used in this guide 
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What is A/UX 2.0? 

A/UX 2.0 brings together two outstanding computing environments: the UNIX and the 
Macintosh environments. 

Why UNIX? 

The UNIX operating system has become very important because it is a standards-compliant, 
multitasking, multi-user operating system. 

A multitasking system is one that allows you to run many processes at the same time. Thus, 
instead of having to wait while your computer prints a text file, you can work on another 
project while the printing is in progress. 

A multi-user system allows many users to work on the same system at the same time. This 
allows them to share files and information. 

The basic A/UX operating system is a combination of the best of the UNIX systems 
(UNIX System V.2 plus extensions from BSD 4.2 and 4,3). 

Why the Macintosh interface? 

A/UX 2.0 enhances the AlUX operating system with the Macintosh FinderTM interface. This 
enhancement differentiates A/UX 2.0 from all other versions of UNIX. With A/UX 2.0 you can 
do the following: 

• Use menu commands and manipulation of icons to open, move, rename, or copy files and 
applications on the A/UX and the Macintosh file systems simultaneously. 

• Store Macintosh files and applications in the A/UX file system as well as in the Macintosh 
file system. 

• Use the Macintosh files or off-the-shelf Macintosh applications while running A/UX exactly 
as you use them while running the Macintosh Operating System. This is true whether they 
are stored under the A/UX file system or a Macintosh file system. 
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• Run several applications at the same time, taking advantage of both Macintosh 
functionality and A/UX multitasking capabilities. You can run several Macintosh 
applications simultaneously as well as A/UX applications. 

Commando, a command-building tool 

In addition to wedding the Finder's ease of use to the capabilities of UNIX, A/UX 2.0 also adds 
dialog boxes for running almost all of the more than 500 hundred UNIX commands available in 
A/UX. This means that you can now use the many options and utilities that UNIX and A/UX 
make available without having to learn the complex commands and options themselves. Each 
dialog box allows you to use the mouse to select the options. 

Commando is described in full in Chapter 4, "Using Commando." 

Two ftIe systems on one personal computer 

Without having to stop and restart the computer, you can run Macintosh software 
applications while using A/UX. Furthermore, you can do so while A/UX processes are running. 

A/UX 2.0 allows you to have both the A/UX file system and the Macintosh file system on the 
same computer. It is important to remember that you do not need to run your Macintosh 
applications from a Macintosh file system. Although A/UX 2.0 is shipped with a small 
Macintosh file system (called MacPartition), from which A/UX is launched, you can store your 
Macintosh applications as well as your Macintosh files under your A/UX 2.0 file system. You 
can also move Macintosh files into the A/UX file system to gain the advantages of using 
A/UX file-access permissions and A/UX backup tools. 

In addition, while running A/UX 2.0 you can use floppy disks that are configured for the 
Macintosh and additional Macintosh HFS hard disks. 

Thus, you can take advantage of the functionality of both operating systems at the 
same time. 
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Who should use this guide 

AlUX Essentials contains information that is important to anyone who plans to use A/UX 2.0. 
It presents concise tutorials that introduce you to the Macintosh way of interacting with the 
traditional UNIX environment and information summaries that briefly explain the 
functionality of essential parts of A/UX. 

Although everyone who uses A/UX 2.0 should consult AlUX Essentials to become familiar with 
the new look and functionality of A/UX 2.0, this guide is particularly designed for users who are 
not experienced with A/UX or other versions of UNIX. It will also prove useful to those who are 
somewhat new to the Macintosh computer, although this guide assumes that you are already 
familiar with the basic Macintosh skills. You should be sure to read Macintosh User's Guide: 
Essentials and to follow the tour disk, A Tour of Your Macintosh. 

The road map diagram, just before the beginning of the Table of Contents, illustrates the 
learning path for A/UX 2.0. 

How to use A/UX Essentials 

This guide is meant to be an introduction to A/UX 2.0. You should read at least the first four 
chapters and work through the tutorials in those chapters. Once you are comfortable with the 
basics of A/UX 2.0, you may want to use this book as a reference work. 

If you are familiar with earlier versions of A/UX (or other versions of UNIX) and with the 
Macintosh Finder, you may need only to scan through the table of contents or the index to 
locate information that is new to you. 
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AlUX Essentials contains the following chapters: 

• Chapter 1, "Starting and Finishing a Work Session," teaches you how to start the system, 
log in, log out, and move between A/UX and the Macintosh Operating System. Chapter 1 
also introduces other skills and information essential to getting started. 

• Chapter 2, "Getting Around in A/UX," teaches you how to manipulate the A/UX file 
system and use files and folders. It also introduces you to essential information about 
access permissions. 

• Chapter 3, "Customizing Your Work Environment," explains how to use the Control Panel 
and other devices to create precisely the work environment that you need. 

• Chapter 4, "Using Commando," describes a major innovation of A/UX 2.0, Commando, 
which allows you to run UNIX and A/UX commands with Macintosh-like dialog boxes. 

• Chapter 5, "Using CommandShell," shows you how to use the A/UX command-line interface 
in a CommandS hell window. This allows you to work directly with the A/UX operating 
system using traditional UNIX commands. 

• Chapter 6, "Writing With TextEditor," is an introduction to the Macintosh-style text 
editor, which allows you to create and edit text-only files using the Macintosh menus 
and a mouse. 

• Chapter 7, "Printing in A/UX," describes the different kinds of printer connections and the 
various ways of sending a file to the printer while using A/UX. 

• Chapter 8, "Communicating With Others," describes ways of sending mail and messages to 
other A/UX users. 

• Chapter 9, "A/UX Reference," presents a brief summary of all menus and menu commands in 
the A/UX Finder, CommandShell, and TextEditor. 

• Chapter 10, "Troubleshooting," shows how to solve some problems that may arise while you 
are using NUX 2.0. 

• Chapter 11, "Where to Go From Here," gives you information on resources available for 
learning more about A/UX. 

• The Glossary contains definitions of all A/UX terms newly introduced in this guide. 
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Terminology: UNIX-style plus Macintosh-style 

Although A/UX 2.0 weds two traditions, UNIX and Macintosh, these two environments imply 
two different traditions of terminology. For example, Macintosh users are all familiar with the 
word "folder." It represents essentially what UNIX users call a "directory." The term "folder" is 
particularly meaningful when you are using the Finder, where it is represented by a file-folder 
icon. When you are entering commands in a CommandShell window, however, it's best to think 
of it as a directory, especially when you are entering such commands as "make directory" 
(rnkdir) or "change directory" (cd). 

For that reason, this guide uses Macintosh terminology when describing how to work with the 
Finder and traditional A/UX (or UNIX) terminology when describing operations done in a 
CommandShell window. 

Conventions used in this guide 

A/UX guides follow specific conventions. Words that require special emphasis appear in 
specific fonts or font styles. The following sections describe the conventions used in all 
A/UX guides. 

Keys and key combinations 

Certain keys on the keyboard have special names. These modifier and character keys, often 
used in combination with other keys, perform various functions. In this guide, the names of 
these keys are in Initial Capital Letters followed by SMALL CAPITAL letters. 
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The key names are 

CAPS LOCK 
COMMAND 

ESCAPE SHIFT 
LEFT ARROW TAB 

CONTROL RETURN UP ARROW 
DOWN ARROW RIGHT ARROW 

For example, suppose you enter 
Applee 

instead of 
Apple 

To erase the additional e, you would position the cursor (or insertion point) to the right of the 
word and press the DELETE key once. 

Sometimes you will see two or more names joined by hyphens. The hyphens indicate that you 
use two or more keys together to perform a specific function. For example, 

Press COMMAND-K 

means "Hold down the COMMAND key and press the K key." 

Terminology 

In A/UX guides, a certain term can represent a specific set of actions. For example, the word 
enter indicates that you type an entry and press the RETURN key. The instruction 

Enter 1 s 

means "Type 1 s and press the RETURN key." 
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Here is a list of common terms and the corresponding actions you take. 

Term 

Choose 

Click 
Drag 

Enter 
Press 

Select 
Type 

Action 

Activate a command in a menu. To choose a command from a pull-down 
menu, click once on the menu title while holding down the mouse button, 
and drag down until the command is highlighted. Then release the 
mouse button. 
Press and then immediately release the mouse button. 
Position the pointer on an object, then press and hold down the mouse 
button while moving the mouse. Release the mouse button when the 
object reaches the desired position on the screen. 
Type the letter or letters and press the RETURN key. 
Type a single key without pressing the RETURN key. Or position the 
pointer on an object and hold down the mouse button. 
Position the pointer on a selectable object and click the mouse button. 
Type an entry without pressing the RETURN key. 

The Courier font 

Throughout A/UX guides, words that you see on the screen or that you must type exactly as 
shown are in the Courier font. 

For example, suppose you see the instruction 

Type date on the command line and press RETURN. 

The word da t e is in the Co uri e r font to indicate that you must type it. 
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Suppose you then read this explanation: 

Once you type date and press RETURN, you'll see something like this: 
Tues Oct 17 17:04:00 PDT 1989 

In this case, Courier is used to represent exactly what appears on the screen. 

All A/UX manual page names are also shown in the Courier font. For example, the entry ls(1) 

indicates that 1 s is the name of a manual page. 

Font styles 

Words that you must replace with a value appropriate to a particular set of circumstances 
appear in italics. For example, if you see 
cat filename 

replace the italicized word with the name of the file you wish to view. If you want to view the 
contents of a file named E 1 vis, type the word E 1 vis in place of filename. In other words, 
enter 
cat Elvis 

New terms appear in boldface where they are defined. 

A/UX command syntax 

A/UX commands follow a specific command syntax. A typical A/UX command has 
this form: 
command (flag-option] [argument]... 
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The following table outlines the elements of an A/UX command. 

Element 

command 

flag-option 

argument 

[] 

Description 

The command name. 
One or more optional arguments that modify the command. Most flag 
options have the form [-opt ... ]' where opt is a letter representing an option. 
Most commands have one or more flag options. 
A modification or specification of a command, usually a filename or 
symbols representing one or more filenames. 
Brackets used to enclose an optionqJ item-that is, an item that is not 
essential for execution of the command. 
Ellipses used to indicate an argument that can be repeated any number 
of times. 

For example, the wc command is used to count lines, words, and characters in a file. Here 
is the full syntax for that command, including all possible flag options and the optional 
argument name. 
wc [-c] [-1] [-w] [name .. .] 

Thus, you can enter 
wc -w /Prisci11a 

to count all of the words in the file /Prisci11a, where wc is the name of the command, -w is 
the flag option that instructs the command to count all of the words in the file, and the 
optional argument / P r is c ill a is the file to be searched. 
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Command reference notation 

A!UX Command Reference, A!UX Programmer's Reference, and A!UX System Administrator's 
Reference contain references for commands, programs, and other related information. Material 
is organized within these references by section numbers. The standard A/UX cross-reference 
notation is 

cmd (sect) 

where cmd is the name of the command, file, or other facility; sect is the section number where 
the entry resides. 

• Items followed by section numbers (IM), (7), or (8) are listed in 
A!UX System Administrator's Reference. 

• Items followed by section numbers (1), (Ie), (IG), (IN), and (6) are listed in 
A!UX Command Reference. 

• Items followed by section numbers (2), (3), (4), and (5) are listed in 
A!UX Programmer's Reference. 

For example, 
ca to) 

refers to the command cat, which is described in Section 1 of A!UX Command Reference. 

References can be also called up on the screen. Use the man command to display pages 
from reference manuals, known as manual pages, directly on the screen. For example, enter 
the command 
man cat 

to display the manual page for the cat command, including its description, syntax, options, 
and other pertinent information. To exit, press the Space bar until you see a shell prompt, or 
type q at any time to return immediately to your shell prompt. 
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Cross-referencing 

An A/UX guide often refers to information discussed in another guide in the suite. The format 
for this type of cross-reference is "Chapter Title," Name of Guide. 

For a complete description of A/UX guides, see Road Map to AlUX This guide contains 
descriptions of each A/UX guide, part numbers, and ordering information for all the guides in 
the A/UX documentation suite. 
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Chapter 1 Starting and Finishing a Work Session 

This chapter explains how to start a work session and what to do when 
you're ready to quit working for the time being. It also explains how to 
shut down the computer and how to get to the Macintosh® Operating 
System (Macintosh OS). 

Before using this guide, you need to know basic Macintosh skills, such as 
clicking, dragging, pulling down menus and choosing from them, and using 
Macintosh windows. If you are new to the Macintosh computer, take the 
tour on the tour disk provided with your Macintosh computer or read the 
appropriate sections in the Macintosh User's GUide; Essentials. 

This chapter contains the following sections: 

• Starting the computer 

• Starting A/UX 

• Logging in 

• Login options 

• Logging out 

• Looking up A/UX and UNIX commands on line 

• Working with Macintosh files in A/UX 

• Getting to the Macintosh OS 

• Getting your bearings 

• Shutting down A/UX 

• About system administration 

Although you may find it useful to go through this entire chapter in 
sequence, you may also use it as a reference work by going directly to the 
appropriate section. 
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Starting the computer 

Before you start the computer, you or the system administrator should set up your hardware 
according to the instructions that were packaged with it, and should install A/UX® 2.0 by 
following the directions in the AlUX Installation Guide. You also may connect and configure 
peripheral devices by using Setting Up Accounts and Peripherals for AlUX. 

Turn on the power as follows: 

• Press the POWER ON key, which is shown in Figure 1-1. 

The POWER ON key is the key with a small triangle. It is at the top of the keyboard in 
the middle or the right corner. 

• Figure 1-1 The POWER ON key 
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If you are using a Macintosh SE-30, turn on the computer with the power switch at 
the back of the machine. 

The computer begins working and displays the message: "Welcome to Macintosh." This 
message indicates that the computer is searching for system software. If A/UX Startup is 
set as the startup application on your startup disk, the system automatically goes through 
the loading and launching process. Continue with the section called "Loading and Launching," 
later in this chapter. 

Starting A/UX 

As shipped, A/UX does not start up automatically unless you or the system administrator set it 
to start automatically. Although the installation instructions advise setting automatic startup, 
your system may be set for manual startup of A/UX. 

Setting automatic A/UX startup 

If your system has not been set to start A/UX automatically, you can set it to do so after the 
MacPartition disk icon is displayed (Figure 1-2), and before you start A/UX manually. Follow 
these steps: 

1. Double-click the MacPartition icon to open the MacPartition window. 

2. Select the A/UX Startup icon by highlighting it. Do not double-click 
the icon. 

3. Choose Set Startup from the Special menu. 

4. Select A/UX Startup. 

5. Click OK. 

For further information on setting automatic A/UX Startup, see AlUX Local 
System Administration. 
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Starting A/UX manually 

If A/UX Startup is not set as the startup application, you need to run the A/UX Startup 
application manually. Follow these steps to start up A/UX: 

1. Locate the disk called MacPartition. 

A disk icon labeled MacPartition (Figure 1-2) is located near the right edge of 
the screen. 

• Figure 1-2 The MacPartition icon 

I. 
MacP artition 

This icon represents a small part of your disk space that contains the Macintosh file 
system. The A/UX Startup program, which is used to launch the A/UX operating 
system, is contained here. 

2. Double-click the MacPartition icon. 

Figure 1-3 shows the contents of the MacPartition disk. 

• Figure 1-3 MacPartition 

MacPartition 
6 items 1 ,654K in disk 359K av ailab Ie 

LiJ LJ cRI 
c::;:~ 

A/UX 
Sy stem Folder bin Alux Startup 
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3. Double-click the A/UX Startup icon to launch AlUX. 

Position the pointer over the icon and double-click to open the application. A/UX 
moves through the loading and launching process. 

Loading and launching 

As A/UX Startup runs, a series of screens appears that inform you of the progress of the 
startup. One of these screens is shown in Figure 1-4. 

• Figure 1-4 A startup screen 

c ~I Welcome to n/UH. 
s:~ 

A/UX Checking root file system ... 

Your screen displays the status of the startup process. The A/UX Startup application performs 
a check of the file systems each time you start A/UX and prompts you to fix any file-system 
problems identified during the check. For example, problems may be caused if the system was 
shut down improperly the last time it was used. These problems usually are corrected during 
this file-system check. This check may last for several minutes. 

D Important A/UX may report alert messages during the startup sequence. In some 
cases, you need to supply information in response to the message. 
When you click OK in the alert box, a window appears, into which 
you can enter any information that the program requests. 6 
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At the end of the startup process, the Login dialog box appears. Proceed with the 
next section ("Logging In") to learn about logging into different accounts in A/UX. 

Logging in 

You start working with A/UX by logging in to the system. Unlike the Macintosh as, 
A/UX supports many user accounts on a single computer. Therefore, the process of 
logging in is necessary to tell the system what account you're permitted to use and 
to place you in that account. 

The Login dialog box 

When you log in, you give the system two pieces of information: 

• your login name 

• your password 

You may log in to several types of accounts: 

• the root account for system administrators 

• the start account for tutorials 

• the Guest account for guest users 

• your own user account (if the system administrator has assigned you one) 

This section describes how to log in to these accounts. 

As soon as A/UX Startup has finished running, the Login dialog box appears. You can log in 
whenever you see the Login dialog box, which is shown in Figure 1-5. 

• Note: A group of login options is available to you while the Login dialog box is 
displayed. These options include changing your password and changing your session 
type. These login options are explained later in this chapter. See "Login Options." 
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• Figure 1-5 The Login dialog box 

c ~I Welcome to R/UH. 
<=1""% 

A/UX 

log in 8S: 

o Guest 
@ Regi stered User 

,...-----------, 

Name: 

Password: I 
'--------------' 

n login )] 

To log in means to enter the name that identifies an account and to enter the account's 
password (if required). The three sections that follow describe how to log in to the start 
account, the Guest account, and the user and root accounts. Refer to the section of this 
chapter that describes how to log in to the account you wish to use. 

6, Important A/UX is case sensitive, that is, it distinguishes between uppercase 
and lowercase letters. If your login name is supposed to be john, 

but you type John, A/UX won't recognize it because of the 
uppercase J. This is true of all character strings that A/UX reads, such 
as commands, passwords, folder names, and so on. 6 

Logging in for the tutorials 

The start account contains the files associated with the various tutorials in this book. You 
should log in to this account whenever you're using a tutorial presented in this guide. 

To log in to the start account, follow these steps: 
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1. While the Login dialog box is displayed, click the Registered User button, 
unless it is already selected. 

2. Type start as the login name. 

The login name for the tutorial account is s tart. Notice that all the letters in the 
name start are lowercase. Remember to enter the login name exactly as specified, 
using lowercase letters unless capital letters are specified. 

3. Press RETURN. 

This action moves the cursor to the Password text box. You can also press TAB or 
click the Password text box to move there. A/UX asks you for a password to ensure 
system security. Each account has a password so that only the person who is entitled 
to use that account has access to it. To change the password for your account, see 
"Changing Your Password," later in this chapter. 

4. Type my .passwd or use the password given to you by the 
system administrator. 

A gray rectangle expands through the Password text box as you type each character. 

Since the password my. passwd appears in this book, it's a good idea to change 
this password immediately, to prevent anyone from breaking into your system 
by using the start account. Your system administrator may already have changed 
the password. 

See "Changing Your Password," later in this chapter, for more information on security 
and passwords. 

5. Click Login or press RETURN. 

If the password and the login name are correct, you're logged in. If you type the wrong login 
name or password, a warning dialog box appears. Try again, and be sure that you are typing 
lowercase and uppercase letters as required. 
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If you made a mistake while typing your login name or password, you can use either of two 
methods to correct your typing: 

• Press DELETE once to erase the last character you typed. Repeat this action 
to erase additional single characters. 

• Select a block of text by dragging over it and then press DELETE. 

You can type the login name or password again. 

Proceed to "You're Ready to Work," later in this chapter. 

Logging in to the Guest account 

If your system administrator has not set up a personal login account for you, you can use the 
Guest account. 

To log in to the Guest account, follow these steps: 

1. While the Login dialog box is displayed, click Guest. 

This Login dialog box may be slightly different from the one in Figure 1-5. For 
example, the text box for the password may be missing. 

2. Click Login or press RETURN. 

The system administrator may have set up the system so that you do not need to 
enter the Guest account password. 

D If you aren't required to enter a password, the Name and Password fields do not 
appear when you click the Guest radio button. 

D If the Name and the Password fields appear in the Login dialog box, you need a 
password. As configured upon shipment, A/UX allows you simply to press 
RETURN twice after you type your account name, which in effect enters a blank 
password. 

D For the sake of system security, the system administrator may set a password. If 
you are required to enter a password, see your system administrator or the 
person in charge of the Guest login account. 
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See "Changing Your Password," later in this chapter, for more information on security 
and passwords. 

If the password and the login name are correct, you're logged in. Proceed to "You're Ready 
to Work," later in this chapter. 

If you made a mistake while typing your login name or password, you can use either of two 
methods to correct your typing: 

• Press DELETE once to erase the last character you typed. Repeat this action 
to erase additional single characters. 

• Select a block of text by dragging over it and then press DELETE. 

You can type the login name or password again. 

Logging in to your user account or the root account 

Your personalized user account allows you full use of the files, programs, and utilities that you 
created or that the system administrator created for you. It also contains files that specify 
preferences about your work habits, such as the pattern of your desktop. Your system 
administrator has set up the account by using the adduser script described in A/[;X Local 
System Administration or by following standard A/UX procedures for setting up a user account. 
You should log in to this account whenever you're working with A/UX (but log in to the start 
account when using the tutorials in this book). 

You can also use these instructions to log in to the root account provided for system 
administration tasks. Substitute the name root for your user name. 

To log in to your user account or the root account, follow these steps: 

1. While the Login dialog box is displayed, click the Registered User button, 
unless it is already selected. 
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2. Type your login name. 

If you are logging in to the root account, type root. If you are logging in to a user 
account, type the login name assigned to you by your system administrator. 
Remember to enter the login name exactly as specified, using lowercase letters unless 
capital letters are specified. 

If the system administrator created your user account without assigning a password, 
you may be asked to assign your own password by typing it into the space provided. 

3. Press RETURN. 

This action moves the cursor to the Password text box. You can also press TAB or 
click the Password text box to move the cursor here. A/UX asks you for a password 
to ensure system security. Each account has a password so that only the person who 
is entitled to use that account has access to it. To change your account password, 
see "Changing Your Password," later in this chapter. 

4. Type your password. 

A gray rectangle expands through the Password text box as you enter each character. 

5. Click Login or press RETURN. 

If the password and the login name are correct, you're logged in. Proceed to the 
section called "You're Ready to Work." 

If you made a mistake while typing your login name or password, you can use either of two 
methods to correct your typing: 

• Press DELETE once to erase the last character you typed. Repeat this action 
to erase additional single characters. 

• Select a block of text by dragging over it and then press DELETE. 

You can type the login name or password again. 
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You're ready to work 

The A/UX FinderTM interface now appears, as shown in Figure 1-6. This is a special application 
that manages the A/UX desktop. It displays icons that represent the available A/UX and 
Macintosh file systems. The Finder makes it easy to work with disks, files, programs, and 
utilities. Use the Finder to open a folder or a file or to execute a program by double-clicking 
its icon. 

If you started A/UX manually, by opening the MacPartition folder and double-clicking the 
A/UX Startup icon, the MacPartition folder is still open. You can close it by clicking the close 
box at the upper left of the MacPartition folder's window. If your system starts A/UX 
automatically, the MacPartition folder is not open when the Finder appears. 

• Figure 1-6 The A/UX Finder 
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If your system administrator has set up a personal login account for you, a folder icon labeled 
with your login name appears near the right edge of your screen. This represents your home 
directory folder. If you logged into the start account (or the Guest account), the start (or the 
Guest) folder is your home directory folder. The home directory folder contains the startup 
files, any customized programs or utilities, and any files that belong to that account. 

If you are using a home directory folder that is shared by others, such as the start folder or the 
Guest folder, another user may have moved its icon off the desktop (probably by choosing 
Put Away in the File menu). To locate the start folder or the Guest folder, follow these steps: 

1. Double-click the A/UX ftle hierarchy icon, at the upper right of the screen. 

This is the disk icon with the slash (/) label. This action opens the root folder. 

2. Double-click the folder labeled users. 

Both the start and the Guest folders are now visible. Other users' home directory 
folders may also be located here. 

• Note: If others have used your system before you, you may see the same windows 
that were displayed when the previous user logged out. It's possible, therefore, that a 
window may be covering the icon for your home directory folder. If so, you may 
have to move some of the windows to find the icon. 

You're ready to work. When you're ready to stop working, see the section "Logging Out," later 
in this chapter, for instructions on logging out of A/UX. 

Login options 

While the Login dialog box is displayed, you may select one of two options: Change Password 
and Change Session Type. You can ignore these options unless you plan to (1) change your 
password, (2) change the session type for using older third-party Macintosh applications that 
only run in a 24-bit environment, (3) run the console emulator, or (4) run special interfaces that 
are purchased separately (such as Xl1). Unless you need to do one of these, you can ignore the 
login options. 
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When the Login dialog box is on the screen, display the Options menu, which is in the menu bar 
at the top of your screen. If you have already logged in and the A/UX Finder is displayed, you 
can redisplay the Login dialog box by choosing Logout in the Special menu (located in the 
menu bar at the top of the screen). 

The Options menu gives you the following choices: 

• Change Password: This allows you to change your password. For directions, see 
"Changing Your Password," later in this chapter. 

• Change Session Type: This allows you to run certain older Macintosh applications that 
use memory differently than the newer applications do. It also allows you to display an 
A/UX Console Emulator. See "Changing Your Session Type," later in this chapter. 

Changing your password 

It's important to change your password often to prevent others from discovering the 
password and logging in to your account. Use a password that you can remember without 
writing it down. Don't use a password that is easy to deduce, such as your name spelled 
backward, your computer login name in capital letters, or the name of a family member. 

Display the Login dialog box. If you are already logged in, you must choose Logout from the 
A/UX Finder's Special menu to display the Login dialog box. Follow these steps to change 
your password. 

1. Choose Change Password from the Options menu. 

The Change Password dialog box appears. 

It lists the special restrictions that apply to the characters you can use in a password. 
See pas swd(1) in AlUX Command Reference for more information. If your system 
administrator has overridden these requirements, a description of them does not 
appear in the dialog box. 

2. Type your login name. 

3. Type your old password. 

4. Type your new password. 
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5. Click OK. 

Another dialog box directs you to confirm your new password. 

6. Type your new password again. 

7. Click OK. 

The Login dialog box appears again, with the Name and Password fields filled in. You 
thus have the opportunity to use the Options menu again before completing your 
login, if necessary. 

8. Click the Login button. 

You are logged in to A/ux. Your new password takes effect. You will have to enter it the next 
time you log in. 

Changing your session type 

When you choose Change Session Type in the Options menu (with the Login dialog box 
displayed), you see the dialog box shown in Figure 1-7: 
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• Figure 1-7 The Change Session Type dialog box 

Change Session Type 

Name: start Password: 1..:....11 _____ -----1 

A,/UH Finder 132-bit I ~ 
A!UH Finder (24-bit) 
Console Emulator 

Cancel 

Ellery Session 

n This Session Only l 
A!UH Finder (32-bit) is the normal session type. Macintosh 
applications that are not 32-bit clean will not run properly 
in this mode. 

A/UX is shipped with the following options: 

• A/UX Finder (32-bit): This is the default setting. For a description of this option, see the 
next section,"32-Bit Address Versus 24-bit Address." 

• A/UX Finder (24-bit): For a description of this option, see the next section,"32-Bit 
Address Versus 24-bit Address." 

• Console Emulator: This causes a command line interface to appear on your screen. 
Because this feature is meant primarily for debugging purposes, you will most likely not 
need to use it. If you want to work with the traditional UNIX-style command-line interface, 
see "Using the A/UX System Console" in Chapter 5, "Using CommandShell." 

Certain other interfaces that can be purchased separately, such as XII, may be listed in the 
menu (below Console Emulator), if they have been installed. 
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32-bit address versus 24-bit address 

If you plan to use A/UX with Macintosh files and with software created for the Macintosh 
computer, you may run into trouble using some older programs created for older versions of 
the Macintosh computer. The reason is that two kinds of Macintosh applications run in A/UX: 
24-bit addressed applications and 32-bit clean applications. These terms describe how the 
application uses memory. 

A/UX is set to run in 32-bit addressing mode by default. If you need to change the setting, do 
so when you log in. See "Login Options," earlier in this chapter. Unfortunately, it's not easy to 
tell what software will run in 32-bit addressing mode until you try to run it. If the software 
doesn't work properly, try setting the login mode to 24-bit addressed, as follows: 

1. Choose Logout in the Special menu under the AlUX Finder. 

After a short wait, the Login dialog box appears. 

2. Type your login name in the appropriate text box. 

3. Choose Change Session Type in the Options menu. 

You see the dialog box shown in Figure 1-7. 

4. Type your login name and password in the appropriate fields. 

5. Choose A/UX Finder (24-Bit). 

6. Click This Session Only. 

If you want to use this session type whenever you log in, click Every Session. 

The Login dialog box reappears. Note that the password, which you entered into the 
Change Session Type dialog box, has been transferred to the Login dialog box. 

7. Complete the login process. 

6 Important When you run applications in 24-bit addressing mode, you don't 
have access to the entire Macintosh-like environment that exists 
in 32-bit addressing mode. Turn on 24-bit addressing mode only 
when it's necessary. 6 
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When you start an application that is not certified as being 32-bit clean, a warning box 
appears informing you of this fact. If you know that the application runs properly, you can 
turn off the warning box by following the directions in the section called "Not 32-Bit Clean" 
in Chapter 10, "Troubleshooting." 

Logging out 

When you finish your work with A/UX, end your work session by logging out. To log out, 
do this: 

• Choose Logout in the Special menu under the AlUX Finder. 

The system reminds you to save all your unsaved work. 

After you log out, the Login dialog box reappears, indicating that you have logged out 
successfully. The computer remains on, ready for the next user to log in. 

Looking up A/UX and UNIX commands on line 

There are many places in AlUX Essentials where you are advised to check AlUX Command 
Reference for information on A/UX and UNIX commands. You may find the information by 
displaying the on-line manual pages (usually called the man pages). Do this as follows: 

1. With AlUX running, choose CommandS hell from the Apple menu. 

2. In the CommandShell window, type man commandname and press RETURN. 

The on-line manual entry for the command you entered in place of commandname 
is displayed. 

For instructions on using the man command, do the following: 

• Enter man man in the CommandS hell window. 
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Working with Macintosh ftles in A/lJX 

You can use Macintosh applications and Macintosh files while you are running A/UX 2.0. This is 
true whether the files or applications are stored on a disk formatted for the Macintosh or in 
your A/UX file system. In addition, you can easily move your Macintosh application and files 
to your A/UX file system (see "Storing Macintosh Files" in Chapter 2, "Getting Around in 
A/UX"), and you can work with them just as you do when working in the Macintosh OS. The 
advantage of moving them into the A/UX file system is that you can then use A/UX backup 
facilities and A/UX file permissions with your Macintosh files. 

However, you may wish to store your Macintosh files and applications in a Macintosh file 
system so that you can use them when you have the Macintosh OS running. Although A/UX can 
recognize files that are stored in a Macintosh file system, the Macintosh OS can not recognize 
files that are stored in the A/UX file system. 

Using fues on HFS hard disks 

The MacPartition icon represents a small Macintosh file system on your disk. You can use 
this for storing Macintosh files, if you wish to. However, since MacPartition doesn't 
contain a great deal of memory, you may want to add a second hard disk with the Macintosh 
file system. 

If a second hard disk with the Macintosh file system is attached to your computer and is 
running, after you log in to your account (as described in "Logging In," earlier in this chapter) 
you should see an icon representing the Macintosh hard disk in addition to the icons 
representing the MacPartition disk, the root file system, and your home directory folder. 
Figure 1-8 shows a hard-disk icon. Although the disk icon illustrated here is labeled Mac Disk, 
the one on your system will have whatever label has been assigned to it. 

• Figure 1-8 A hard-disk icon 

I. 
Mac Disk 
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• Open the hard disk by double-clicking its icon or by selecting the icon and 
choosing Open in the File menu. 

You see a window showing the contents of the hard disk. 

You can open, change, copy, and use files just as you do in the Macintosh as. For more 
information on specific abilities, see Macintosh Reference, which was shipped with your 
computer, and the owner's guide that came with your hard disk. 

Working with rues on HFS floppy disks 

You can work with files stored on a floppy disk whenever you are logged in to an A/UX user 
account. With A/UX running, follow these steps: 

1. Be sure that you are in the AlUX Finder by choosing Finder from the 
Apple menu. 

2. Insert the disk into a floppy disk drive. 

An icon representing the disk appears at the right edge of the screen. 

3. Open the disk by double-clicking its icon or by selecting the icon and 
choosing Open in the fue menu. 

You see a window showing the contents of the disk. 

You can open, change, copy, and use files just as you do in the Macintosh as. For more 
information on specific abilities, see Macintosh Reference, which was shipped with 
your computer. 

For more information on inserting floppy disks and using them for backing up files, see 
"Backing Up and Restoring Critical Files" in Chapter 2, "Getting Around in A/UX." 
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Getting to the Macintosh OS 

,Sometimes you may want to use the Macintosh OS exclusively. If the power has been turned 
off, follow the directions in the next section ("If the Power is Off"). 

If A/UX is running, proceed to the section after that, "If A/UX is Running." 

If the power is off 

If the power has been turned off, and if A/UX Startup is set as the startup application on the 
startup disk, you need to cancel the automatic startup procedure. Follow these directions. 

During the initial five seconds of the startup procedure, you can click Cancel on the startup 
screen to interrupt the procedure. Follow these steps: 

1. Press the POWER ON key to turn on the computer. 

First the copyright screen appears. 

2. With the copyright screen displayed, hold down the COMMAND key while 
pressing the period key. 

If the copyright screen disappears before you have time to do this, a startup 
screen appears. 

3. If the copyright screen has vanished before you could perform step 2, click 
Cancel during the first five seconds of the startup procedure. 

You see the A/UX Startup window with the A/UX Startup # prompt. 

4. Choose Quit from the File menu. 

The Macintosh OS Finder appears. Icons for the Macintosh HFS hard disks 
connected to your system appear on the right side of the screen. Note that the 
A/UX root (/) disk does not appear. The Macintosh OS does not recognize the 
A/UX file system. 

To begin using a file on your Macintosh OS hard disk, open it by double-clicking its icon. 
Refer to the Hard Disk SC Owner's Guide or to the owner's guide that came with your 
computer for information about setting up and using files and folders on this disk. 
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If A/UX is running 

If the computer is on and running A/UX, follow these directions: 

1. Choose Restart from the Special menu, with either the Finder or the Login 
dialog box displayed. 

The Restart dialog box appears. 

2. Enter the root password in the appropriate text box. 

If you are already logged in as the root user, you are not asked for the root 
password here. 

3. If others are using the system, type a warning message in the next 
text box. 

Your message is broadcast to other users. 

If you are the sole user of this system, you are not asked for this information. 

4. Type a number specifying the delay, in minutes, between the time the 
message is transmitted and the time other users must have completed 
logging out. 

Give other users a reasonable amount of time to save their work and to log out. 

If you are the sole user of this system, you are not asked for this information. 

5. Click Restart. 

6. With the copyright screen displayed, hold down the COMMAND key while 
pressing the period key. 

If the copyright screen disappears before you have time to do this, a startup 
screen appears. 

7. Click Cancel during the ftrst five seconds of the startup procedure. 

8. Choose Quit from the File menu. 

The Macintosh as Finder appears. Icons for the Macintosh as hard disks connected 
to your system appear on the right side of the screen. Note that the A/UX root (/) 
disk does not appear. The Macintosh as does not recognize the A/UX file system. 
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To begin using a file on your Macintosh HFS hard disk, open it by double-clicking its icon. 
Refer to the Hard Disk SC Owner's Guide or to the owner's guide that came with your 
computer for information about setting up and using files and folders on this disk. 

Getting your bearings 

This section describes how to find out what account you're using, what you are allowed to do 
with it, and how to work in a different account than the one you are currently logged in to. 

Who are you? 

If you forget your login name, use the whoami command to find out what it is. 

Follow these instructions. 

1. Choose CommandShell from the Apple menu. 

A window appears on the screen. CommandShell and the sheUlanguage are described 
in Chapter 5, "Using CommandShell." For now, think of the CommandShell window as 
a way to communicate with the computer. 

2. Enter the command: who ami 

Remember that you enter a command by typing the command and pressing the 
RETURN key. In a few seconds you see a response that identifies the account name. 

3. Choose Finder from the Apple menu. 

This action returns you to the Finder. 
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What are you allowed to do? 

Table 1-1 shows what types of actions you can perform and where you can find more 
information about these tasks. 

• Table 1-1 

Who you are 

Regular user 

Guest user 

Root user 

What you can do 

What tasks Where to 
you can do find information 

Log in and log out Chapter 1 
Use A/UX programs and utilities Chapter 2 
Create, print, manage, and A/UX Command Reference 
store documents 
Use conforming Macintosh Macintosh Reference 
applications and desk accessories Application user's guide 
Change your password Chapter 1 
Connecting to a network Setting Up Accounts and Peripherals 

forA/UX 

Same as regular user 

All the above, plus: 
Add user accounts: Setting Up Accounts and Peripherals 

forA/UX 
Turn the system off Chapter 1 
and start it up again 
Add and manage peripheral devices Setting Up Accounts and Peripherals 

forA/UX 
Set up and manage a network A/UX Network System 

Administration 
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Using a different user account after logging in 

While you're working in one login account, you may want to accomplish some task in a 
different login account without logging out of the system and logging back in to the other 
account. When you do this, you have become a substitute user. The ability to become a 
substitute user is useful if you need to work in another account briefly. For example, if you 
need to perform a system-administration task, but you are currently working in a user account, 
you can temporarily use the root account, perform the task, then return to your user account 
without having to log out and log back in twice. 

This section lists the steps you take to accomplish this. 

To become a substitute user, you must work in a CommandS hell window. The CommandShell 
window actually removes you from the A/UX Finder temporarily and places you in a traditional 
UNIX-style environment. You are a substitute user only as long as you are working in that 
CommandS hell window. When you return to the A/UX Finder, you are still working in the same 
account you were logged in to before you became a substitute user. 

You can work in any account if you know its login name and its password. Becoming a 
substitute user does not log you out of your own account and in to a new account; it merely 
allows you to work in the other account temporarily. As soon as you log out of the other 
account, you are again working in your own account. 

1. Choose CommandShell from the Apple menu. 

A window appears with the cursor blinking in the upper-left corner. 

2. Enter the command su plus a space, and the login name of the new account. 

The s u (substitute user) command allows you to work in a different account 
from the one you are currently logged in to. After you type s u, leave a space and 
type the login name of the new account. Then press RETURN. A/UX displays the 
following prompt: 
Password: 

You need to know the password for the new account to complete this procedure. 

3. Type the password. 

No characters are displayed as you type the password here. 
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4. Press RETURN. 

When you press RETURN, A/UX reads the password. If the login name and the 
password are correct, you may begin to work in the new account. If either the login 
name or the password is incorrect, you see the following message: 
su: Sorry 

In this case, you are still working in the same account you were originally using. 

Shutting down A/UX 

You may sometimes need to shut down A/UX to do system maintenance, for instance, to add 
peripheral devices to a network or to repair a file system. To shut the system down properly, 
you need to know the password for the root account. 

... Warning Don't use the switch on the back of the Macintosh computer to turn 
it off while A/UX is running. Doing so may corrupt the file system and 
may cause a loss of data. Always use the correct shutdown procedure 
to turn off the computer. .... 

Shutting down the computer 

Follow these steps to shut down the computer: 

1. With either the Finder or the Login dialog box displayed, choose Shut Down 
from the Special menu. 
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You see the Shut Down dialog box, shown in Figure 1-9. 

• Figure 1-9 The Shut Down dialog box 

Shut Down ... 

You must haue root priuileges to shut 
this system down. 

Root password: 

logout n Shut Down J 

2. Enter the root password in the appropriate text box. 

If you logged in as the root user, you are not asked for this password. 

3. If others are using the system, type a warning message in the next 
text box. 

Your message is broadcast to other users. 

If you are the sole user of this system, you are not asked for this information. 

4. Type a number specifying the delay, in minutes, between the time the 
message is transmitted and the time the other users must have completed 
logging out. 

Give the other users a reasonable amount of time to save their work and to log out. 

If you are the sole user of this system, you are not asked for this information. 

5. Click Shut Down. 

If you want to shut down and start up again immediately, choose Restart, instead of Shut 
Down, from the Special menu. The Restart dialog box appears. The procedure is the same as 
the shutdown procedure. 
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About system administration 

When several people use an A/UX system, a system administrator must maintain the system. 
The system administrator sets up user accounts, keeps track of passwords, sends out 
messages regarding procedures and schedules, watches out for system security, and serves 
as a troubleshooter for any problems that arise. 

When you're using AlUX, you may be the only person using the computer and must therefore 
act as your own system administrator. The system administrator uses the root account to 
perform maintenance tasks. This account has access to all files in the entire file system. Thus, 
if you're the system administrator for your AIUX system, you should log in to your user account 
to do your normal work. Then, when you need to perform a maintenance task, you should log 
out and log in again using the root account. 

Maintaining the start account 

The start folder contains a script called setup. After someone uses the start folder for 
tutorials, the material in this folder may well be altered. To restore it to its original condition, 
run the set up script as follows: 

• Double-click the setup icon in the start folder. 

The s tart folder is restored to its original form. 

For further information on system administration, see Setting Up Accounts and Peripherals 
for A/UX and A/UX Local System Administration. 
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Chapter 2 Getting Around in A/UX 

This chapter describes how you use files in A/UX. It explains how file 
systems are structured, which file systems you can use, and how to 
maintain your files. 

Before using this guide, you need to know basic Macintosh skills, such as 
clicking, dragging, pulling down menus and choosing from them, and using 
Macintosh windows. If you are new to the Macintosh computer, take the 
tour on the tour disk provided with your Macintosh computer or read the 
appropriate sections in the Macintosh User's GUide; Essentials. 

This chapter contains the following sections: 

• Identifying what you see on the screen 

• Using the Finder 

• Finding commands and utilities 

• The A/UX Finder icons 

• Protecting your files and folders 

• Using folders 

• Manipulating your files 

• Storing Macintosh files 

• Backing up and restoring critical files 

• Pathnames in the A/UX file system 

You can read this chapter in sequence or go directly to the section that 
contains the information you need. 
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Identifying what you see on the screen 

This section identifies the various objects that appear on the screen in A/UX 2.0. When 
you log in to A/UX 2.0, you don't automatically see the command-line interface familiar to 
most UNIX users. A/UX starts up with the A/UX Finder interface, an application that is similar 
to the Macintosh Finder in functionality and appearance. It's a graphical representation of the 
operating system that presents icons based on real-world metaphors. 

If you're familiar with the Macintosh Finder, you will recognize the A/UX Finder shown in 
Figure 2-1. Note that the MacPartition folder is not open in Figure 2-1. As you learned in 
Chapter 1 ("Starting and Finishing a Work Session"), this window is open if you have started 
A/UX manually. It is not displayed if you have set A/UX to start automatically. 

• Figure 2-1 The A!UX Finder 
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Using the Finder 

The Finder graphically represents a desktop environment. It displays icons that represent 
objects (such as files or folders) in the A/UX file system. Each icon identifies an object or 
function by its resemblance to a real-world object. For example, if you toss a document into a 
trash can, you dispose of it; in the Finder, if you drag a file icon to the Trash icon, you remove 
it from your disk. 

If you are acquainted with recent Macintosh models, you may be familiar with MultiFinder®, 
which enhances the Finder. A/UX 2.0 has MultiFinder installed permanently, and so MultiFinder 
runs automatically when you start A/UX. For those who are not acquainted with MultiFinder, its 
enhancements to the Finder are listed here. The A/UX Finder allows you to do the following: 

• You can work with different A/UX and Macintosh applications concurrently. You can 
copy and paste information between documents and applications easily and quickly, 
without having to save the file from one application before you open a file from the 
other application. 

• You can have immediate access to the Finder without having to close the application 
you're using. Thus, you can open additional applications whenever you wish, rename or 
delete documents you aren't working on, and so on. 

• A/UX is a multitasking system. That means that you can run several applications at the same 
time. Since the A/UX Finder allows you to open several applications at once, applications 
may work in the background (for example, to print a long document) while you use another 
application, such as a spreadsheet. 

Using several applications at one time 

The A/UX Finder allows you to display many windows at the same time. You can work with a 
text editor in one window; then, while the document is being sent to the printer (and without 
closing the text editor window), you can display another window to work with a second 
application. The application with which you are currently working is in the active window, 
which always has stripes running across the title bar. It is always in the foreground. If the other 
windows in the A/UX Finder occupy the same screen area, all the other windows are behind the 
active window. Figure 2-2 shows an active and an inactive window. 
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• Figure 2-2 An active and an inactive window 
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• Note: Although you can work only in the active window, the applications used in the 
other windows may well be running and processing their instructions. This is called 
running an application in the background, or backgrounding a process, The phrase 
inactive window merely indicates that you cannot interact with the window for the 
moment; under A/UX, it does not indicate that the application used in that window 
is not running, 
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Finding commands and utilities 

The A/UX Finder provides menus that allow quick access to common commands used for 
file-system organization. These menus are available on the menu bar at the top of the screen. 
You can open a menu, look for a command, and choose it from the menu. The list that follows 
shows the standard menu titles and the types of commands you'll find in each menu. 

• Apple menu: Desk accessories and active applications 

• File menu: commands to manipulate files 

• Edit menu: commands to edit or change filenames or folder names 

• View menu: commands to change the way folder contents appear on the screen 

• Special menu: commands that act on the Finder or the operating system 

In Chapter 9, "A/UX Reference," you'll find a complete list of the menu commands with brief 
descriptions of the actions associated with the commands. 

The A/lJX Finder icons 

The A/UX operating system contains many files and folders, each of which is represented by an 
icon in the A/UX Finder. This section illustrates what icons you see and what they represent. 

Folders and documents 

A reminder about terminology: In traditional UNIX® terminology, the term "directory" is used 
for the object that is called a "folder" in the Macintosh environment. Thus, in traditional UNIX 
terms, the file system contains mainly two types of file: plain files and directories. Directories, 
in turn, can contain plain files and other directories. This is also true of A/UX. 
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Although users who are using A!UX in the CommandS hell will find it useful to think in traditional 
UNIX terms, and will refer to "directories" rather than "folders," those who are using the 
Macintosh desktop interface will probably prefer to think in terms of the folder and file icons 
that are in the Finder. Because the Finder is discussed in this section, the term "folder" is used 
consistently here. In sections that discuss the A/UX command line interface, which is in the 
style of the UNIX system (for example, in "Pathnames in the A/UX File System," later in this 
chapter) the word "directory" is used. 

The A/UX Finder represents files and folders with distinctive icons. Since a folder can contain 
files and other folders, folders are represented by the file folder icon familiar to Macintosh 
users. The folder is much like a regular file folder in a real office. It contains files and other 
folders that are related to each other or to a common topic. 

You can give a folder any name that makes sense to you. You can put files in folders, and 
folders in folders, to the degree that satisfies your need for organization. If you have 
permission to open a folder, when you open it you see a window with icons representing the 
folder's contents. 

The icon for a given file or folder changes according to the user permissions (for a description 
of permissions, see "Protecting Your Files and Folders" later in this chapter). Icons that are 
shaded, for example, indicate that you do not have read and/or write permission. Note that 
this refers only to your permissions. Other users have different permissions, and their own 
permissions are therefore reflected in the icons they see. 
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Folder icons 

This section illustrates the different folder icons that you may see in the A/UX Finder. 

Folder icons: The two icons in Figure 2-3 represent folders for which you have read and 
execute permission. You mayor may not have write permission. The marked tab on the folder 
on the right indicates that you own the folder (that is, you created it, or ownership has been 
transferred to you). 

• Figure 2-3 Folder icons 

etc susan 

Dimmed folder icon: This icon (Figure 2-4) indicates that you cannot open this folder, nor 
can you change any of its contents. 

• Figure 2-4 Dimmed folder icon 

dave 
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Drop box icon: This icon (Figure 2-5) represents a folder for which you have write and 
execute permission only. You cannot see or read the files in the folder, but you can place 
files in it. 

• Figure 2-5 Drop box icon 

bob 

Current system folder icon: This icon (Figure 2-6) represents the system folder that the 
system is currently using. 

• Figure 2-6 Current system folder icon 

l[] 
Sy stem F older 

File, application, and utility icons 

The following icons represent various kinds of files, commands, scripts, and applications. In 
A/UX 2.0 you can use applications and utilities from both A/UX and Macintosh file systems. 
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A/UX text-ftle icon: This icon (Figure 2-7) represents a text file for which you have read 
permission. When you double-click this icon, the file opens using the default text editor. For 
information on the default text editor, see Chapter 6, "Writing with TextEditor." 

• Figure 2-7 A/UX text-file icon 

i 
passwd 

Nonexecutable ftle (without read permission) icon: This icon (Figure 2-8) represents 
any nonexecutable file to which you are denied read permission. For example, it could be 
a text file, a shell script, or an application (to which you are denied execute permissionas 
well as read permission). 

• Figure 2-8 Nonexecutable file (without read permission) icon 

I 
john 
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Nonexecutable data ftle icon: This icon (Figure 2-9) represents a file that that is not a text 
file and that you may not execute. 

• Figure 2-9 Nonexecutable data file icon 

r~i #-. 
ne-xtunix 

UNIX (A/UX) command icon: This icon (Figure 2-10) represents an A/UX command. 
When you double-click this icon, you see a Commando dialog box, which allows you to 
run the command. 

• Figure 2-10 UNIX (A/UX) command icon 

gre-p 
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Shell script icon: Note the similarity between this icon (Figure 2-11) and an A/UX command 
icon (Figure 2-10). This icon functions as though it were a UNIX command icon, that is, 
double-clicking the icon displays a Commando dialog box. If no Commando dialog box has 
been created for the shell script, a default dialog box appears, which allows you to enter the 
script's options and arguments. For further information on Commando dialog boxes, see 
Chapter 4, "Using Commando." 

• Figure 2-11 Shell script icon 

basE'namE' 

Executable ftle (without read permission) icon: This icon (Figure 2-12) represents a file 
that you can run (such as an application), but for which you do not have read permission. 
Many applications (such as those supplied by third-party developers) represent their products 
with their own custom-designed icons, which appear in place of this icon. 

• Figure 2-12 Executable file (without read permission) icon 

• joan 
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HyperCard application icon: This icon (Figure 2-13) represents the HyperCard application. 
Under A/UX 2.0, you may run Macintosh applications, such as HyperCard, by double-clicking 
the icon just as you do under the Macintosh OS. The application may be stored in a Macintosh 
file system (for example, on a Macintosh hard disk), or in your A/UX 2.0 file system. 

• Figure 2-13 An application icon 

HyperCard 

Available ftIe systems 

This section describes icons that represent available file systems. In A/UX 2.0 you can mount 
and use both A/UX and Macintosh file systems. The icons described in this section represent 
the different file systems you can access. 

AlUX ftle hierarchy icon: This icon (Figure 2-14) represents the top level of the A/UX 
file hierarchy. 

• Figure 2-14 A/UX file hierarchy icon 

I. 
I 
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Macintosh hard disk icon: This icon (Figure 2-15) represents a hard disk that contains a 
Macintosh file system. 

• Figure 2-15 Macintosh hard disk icon 

I. 

MacP artition 

Macintosh floppy disk icon: This icon (Figure 2-16) represents a floppy disk with a 
Macintosh file system. 

• Figure 2-16 Macintosh floppy disk file icon 

text backup 

Useful Commands 

When you open the start folder, the Guest folder, or your home directory folder, you see a 
folder icon labeled Useful Commands. This folder contains a collection of frequently used 
A/UX commands. To use these commands, follow these directions: 

1. Double-click the Useful Commands folder icon. 

This opens the folder shown in Figure 2-17 and displays the icons that represent 
the commands. 
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• 

0 

Note that when you open this folder, the icons may be so close together that 
their labels overlap. You may click and drag them to arrange them as illustrated in 
Figure 2-17 or you may choose By Name in the View menu. This lists the contents of 
the folder alphabetically by name. 

Figure 2-17 The Useful Commands folder 

Useful Commands 0 
13 items 40,094K in disk 11 ,296K available 

Q 

~ ~ ~ 
addcmd (add Useful Cmd) apropos (key word search) chmod (change permission) 

~ ~ ~ 
diff (compare files) 

find (find files) grep (pattern search) 

~ ~ ~ 
lpr (line pl'"inter) ls (list files) man (view manua 1) 

~ ~ ~ 
ps (process status) sort (sort lines) w (user activity) 

~ 
where is (locate command) 
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2. Double-click the icon for the command you want to execute. 

A Commando dialog box for that command appears. For details on Commando, see 
Chapter 4, "Using Commando." 

You may try this now by double-clicking the 1 s icon. The use of this icon is 
described in Chapter 4, "Using Commando." Click Cancel to close the dialog box. 

Commands in the Useful Commands folder 

There are two versions of the Useful Commands folder: one in your home directory and another 
in the root account. 

The Useful Commands directory in a user's home directory contains the following commands 
(for further information about these commands, see A/UX Command Reference): 

• addcmd (add Useful Cmd): Adds the desired command to the Useful Commands folder 
by creating a link to the actual command. See the next section, "Adding New Commands to 
the Useful Commands Folder." 

• apropos (keyword search): Performs a keyword search of the synopses of the on-line 
manual pages. 

• chmod (change permission): Allows you to change the permissions of a file 
or a directory. 

• diff (compare fues): Compares two text files and shows the lines that differ. 

• find (fmd fues): Finds and displays the location of a file. 

• grep (pattern search): Searches files to find lines that match a given pattern. 

• Ipr (line printer): Sends a file to the printer. 

• Is (list fues): Lists the files and directories in a given directory. 

• man (view manual): Displays the on-line manual page for a given command. 

• ps (process status): Prints information about the active processes. 

• sort (sort lines): Sorts the lines of designated files and displays the results. 

• w (user activity): Prints a summary of all activity on the system, including what every 
user is doing. 

• whereis (locate command): Finds the location of the specified command in the 
file system. 
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The Useful Commands folder in the root account contains the following commands in addition 
to those listed above: 

• adduser (add new user): Adds a new user account to the system. 

• date (change date): Displays and sets the current date and time. 

• df (disk freespace): Displays the number of free blocks and free inodes available for a 
mounted file system. 

• fsentry (install ftlesystem): Creates an entry in the file system table (jetc/fstab). 

• mount (mount ftlesystem): Used in mounting a file system. 

• newconfig (configure system): Invokes the commands necessary to prepare and 
configure a new kernel. 

• setport (set serial port): Adds or modifies entries for serial ports. 

• settimezone (set timezone): Sets the time zone. 

• umount (unmount ftlesystem): Used to unmount a file system. 

Adding new commands to the Useful Commands folder 

As you become more familiar with A/UX 2.0, you may want to add to this folder the commands 
you find most useful. 

The Useful Commands folder contains an icon labeled addcmd. This icon represents a script 
that allows you to add an A/UX command to the Useful Commands folder. 

To add a command, follow these steps: 

1. Double-click the addcmd icon. 

The dialog box illustrated in Figure 2-18 appears. 
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• Figure 2-18 The addcmd dialog box 

r-addcmd Options 
Command name: 

I I 
Output Error 

I I I I 

addcmd 
~comm.nd Line 

I 
r-Help ( ) 
Add a command to your 'UsE'ful Commands' fo ldE'r. addcmd puts a sy mbo lic 

Cancel 

€ D 
link to thE' command in your 'UsE'ful Commands' fo ldE'r . addcmd 
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2. Type the command in the text box labeled "Command name". 

You can type a phrase in parentheses describing the command, if you wish. 

For example, type the following: who (list users). 

3. Click the addcmd button. 

When you redisplay the Useful Commands folder, you will see an icon representing the 
command you have added. If you have followed the directions in step 2, the icon is labeled 
who (list users). 

Command storage locations 

Once you become familiar with the A/UX file system, you'll recognize common storage 
locations for programs. Unless you are the system administrator, you should not modify any 
files in the system folders. Some of the locations are listed here. Note that their locations are 
described as A/UX pathnames; for information on pathnames, see "Pathnames in the A/UX File 
System," later in this chapter. 

• /mac/bin-applications, such as TextEditor or CommandShell, that are UNIX-like but 
have Macintosh features 

• /mac/ sys/System Folder-Macintosh programs, desk accessories, and the System 
Folder and its contents 

• / et c-system administration files 
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Protecting your ftles and folders 

A/UX is a multi-user system that allows you to share files with other users. It also provides a 
way to protect your files and folders so that only you (or a restricted group of users) can open, 
read, change, or run them. Just as only the person who knows an account's password can log in 
to that account, only users with the correct access permissions can use files or folders. The 
person who owns the folder or file (that is, the one who created it or who has been granted 
ownership) controls the accessibility of that folder or file. The only exception to this is the 
person who is logged in as root. That person has access to all files. For that reason, only the 
system administrator has permission to log in as root, under most circumstances. Because of 
these special privileges, the person logged in as root is called the superuser. 

File access permissions 

File access permissions determine who can use a particular file and what they can do with it. 
Three types of permission exist. You can set read permission, write permission, and 
execute permission for each file. 

• Read permission allows you to open the file and read it. 

• Write permission allows you to change the file. 

• Execute permission allows you to run an executable file, such as an application 
or a script. 
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Categories of users 

Every file's permissions grant or deny access to the file according to the user's membership in 
one or more of three categories. A description of these three categories follows: 

• Owner (sometimes called User) permission 

The person who owns the file. If the file has owner permission, the person who is 
logged in as the owner of the file can use it. The owner of a file or folder is the user 
who created it. Ownership can be transferred to a different user with the chown 

command. For further information on the chown command, see chown(1) in 
AlUX Command Reference. 

• Group permission 

A specific named group of users. If the file has group permission, those who are 
assigned to this group can use it. 

• Others (sometimes called World) permission 

Everyone who has an account on the system. If the file has others permission, 
everybody logged in can use it. 

Therefore, each form of permission (read, write, and execute) can be assigned to the owner, 
to a specified group of users, and/or to all users logged in to the system. 

Checking a rtIe's permissions 

To check the current permissions of a file, you must examine its so-called long listing. 

Check the permissions of the file called letterl in the start directory. During the course of 
this brief tutorial, you are working in a CommandShell window. Therefore, this tutorial uses 
UNIX-style A/UX terminology; that is, the start directory rather than the start folder. 
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1. Choose CommandShell from the Apple menu. 

A CommandShell window appears, as shown in Figure 2-19. 

• Figure 2-19 A CommandShell window 

o CommandS hell 1 
localhost.start 1 ~ • 

If a CommandShell window does not appear, choose Open from the File menu after 
choosing CommandShell from the Apple menu. For details on CommandS hell 
windows, see Chapter 5, "Using CommandShell." 

2. To be sure that you are in the start directory, enter: 
cd /users/start 

The command cd means "change directories." For an explanation of the pathname 
/users / start (and of pathnames in general), see "Pathnames in the A/UX File 
System," later in this chapter. 

3. Enter the command: Is -1 (there is a space between ls and -1). Be sure 
that you type the letter "ell" and not the number "one." 
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This displays a long listing of the contents of the directory in which you are working. A long 
listing indicates more than just the filename. It indicates the permissions, the owner, the size 
of the file, the date on which the file was last modified, and other information. 

Look for the line labeled 1 e t t e r 1 in the column on the right. The line appears as follows: 
-rw-r--r-- 1 start project 1289 Jan 18 19:20 letterl 

Each column gives some information about the file 1 e t t e r 1 : 

• -rw-r--r--: the file's permissions (explained below) 

• 1: the number of links. You need not be concerned with this 

• start: the name of the file's owner (in this case, the file is owned by whoever is logged 
into the start account) 

• project: the name of the group 

• 1289: The size of the file (in bytes) 

• Jan 18 09: 20: The date and time on which the file was last modified 

• letter1: The filename 

The first column of that line contains the following string of characters: 
-rw-r--r--

If let terl were the name of a directory within the start directory (that is, if it were a 
subdirectory), the first character would be the letter d rather than a dash. The fact that the 
first character is a dash means that let terl is a regular file, not a directory. 

There are nine more characters on the line. Consider them in three groups of three 
characters each: 
rw- r-- r--

• The first group of three characters refers to owner (or user) permission. 

• The second group of three characters refers to group permission. 

• The third group of three characters refers to others (or world) permission. 
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As for the characters themselves, they have the following meanings: 

• r means read permission has been granted. 

• w means write permission has been granted. 

• x means execute permission has been granted (for executable files only, such as programs 
or shell scripts, and for most folders). 

• - means permission has been denied. 

Furthermore, for each group of three, these characters always occur in the same order: rwx. 

That is, you are always told first about read permission, then about write permission, and 
finally about execute permission. 

Thus, -rw-r--r-- means: 

• - This is a file, not a directory. 

• rw- The owner of the file has read and write permission, but not execute permission. This 
is a nonexecutable file. If you accidentally assign it execute permission, the system will 
attempt to treat it like a shell script when you double-click its icon. This will result in an 
error message. 

• r- - The group has read permission only. No one in the group can change this file. 

• r-- All others (besides the owner of the file and the group) have read permission only. 
No one but the owner can change this file. 

Changing file access permissions 

The chmod (change mode) command allows you to change the permissions for any file that 
you own. You use chmod to grant or to deny read, write, and execute permissions for the three 
categories of user. 

During the course of this brief tutorial, you will work in a CommandS hell window. Therefore, 
this tutorial uses A/UX terminology, which is like the terminology of the UNIX system; that is, 
the s tart directory rather than the s tart folder. 

In the section "Checking a File's Permissions," earlier in this chapter, you learned that the file 
let terl in the start directory allows only read permission to the group. 
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Since this tutorial consists of changing the permissions of a file whose owner is s tart, you 
must be logged in as start. If you are not logged in as start, follow these directions: 

1. If you have been working in a CommandShell window, make the A!UX 
Finder active again by choosing Finder in the Apple menu or by clicking the 
MultiFinder icon (at the upper right corner of the screen). 

2. Choose Logout in the Special menu of the A!UX Finder. 

3. When the Login dialog box appears, log in as start. 

Follow the login instructions in "Logging In for the Tutorials" in Chapter 1, "Starting 
and Finishing a Work Session." 

To practice granting write permission to the group, you first need to display the Commando 
dialog box for the chmod command. Complete the following steps: 

1. If you have been working in a CommandS hell window, make the A!UX 
Finder active again by choosing Finder in the Apple menu or by clicking the 
MultiFinder icon (at the upper right corner of the screen). 

2. With the start folder open, double-click the Useful Commands icon to 
display the Useful Commands folder. 

3. Double-click the chmod icon. 

The Commando dialog box for the chmod command appears on the screen. 
Figure 2-20 shows the chmod commando dialog box. 

Commando is a tool that helps you build commands in the A/UX command line. 
Chapter 4 ("Using Commando") explains Commando in detail. For now, continue 
with the steps presented in this tutorial. 
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• Figure 2-20 The chmod Commando dialog box 

r-chmod Options ----------------------, 
: ... Required ............................................................................................................................................................................................... ~ 

! @ Grant or deny permission : 
: 0 Specify mode ( Files/directories to change) ! 
l ................................................................................................................................................................................................................................. 1 
["··Operation ............................... : r" User types ································1 f···Permissions ............................ ! 
: @ Grant : : 0 Owner : : 0 Read : 
! 0 De ny ! 1 0 Group : : 0 Write 1 
: ................................................................... ; 1 0 Others 11 0 EHecute 

l ........................................................................ J. ~ •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• : 

( Mn~h~ SW~( i fic<11 hm ) ( output 6' Error) 

r;command line 

Lhmod 
+ 

r-Help-----------------~ 
Change read, write, and execute permissions for files and directories. 

~-----------------~ 

To execute chmod with this dialog box, do the following: 

Cancel 

1. Be sure that the "Grant or deny permission button" is clicked. 

2. Under Operation, click the Grant button (if it isn't already highlighted). 

3. Under "User types," click Group. 

This tells the system that you are about to change permissions for the group. 

4. Under Permissions, click Write. 

You don't need to grant read permission because the group already has it. 

5. Click the "Files/directories to change" button. 

In response, the system displays the dialog box shown in Figure 2-21. 
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• Figure 2-21 Files to Change dialog box 

(Add Current Directory: 1 

Ie start I 
D -( lipboard ~ 
D -cshrc 
D -desk: 
D -EHamplsBack:Up 
D -k:shrc 
D -login 
D -logout 
D -profile 
D letterl 

Select files and/or directories: 

c::::::Ji 

Driue 

Done 

Cancel 

n Add) 

( nem(H~e 

6. Choose letterl in the list by double-clicking it (or by selecting it and 
clicking Add). 

This places the filename 1 e t t e r 1 in the "Select files and/or directories" box. 

7. Click Done. 

This redisplays the chmod Commando dialog box. 

8. Click chmod, which is at the lower right corner of the dialog box. 

Now follow the directions under "Checking a File's Permissions," earlier in this chapter, to see 
the new permissions for 1 e t t e r } . 

Change the permissions back by denying write permission to the group. Simply follow the 
procedure you just used to grant write permission to the group. The difference now is that 
instead of clicking the Grant button, you click the Deny button. 
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You can also use chmod to grant or deny permission for folders. However, be careful when 
you're granting or denying folder permissions. The terms "read," "write," and "execute" have 
special meanings when applied to folder permissions. See the next section, "Folder and 
Directory Access Permissions," for more information. 

If you want detailed information about the chmod command, see chmod(1) in 
AlUX Command Reference. For more information about file-protection schemes, see 
AlUX Local System Administration. 

Folder and directory access permissions 

You can set the access permissions of folders or directories that you own. Folder and directory 
access permissions can be somewhat confusing because they have the same names as file 
access permissions (read, write, and execute), but they affect folders and directories 
differently than they affect files. In addition, directory access permissions in the 
CommandShell work somewhat differently than folder access permissions in the A/UX Finder. 

The following general rules apply to directory access permissions if you are working 
in the CommandShell: 

• Read permission allows you to read the contents of a directory (that is, to list its 
contents with the ls command and many of the command's options; see Chapter 4, "Using 
Commando"). However, it doesn't allow you to go into the directory or to add, rename, or 
remove any of its contents. 

• Execute permission allows you to enter the directory, but you cannot list its contents, 
nor can you add, remove, or rename its contents. You can access the items in the directory 
only if you know their names. 

• Write permission allows you to add or to remove items from the directory, or to rename 
them, if you already know the items' names. However, you cannot enter the directory, nor 
can you list its contents. 

These permissions are usually used in combination, although they may be of some use 
individually. For example, a directory that has only execute permission can be used to prevent 
snooping by unauthorized users. 
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UNIX directory permissions in the CommandShell work differently than folder permissions 
in the A/UX Finder because in order to see what a folder contains in the A/UX Finder, or to 
remove or rename anything in the folder, you must open the folder by double-clicking it. 
Since that is equivalent to entering the folder, you need read and execute permission. In 
fact, the A/UX Finder insists that you have execute permission before you can do anything 
useful with a folder. 

The following list shows the permissions you need in order to perform various operations upon 
a folder in the A/UX Finder: 

• To open a folder and read its contents, you need read and execute permissions. 

• To open a folder and add, rename, or remove fdes, you need read, write, and 
execute permissions. 

• To add items to a folder that you cannot open and whose contents you cannot 
see, rename, or remove, you need write and execute permissions. This folder is 
commonly called a drop box, because once you add an item to it, that item is available 
only to a user who has at least read and execute permissions. 

Note, however, that if you are using the CommandShell, you can use UNIX commands to 
manipulate an item in a drop box, provided that you already know the item's name. As 
mentioned above, A/UX directory permissions allow a user with write and execute 
permission to enter and to change the contents of a directory. 

Changing folder permissions 

To change the permissions for a folder, follow the directions given earlier in this chapter in 
"Changing File Access Permissions." The only difference is that instead of selecting a filename 
from the list of items in the directory (Step 6), you click the Add Current Directory button 
above the directory name (shown in Figure 2-21). 
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Default access permissions 

When you create a file or a folder, the system automatically assigns certain preset access 
permissions for you, your group, and other system users. As shipped, the A/UX default access 
permissions are listed in the following sections. 

For regular nonexecutable flIes 

The default access permissions for newly created regular text files are as follows: 

• Owner: read, write 

• Group: read 

• Others: no permission 

Folders and executable fdes 

Newly created folders and compiled programs are automatically assigned the following default 
permissions: 

• Owner: read, write, execute 

• Group: read, execute 

• Others: no permission 

Shell scripts 

A shell script is a text file that consists of one or more A/UX commands that run as a program 
when you double-click the file's icon in the A/UX Finder. A/UX does not know that a newly 
created shell script is anything other than a regular text file. Therefore, it assigns the default 
permissions for a text file. After you create a shell script, assign execute permission as follows: 
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• Enter the command: chmod +x filename (in a CommandS hell window). 

The command chmod +x automatically enhances the default permissions to the shell 
script as follows: 

D Owner: read, write, execute 

D Group: read, execute 

D Others: no permission 

Changing default permissions 

To change the default permissions, use the uma s k command. The use of this command is 
described in sh(1) in A/UX Command Reference. 

Using folders 

When you log in to your A/UX system, your home directory folder appears on the right side 
of the desktop. 

The home directory folder contains any files that are specific to your user account. You should 
store all your files in it, as well as any applications you like to use, unless there is a specific 
reason for storing them in a different folder (for example, certain applications might require 
their own folders, or you may be sharing applications with other users). 

You can customize your working envlronment by altering the information stored in system 
files in your home directory folder. Chapter 3, "Customizing Your Work Environment," 
explains how to do this. 
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Looking at the contents of a folder 

Folders in A/UX behave as they do in the Macintosh OS. To see what your current folder 
contains, you open the folder. Follow these steps: 

1. Click your home directory folder to select it. 

The icon is highlighted to show that it is selected. 

2. Choose Open from the File menu. 

You can also double-click a folder icon to open it. A window appears showing you 
the contents of the folder. You can change the way the contents appear by using the 
commands in the View menu. 

Figure 2-22 shows the contents of the /users / start folder. 

• Figure 2-22 The contents of the folder /users/ start 
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Moving to a different folder 

From your home directory folder you can move to other folders. 

When you move to a new folder, it becomes the current folder. Follow these steps: 

1. Locate the folder that you want to use. 

2. Double-click the folder to open it. 

You can now look at or use the contents, if you have the appropriate permission (see 
"Folder and Directory Access Permissions," earlier in this chapter). 

Creating a new folder 

To create a new folder in which to store files, you must have write and execute permissions in 
its parent folder. See "Folder and Directory Access Permissions," earlier in this chapter, for 
information about access permissions. 

• Note: If write permission to the newly opened folder is denied, the icon representing 
a pencil with a line through it appears in the upper-left corner of its window, as in 
Figure 2-23. 
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• Figure 2-23 Write permission to a folder denied 

r Write permission denied 
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Follow these steps to create a new folder in the start folder: 

1. Double-click the start folder (if it isn't already open). 

2. Choose New Folder from the File menu. 

A new folder (called "Empty Folder") appears selected in the directory. Figure 2-24 
shows a new folder. 

3. Type a name for the folder. 

As soon as you begin typing, the highlighted name "Empty Folder" is replaced by the 
characters you type. 

The folder name can have up to 31 characters. Use only letters, numbers, or the 
underscore character. Do not use the slash character. It is best to use an underscore 
character instead of a space, or to precede a space with a backslash character. 

• Figure 2-24 A new folder 

• 
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Removing a folder 

To remove a folder, you must have correct access permissions (see "Folder and Directory 
Access Permissions," earlier in this chapter). You can remove a folder only when its contents 
are not in use. 

To remove the folder you created in the previous section, follow these steps. 

1. Click the new folder to select it. 

2. Drag the folder to the Trash. 

When the Trash icon is selected, release the mouse button. If you're sure you still 
want to get rid of the folder, proceed to step 3. However, you can still retrieve the 
folder if you decide you don't want to remove it. Double-click the Trash icon. The 
folder appears in the Trash window. You can drag it to the folder in which you want 
to store it. 

3. Choose Empty Trash from the Special menu. 

The folder is now removed permanently from the file system. If you don't choose 
Empty Trash, the folder is thrown away at an unspecified time, depending on your 
actions. For example, the Trash is emptied automatically when you log out. Also, 
some applications automatically empty the Trash when they are opened. 
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Manipulating your files 

You can create files; copy or move them to a new location; view, edit, or print them; and 
analyze, compare, or sort their contents. This section describes how to manipulate your 
files with the A/UX Finder. Before carrying out the instructions in this section, you must 
have the appropriate access permissions. For information about A/UX CommandShell 
command equivalents, see Chapter 3, "Customizing Your Work Environment." See also 
A/UX Command Reference. 

Creating a ftIe 

You can create new files in several ways: 

• Create a ftle with one of the A/UX text editors. 

See Chapter 6, "Writing with TextEditor," for details. 

• Select a ftle and choose the Duplicate command in the File menu of the 
A/UX Finder. 

This creates a new file whose contents are identical to those of the old file. If it 
is a text file, you can use a text editor to change its contents and save it under a 
new name. 

Opening a ftIe 

You can open any file that appears as an icon in the A/UX Finder. 

1. Locate the ftle's icon in the appropriate folder. 
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2. Double-click the rue's icon. 

If you have opened an icon representing an A/UX command, CommandShell 
is launched, the CommandShell menu bar appears, and a new CommandShell 
window appears. Then you see a Commando dialog box that allows you to 
build the command. See Chapter 4, "Using Commando," for more information 
about Commando. 

If you open a text file, the default text-editing application also opens. For details on 
the default text editor, see Chapter 6, "Writing with TextEditor." 

Copying a ftle 

Follow these steps to make a copy of a file: 

1. Select a rue by clicking its icon in the Finder. 

2. Choose Duplicate from the File menu. 

A new file icon appears with the name "Copy of filename," as shown in Figure 2-25. 

• Figure 2-25 A copy of a file 

i i 
letter 1 Copy of letter 1 
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Renaming a fue 

To change the name of a file, you simply edit it in the Finder. Follow these steps. 

1. Select the ftle you want to rename. 

The icon appears selected, and the pointer turns to an I-beam when positioned in 
the title area. 

2. Position the I-beam where you want to edit, then click. 

D If you want to change the entire name of the file, drag over the name and 
press DELETE. 

D If you want to add to the name, click in the space where you want to add text. 

D If you want to replace text, select the text block. 

3. Type the new name. 

A filename can be up to 31 characters long. Use only letters, numbers, or the 
underscore character. Do not use the slash character. It is best to use an underscore 
character instead of a space, or add a backslash character before the space. 

Moving a fue 

To move a file to a new location in the file system, drag it to the desired spot. Follow 
these steps: 

1. Locate the ftle you want to move by opening folders until you see the icon 
that represents the ftle. 

2. Locate the destination for the ftle. 

The destination folder doesn't have to be open; you can drag a file to a closed 
folder. You must have write and execute permissions for the. destination folder 
before you can put a file in it. 
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3. Drag the fde to the new location. 

An outline of the file icon moves as you drag. When you release the mouse button, 
the file icon appears in the new location. 

• Note: If you drag an icon between file systems (for example, from the the hard disk 
to a floppy disk or from a Macintosh to an A/UX file system), the file or folder you 
drag is copied rather than moved. For further information on dragging an icon 
between file systems, see "Copying Between Macintosh and A/UX File Systems," later 
in this chapter. 

Removing a file 

To remove a file, follow these steps: 

1. Locate the fde you want to remove by opening folders until you see the icon 
that represents the fde. 

2. Drag the fde to the Trash. 

When the Trash icon is selected, release the mouse button. If you're still sure that you 
want to get rid of the file, proceed to step 3. However, you can still retrieve the file 
if you decide you don't want to remove it. To retrieve it, double-click the Trash 
icon. The file appears in the Trash window. You can drag it to the folder in which you 
want to store it. 

3. Choose Empty Trash from the Special menu. 

The file is now removed permanently from the file system. If you don't choose 
Empty Trash, the file is thrown away at an unspecified time, depending on your 
actions. For example, the trash is emptied automatically when you log out. Also, 
some applications automatically empty the trash when they are opened. 
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Locating a ftIe 

If you can't remember where you stored a file, you can search for it by using the Find File 
accessory or the A/UX find command (which will probably work much more quickly). 

The Find File Accessory 

Find File is a Macintosh desk accessory that searches both the A/UX and Macintosh file 
systems for a filename or part of a filename. Follow these steps to locate a file: 

1. Choose Find File from the Apple menu. 

A dialog box appears, as shown in Figure 2-26. 

• Figure 2-26 The Find File dialog box (after the search) 
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2. Type the name of the ftIe for which you want to search. Type pas swd for this 
tutorial. 

You can type the whole name or part of a name. Find File will report any filename that 
contains the string of letters you type. 

3. Press RETURN or double-click the "run" icon (the picture of the 
person running). 

4. After the names of the found flIes appear, click the name of the ftIe you want 
to locate. 

The file location appears in the bottom right of the box, as shown in Figure 2-26. The 
full path is indicated, starting at the root (/), which is the lowest item in the bottom
right window. You may have to scroll down to see the beginning of the path. 

5. Click the close box to exit Find File. 

If you have some idea of where the file you're looking for is located, Y0U can narrow the 
search as follows: 

1. With the Find File dialog box displayed, choose Search Here in the Find File 
menu of the menu bar. 

The Search Here dialog box appears, as in Figure 2-27. 

• Figure 2-27 The Search Here dialog box 
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2. Use this dialog box to locate and choose the starting point of the search. 

The find utility 

A/UX provides a utility to search the file system for filenames. Follow these steps to use the 
find utility. In this tutorial, you will find the location of a file called passwd. 

1. Double-click the find icon in the Useful Commands folder. 

A Commando dialog box appears for the find utility, as shown in Figure 2-28. 

• Figure 2-28 The find Commando dialog box 
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2. Click the "Specify start point" button. 

This allows you to tell the system where to begin the search. The only thing you know 
about the pas s wd file is that it is one of the files used by the system. For this 
reason, chances are that it is not too far from the root. Therefore, you will start the 
search from the root. 

3. Click the "Starting directory( s)" button. 

The dialog box shown in Figure 2-29 appears. 

• Figure 2-29 The Starting Directory(s) dialog box 
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4. Click the icon representing the A/UX root, at the upper right of the 
dialog box. 

Note that the same icon now appears just below the Add Current Directory 
button. That means that the root is now the current directory as far as this dialog 
box is concerned. 
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5. Click the Add Current Directory button. 

The slash character, which represents the root, appears in the box labeled "Select 
files and/or directories," at the bottom of the screen. 

The filled-in dialog box is shown in Figure 2-30. 

• Figure 2-30 The Starting Directory(s) dialog box filled in 
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The find Commando dialog box now reappears. 

7. Type passwd in the "File name" text box. 

The filled-in Commando dialog box is illustrated in Figure 2-31. 
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• Figure 2-31 The find Commando dialog box filled in 
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8. Click "Print ftle pathname." 

9. Click the "find" button at the lower right of the dialog box. 

After a few moments, you see a CommandS hell window listing the pathnames of all files 
named passwd. 

• Note: The find command searches for an independent word, that is, in the example 
given above, it finds only files named passwd, and ignores those named yppasswd, 

opas swd, etc. 
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Storing Macintosh files 

You can use Macintosh software and files regardless of their storage location (see 
"Working with Macintosh Files in A/UX" in Chapter 1, "Starting and Finishing a Work 
Session"). As a general rule, you will rarely move files between file systems. However, 
you may want to store Macintosh data files and applications in your A/UX file systems 
for several reasons; for example: 

• to set A/UX access permissions for Macintosh text files 

• to share Macintosh files with other users on an A/UX network 

• to allow your Macintosh files to be backed up with A/UX backup utilities, along with 
your A/UX files 

See the next section, "Copying Between Macintosh and A/UX File Systems." 

Copying between Macintosh and A/UX file systems 

Copy Macintosh files to the A/UX file system or A/UX files to the Macintosh file system 
as follows: 

1. Be sure that you are in the Finder. 

The icon that represents the Macintosh hard disk or floppy disk must be visible. See 
"Working with Macintosh Files in A/UX" in Chapter 1, "Starting and Finishing a Work 
Session," for further information. 

2. Double-click the disk icon and all necessary folder icons until the 
appropriate fde icon is visible. 

3. Drag the icon of the fde you want to transfer from the original location to 
the new location. 

When you release the mouse button, a dialog box appears that shows the progress of 
the copy operation. This transfer actually makes a copy of the file in the new folder. 
The original file remains on the original disk. 
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Backing up and restoring critical files 

This section presents the simplest ways for you to create backup copies of your critical files 
and of your whole system. 

D Important You should always have backup copies of your own files. A 
system administrator should do a periodic backup of all the 
files on your system. 6 

If you need to back up your entire disk, follow the instructions in "Using the cpio Utility to 
Back Up Your Entire Hard Disk." 

Inserting floppy disks 

When you insert floppy disks, the system can respond in a variety of ways, depending 
on how the floppy disk was initialized and upon whether you are currently working in the 
Finder or in CommandS hell. 

If you want to back up a folder or a file by dragging an icon to the floppy disk's icon, you 
need to be in the Finder and to insert a floppy disk that is initialized for the Macintosh file 
system. For further information on this method of backing up files, see "Dragging to Copy a 
File to a Floppy Disk," later in this chapter. 

If you want to use standard A/UX backup utilities, such as tar or cpio, you need to be in 
CommandShell and to use a destination disk that has been formatted. For further information 
on using cpio, see "Using the cpio Utility to Back Up Files," later in this chapter. 

For more information on the Finder, see "Identifying What you See on the Screen" and "Using 
the Finder," earlier in this chapter. 

For more information on CommandShell, see Chapter 5, "Using CommandShell." 

For information on making backup copies, see AlUX Local System Administration. 
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If you are in the Finder 

If the floppy disk has been initialized for the Macintosh file system, its icon, shown in 
Figure 2-31, appears near the right edge of the screen. 

• Figure 2-32 A Macintosh floppy disk icon 

text backup 

If the floppy disk has not been initialized for the Macintosh file system, you see a series of 
dialog boxes warning you that this is the case. These dialog boxes guide you through the 
initialization process. 

1. In the first dialog box (illustrated in Figure 2-33), click Two-Sided. 

2. When the second dialog box appears, click Erase. 

You may click Cancel if the disk contains data that you don't want to erase. 
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• Figure 2-33 Disk-initialization dialog boxes 

This is not a Macintosh disk:: 

Do you want to initialize it? 

n Eject J [one-Sided] [Two-Sided] 

1.\, This process will erase all 
~ information on this disk:. 

Cancel n Erase J 

If you are in CommandS hell 

If the floppy disk has been initialized for A/UX data (for example, a UNIX file system, tar, or 
cpio) nothing happens; no icon appears and no dialog box appears. Therefore, you cannot 
use the Finder or the menus in the menu bar with this disk. You can work with it only by using 
A/UX command-line commands. You may use it for backing up files with A/UX backup 
utilities, such as tar or cpio. 

If the floppy disk has never been initialized, or if it is initialized for a Macintosh file system, a 
dialog box (shown in Figure 2-34) asks you to specify whether you want to use it for the 
Macintosh file system or for an A/UX file system. A third choice is to eject the disk (and 
therefore to qmcel the procedure). 
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• Figure 2-34 Initializing for a Macintosh or an A/UX data disk 

This is a Macintosh disk. 
What do you want to use it as? 

(Macintosh) 

€ R/UH Data» Eject 

• If you click A/UX Data, after the initialization is complete, the disk behaves like the A/UX 
disk described above (that is, no icon appears, and so on). 

• If you click the Macintosh button, the ensuing dialog boxes guide you through the 
initialization process for a Macintosh HFS file system disk. You must use the Macintosh 
disk with the Finder. 

Dragging to copy a file to a floppy disk 

A/UX 2.0 provides a very easy way to copy individual files and groups of files. Follow 
these steps: 

1. Be sure that you are in the Finder. 

2. Insert a floppy disk (initialized for the Macintosh fue system) into the 
disk drive. 

You see an icon representing the disk. 

3. Drag the icon of the fue or folder that you want to copy to the floppy 
disk icon. 

A dialog box appears describing the progress of the copy operation. 

You can shift-click to select multiple files or folders to back up. 
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Dragging to restore a ftle 

A/UX 2.0 provides a very easy way to restore files or folders that were backed up by dragging 
their icons to a disk. Follow these steps: 

1. Insert in the drive the floppy disk containing the ftle you want to restore. 

You see an icon representing the disk. 

2. Double-click the disk icon to display a window with the disk's contents. 

3. Drag the icon of the ftle or folder that you want to copy to the folder where 
you want it to reside. 

A dialog box appears describing progress of the copy operation. 

You can shift-click to select multiple files or folders to restore. 

Using the epio utility to back up ftles 

A/UX provides several utilities to back up files. In this section you learn about the cpio (copy 
in and out) utility, which copies data in a stream of bits. This section describes one way to 
copy a file for backup purposes. 

1. Choose CommandShell in the Apple menu. 

A window appears with a command prompt. For further information on the 
CommandShell, see Chapter 5, "Using CommandShell." 

2. Insert a floppy disk into the disk drive. 

It should be initialized as an A/UX disk, not a Macintosh disk. (See "If You are in 
CommandShell," earlier in this chapter.) Since this is not a Macintosh disk, the 
desktop does not display an icon representing the disk. 

3. Enter the command: 
echo filename I cpio -0 > /dev/rfloppyO 

Substitute the name of the file you want to copy for the italicized word. Your 
computer may have a second floppy disk drive available. If you are using the 
alternate drive, substitute /dev/rfloppyl for /dev/rfloppyO. 
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• Note: You can also use Commando to enter this command. See Chapter 4, "Using 
Commando," for more information about Commando. The CommandS hell window 
must be active before you insert the floppy disk, whether you use Commando or the 
preceding steps. 

For more information on the cpio utility, see cpio(1) in A!UX Command Reference. 

Using the cpio utility to restore flIes 

The cpio (copy in and out) utility copies data in a stream of bits. This section describes one 
way to restore a file from a cpio copy of the file. 

1. Choose CommandShell in the Apple menu. 

A window appears with a command prompt. For further information on 
CommandShell, see Chapter 5, "Using CommandShell." 

2. Insert in the drive the floppy disk containing a ftle you want to restore. 

Remember, you can restore a file in this way only if you used cpio to back it up. 

Because the floppy disk does not contain a Macintosh file system, your desktop 
does not display a disk icon. However, when you specify the disk in the command 
line, the cpio utility will locate the disk and restore the file. 

3. Enter the command: 
cpio - i v filename < / dev / floppyO 

Substitute the name of the file you want to copy for the italicized word. Your 
computer may have a second floppy disk drive available. If you are using the 
alternate drive, substitute /dev/rfloppyl for /dev/rfloppyO. 

• Note: You can also use Commando to enter this command. See Chapter 4, "Using 
Commando," for more information about Commando. The CommandS hell window 
must be active before you insert the floppy disk, whether you use Commando or the 
preceding steps. 
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For more information on the cpio utility, see cpio(1) in A!UX Command Reference. 

Using the cpio utility to back up your entire hard disk 

You can use the cpio (copy in and out) utility to back up and restore your entire hard disk. 
This section describes how to back up your disk onto another hard disk. Before beginning, be 
sure that your destination hard disk has been initialized as an A/UX file system with the HD SC 
setup utility and is properly cabled to your system. 

1. Choose CommandS hell to bring the shell utility to the front layer. 

A window appears with a command prompt. For further information on the 
CommandShell, see Chapter 5, "Using CommandShell." 

2. Enter the command: 
find / -print I epio -0 > /dev/rdsk/c?dOs31 

Substitute the SCSI ID number of the destination hard disk for the italicized 
question mark. 

• Note: You can also use Commando to enter this command. See Chapter 4, "Using 
Commando," for more information about Commando. 

For more information on the cpio utility, see cpio(1) in A!UX Command Reference. 

Using the cpio utility to restore the entire hard disk 

This section describes one way to restore an entire disk from an external hard disk. Use this 
method if you previously used the cp i 0 utility to back up the disk. 

1. Choose CommandS hell to bring the shell utility to the front layer. 

A window appears with a command prompt. For further information on the 
CommandShell, see Chapter 5, "Using CommandShell." 
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2. Enter the command: 
epio -id < /dev/rdisk/c1dOs31 

In place of the question mark, type the SCSI ID number of the hard disk containing 
the backup data. 

• Note: You can also use Commando to enter this command. See Chapter 4, "Using 
Commando," for more information about Commando. 

For more information on the cpio utility see cpio(1) in A/UX Command Reference. 

Pathnames in the A/UX ftle system 

A/UX differs from traditional forms of UNIX in that A/UX has the friendliness of the 
Macintosh interface. It offers the easy-to-use Finder, which allows you to manipulate 
files and folders by manipulating their icons. However, if you need to work with the 
CommandShell command-line interface, you will find it necessary to understand 
traditional ways of describing a UNIX file system. 

The "folders" of the Macintosh environment correspond to the "directories" of the 
UNIX world. Since this section describes the traditional UNIX way of using pathnames 
in the A/UX CommandS hell window, the word "directory" is used here. 

The A/UX file system is organized in a hierarchy. Figure 2-35 shows an example of this 
organization. Organized from top to bottom, the file system begins at the top with the root 
directory, which is always represented by the slash character(/). Branching downward from the 
root of the file system are the rest of the directories and files in the system. The root directory 
contains a number of directories that store the operating-system files and programs. There is 
only one A/UX file hierarchy for a given system. All additional directories, file systems, and 
files fall within this hierarchy. 

Chapter 2 Getting Around in A/UX 2-53 
030-07S9-A 



• Figure 2-35 The A/UX file-system structure 
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Because of its hierarchical organization, A/UX uses pathnames to refer to files and directories. 
A pathname is a name that describes where the file or directory is located in the hierarchy. 
Here is an example: 
/users/start/letterl 

Here, the file named letterl is located within (or "below," in UNIX terminology) the start 

directory, which is located below the users directory, which, in turn, is located below the 
root directory. 

The directory in which you are currently working is the current directory. When you change 
directories, the directory you move to becomes your new current directory. 

An absolute pathname of a file shows the complete path from the root to the file in question, 
by listing all directories that lead from the root directory and concluding with the filename 
itself. The first item in an absolute pathname is always the character /, which indicates the 
root. Thereafter, the slash character is used to separate the names of the directories. An 
example is 
/users/start/letterl 

We know that this is an absolute pathname because it begins with the slash character, and is 
thus tracing the path from its origin at the root. The subsequent slash characters separate the 
names of the users and the start directories, and the names of the start directory and 
file letterl. 

A relative pathname lists the directories leading to the file, beginning with the current 
directory. For example, if the current directory is /users, then 
start/letterl 

is the relative pathname of /users/start/letterl. Note that a relative pathname never 
begins with the / character, because it doesn't start at the root. 

The name of the file or of the directory whose path is being described is the last component 
of a pathname. Figure 2-36 shows an absolute pathname that ends with the filename. 

When you are specifying a file that is in your current directory, just type the filename. You 
needn't specify its directory, because you're already working in that directory. 

Two dots ( .. ) are an abbreviation for "the directory that contains the current directory." For 
example, if you are in the /users/start directory, you need only type the two dots (. .) to 
specify the / use r s directory with a relative pathname. 
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• Figure 2-36 An absolute pathname 
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Chapter 3 Customizing Your Work Environment 

This chapter explains how to create your own personal System Folder so 
that you can customize the work environment of your user account. 

This chapter contains the following sections: 

• Creating a personal system folder 

• Changing your work environment 

• Using desk accessories 

• Using fonts 

• Using the Control Panel 
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Creating a personal system folder 

The A/UX system operates from a global System Folder that controls the operating 
environment for all users of the system. If your system has more than one user account, 
and you want to use fonts, desk accessories, or a desktop pattern different from the 
owners of the other user account(s), then you need to add a personal System Folder to 
your account. You may then customize your work environment by making changes to 
your personal System Folder. 
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• Figure 3-1 The global System Folder and the personal System Folder 
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Since A/UX is a multiuser system, there are certain aspects of A/UX that only the system 
administrator can change. Although you cannot alter the contents of the global System 
Folder, you can make changes to your personal System Folder in your user account, provided 
you have one. 

If you do not have a user account, you need to create one or have one created for you. 
Contact your system administrator or see Setting Up Accounts and Peripherals for A/UX for 
information on creating your own. 

Once you have a user account, check to see if it contains a personal System Folder. Double
click your user account folder that appears on the desktop. Look inside the folder for a folder 
named System Folder. If there is no system folder within your user account, you'll need to 
create one. You do this by running the shell script systemfolder. A shell script is a small 
program that is created to automate a frequently repeated task. You may also run shell scripts 
using Commando. To learn more about Commando, See Chapter 4, "Using Commando." 

To create a personal System Folder, do the following: 

1. Log in to your user account. 

To learn how to do this see "Logging In to Your User Account or the root Account" in 
Chapter 1, "Starting and Finishing a Work Session." 

2. Open a CommandShell window by choosing CommandShell from the 
Apple menu. 

A new CommandShell window appears. 

3. Type systemfolder at the CommandShell prompt and press RETURN. 

The systemfolder script runs, creating a copy of the global System Folder, and 
placing it in your user account. 

Once you add to or modify your personal System Folder, you must log out and then 
log back in to see your changes take effect. 

4. Log out of your user account by choosing Logout from the Special menu. 
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Changing your work environment 

You can personalize your user account in several ways. For example, you can change the 
speaker volume and the desktop pattern. You can also add and remove different fonts and 
desk accessories. 

Using fonts 

Fonts are a complete set of characters in one design, size, and style. Seven different fonts
Chicago, Courier, Geneva, Helvetica, Monaco, New York, and Times-are installed on your 
system at the factory. You may see more than these if the system administrator has added 
additional fonts to your system. 

You can use an application called the Font/DA Mover to add fonts and desk accessories to 
your personal system (or remove them from your system). The Font/DA Mover icon is shown 
in Figure 3-2. 

• Figure 3-2 The Font/DA Mover icon 

Font 10 A Mover 

The Font/DA Mover is on the Utilities disk that came with your computer. For easy access, 
copy the application to your hard disk. 
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Installing fonts on your personal system 

To install additional fonts on your personal system, do the following: 

1. Log in to your user account. 

To learn how to do this see "Logging In to Your User Account or the Root Account" in 
Chapter 1, "Starting and Finishing a Work Session." 

2. Open the FontiDA Mover by double-clicking its icon. 

The Font/DA Mover window becomes active, with the Font option selected. 
Figure 3-3 shows the Font/DA Mover dialog box. 

• Figure 3-3 The Font/DA Mover dialog box 
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The box on the left contains a list of the fonts currently installed in the system. 
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3. Click the Open button, located below the empty list box at the right of 
the window. 

A dialog box appears. Use this box to locate and open a font file. If necessary, use 
the Drive, Eject, and Open buttons to locate the font file you want. You may also 
insert a floppy disk that contains a font file. 

4. Open the ftle containing the fonts. 

You can either double-click the filename, or select it and click the Open button. 

The dialog box disappears, and the fonts in the file are shown in the list on the right 
of the Font/DA Mover dialog box. 

5. Select the font you to want to install by clicking its name in the list on 
the right. 

You may have to scroll through the list to find the font you want. The small arrows in 
the Copy button show the direction in which the selected fonts will move. Figure 3-4 
shows the Font/DA Mover Copy dialog box. 

• Figure 3-4 The Font/DA Mover Copy dialog box 
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A sample of the font appears in the message area at the bottom of the window, 
and the amount of disk space occupied by the font is displayed between the two 
list boxes. 

You may select more than one font from the list by holding down the SHIFT key while 
clicking the names of the fonts. The combined size of your selection is displayed, 
but no sample appears in the message area. 

6. Click Copy to add the selected font or fonts to your personal system. 

A dialog box appears, warning you that the fonts you are installing may not appear in 
your system until you restart the machine. Logging out will achieve the same results. 
See step 9. 

7. Click OK. 

The items are copied into the target file. The names of the new fonts appear in 
alphabetical order in the list on the left. 

8. Click Quit at the bottom center of the window when you have ftnished 
installing fonts. 

Once you add to or modify your personal System Folder, you must log out and then 
log back in to see your chariges take effect. 

9. Log out of your user account by choosing Logout from the Special menu. 

Removing fonts from your system 

You may find it necessary to remove fonts from your system at some point to gain space in 
memory. To remove fonts from your personal system, do the following: 

1. Log in to your user account. 

To learn how to do this see "Logging In to Your User Account or the Root Account" in 
Chapter 1, "Starting and Finishing a Work Session." 
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2. Open the Font/DA Mover by double-clicking its icon. 

The Font/DA Mover window is made active, with the Font radio button selected. 
The box at the left contains a list of the fonts that are currently installed in your 
personal system. 

3. Select the font you want to remove by clicking once on its name in the list 
on the left. 

Scroll through the list of fonts if necessary to find the font you want to remove. A 
sample of the font is displayed in the message area at the bottom of the window, 
and the space the item occupies on the disk is displayed between the two list boxes. 
You may select more than one font from the list by holding down the SHIFT key while 
clicking the name of the font. The combined size of your selection is displayed, but 
no sample appears in the message area. 

4. Click Remove to remove the selected font or fonts. 

An alert box appears, asking you to confirm or cancel the action. 

5. Click OK to remove the selected font. 

If you change your mind, click Cancel. 

6. Click Quit at the bottom center of the window when you have ftnished 
removing fonts. 

Once you add to or modify your personal System Folder, you must log out and then 
log back in to see your changes take effect. 

7. Log out of your user account by choosing Logout from the Special menu. 

Using desk accessories 

Desk accessories are mini-applications that are available from within most applications and 
are always available in the Finder. Seven desk accessories-the Alarm Clock, Calculator, 
Chooser, Find File, Key Caps, Scrapbook, and Control Panel-are installed automatically. You 
choose desk accessories from the Apple menu, found at the far left of the menu bar. 
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Installing desk accessories on your system 

To install desk accessories on your personal system, do the following: 

1. Log in to your user account. 

To learn how to do this see "Logging In to Your User Account or the Root Account" in 
Chapter 1, "Starting and Finishing a Work Session." 

2. Open the Font/DA Mover by double-clicking its icon. 

The Font/DA Mover window becomes active, with the Font option selected. At the 
left of the window you see a box containing a list of the fonts currently installed on 
your personal system. Figure 3-3 shows the Font/DA Mover dialog box. 

3. Click Desk Accessory at the top of the window. 

The list on the left changes to show the desk accessories currently installed on your 
personal system. 

4. Click the Open button, located below the empty list box at the right 
of the window. 

A dialog box appears. Use this box to locate and open the file containing the 
desk accessories you wish to add to your personal system. If necessary, use the 
Drive, Eject, and Open buttons to locate the file. Seven desk accessories are 
already installed on your A/UX system. Hundreds of other desk accessories are 
available from independent vendors, user groups, computer bulletin boards, and 
various other sources. 

5. Open the ftle containing the desk accessories. 

You can either double-click the filename, or select it and click the Open button. 

The dialog box disappears, and the desk accessories in the file are listed in the box 
at the right of the Font/DA Mover dialog box. 

6. Select the desk accessory that you want to install by selecting its name in 
the list on the right. 

The small arrows in the Copy button show the direction in which the selected desk 
accessories will move. The amount of space occupied by the desk accessory (its 
"size") is displayed between the two list boxes. 
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If you select more than one desk accessory from the list (by Shift-clicking), the 
combined size of your selection is displayed. 

7. Click Copy to add the selected desk accessories to your personal system. 

A dialog box appears, warning you that the desk accessories you are installing may 
not appear in your system until you restart the machine. Logging out will achieve the 
same results. See step 10. 

8. Click OK. 

The desk accessories are copied into your personal system. The names of the new 
desk accessories appear in alphabetical order in the list on the left. 

9. Click Quit at the bottom center of the window when you have fmished 
installing desk accessories. 

Once you add to or modify your personal System Folder, you must log out and then 
log back in to see your changes take effect. 

10. Log out of your user account by choosing Logout from the Special menu. 

Using the Control Panel 

The Control Panel is a desk accessory that allows you to customize your work environment. 
You access the Control Panel by choosing it from the Apple menu. Figure 3-5 shows the 
General Control Panel. 

Chapter 3 Customizing Your Work Environment 3-11 
030-0759-A 



• Figure 3-5 The General Control Panel 

rFil 
~ 

GE'nE'ral 

~
.o 

00 
0. 
Color 

:-1 
MacTCP 

Monitors 

3.3.2 

Control Panel 

RatE' of InsE'rtion 
Point Blinking 

DE'sktop P attE'rn O@O 
Slow Fast 

ME'nu Blinking TimE' C9 7-
2:13:28 AM 6 -

~ 5 -
--- @ 12hr. o 24hr. 4 -

3 

o OO@ DatE' mJ 2 -
1 -

Off 1 2 3 2/14/90 0-

RAM CachE' 1256K I III OOn SpE'akE'r 

@Off VolumE' 

On the left side of the panel is a list of icons, such as Color, Monitors, Sound, and so on. You 
can scroll through the list to look at additional icons. When you dick an icon, a set of features 
related to that icon appears at the right. When you select the General icon from the list, you'll 
find the settings for such items as Desktop Pattern and Menu Blinking in the panel on the 
right. Similarly, settings for Color, MacTCP, Monitors, and Sound, all appear on the right when 
you dick the corresponding icon. 

Changing the desktop pattern 

You can change the pattern of your desktop by selecting a preset pattern or by creating 
your own. 
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Selecting a preset pattern 

To select a preset pattern, do the following: 

1. Log in to your user account. 

To learn how to do this see "Logging In to Your User Account or the Root Account" in 
Chapter 1, "Starting and Finishing a Work Session." 

2. Choose Control Panel from the Apple menu. 

The General Control Panel appears. 

The Control Panel shows a miniature desktop that displays a normal-sized and a 
magnified representation of the current desktop pattern. The desktop pattern 
control area is shown in Figure 3-6. 

• Figure 3-6 The desktop pattern control area 
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3. To see the preset patterns, click the white menu bar at the top of the 
miniature desktop. 

Each time you click the menu bar, a different pattern appears until you cycle through 
all of the preset patterns. There are 40 patterns to choose from. Once you have 
viewed all of the patterns, the cycle repeats. 

4. Once you ftnd a pattern you like, click once on the miniature desktop to 
select it. 

5. Click the close box in the upper-left corner of the Control Panel. 

The new desktop pattern appears on your screen. 

Creating your own desktop pattern 

To create a new desktop pattern, do the following: 

1. Choose Control Panel from the Apple menu. 

The General Control Panel appears. 

The Control Panel shows a miniature desktop that displays a normal-sized and a 
magnified representation of a pattern. 

2. In the creation area at the left of the miniature desktop, click the dots you 
wish to change. 

Try dragging the pointer through the creation area while holding down the mouse 
button. Notice how clicking a black dot will change it to white and vice-versa. 
Try this technique a few times. The results appear in the miniature desktop area 
on the right. 

3. Click once on the miniature desktop to select the new pattern. 

4. Click the close box in the upper-left corner of the Control Panel. 

The new desktop pattern appears on your screen. 
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Setting the blinking speed of the insertion point 

When you insert text in a CommandShell, TextEditor, or vi window, the insertion point 
blinks on and off so that it is easy to see. You can adjust the rate at which it blinks by doing 
the following: 

1. Choose Control Panel from the Apple menu. 

The General Control Panel appears. 

The insertion point control area is illustrated in Figure 3-7. 

• Figure 3-7 Insertion point control area 
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2. Click any button from Slow to Fast to set the rate at which the vertical bar 
marking the insertion point blinks. 

As you click each option, you will see the insertion point blink at the rate you 
have selected. 

3. Click the close box in the upper-left corner of the Control Panel. 

The insertion point blinks at the rate you have set. 
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Setting the menu blinking speed 

The menu blinking speed determines the number of times a menu command will blink when it 
is chosen. For example, when you select Print from the File menu, the command blinks three 
times (by default) to acknowledge the selection. To adjust the rate, do the following: 

1. Choose Control Panel from the Apple menu. 

The General Control Panel appears. 

The menu blinking control area is illustrated in Figure 3-8. 

• Figure 3-8 Menu blinking control area 
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2. Click any button from 1 to 3 to determine the number of times commands 
blink when you choose them. 

If you do not want the menu to alert you by blinking, click Off. 

3. Click the close box in the upper-left corner of the Control Panel. 

The menu blinks at the rate you have set. 
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Setting the time and date 

Setting the time and date in A/UX is done using the date command. See Chapter 5 of the 
AlUX Installation Guide for more information. 

Using color 

When you select text or icons on the screen, they are highlighted. A highlight is text or 
icons that appear as light figures or letters on a dark background, rather than dark on light. 
Highlighting is accomplished by inverting the display. On a monochrome monitor, the 
highlight is always black or gray, but on a color monitor you can make your highlights as 
colorful as you like. You use the Color Wheel to change the highlight color. 

To change the highlight color, do the following: 

1. Choose Control Panel from the Apple menu. 

The General Control Panel appears. 

2. Click Color in the list of icons on the left side of the Control Panel. 

If necessary, use the scroll bar to bring the Color icon into view. Figure 3-9 shows the 
Color Control Panel. 
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• Figure 3-9 Color Control Panel 
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You see an example of the current highlight color and the Change Color button. 

3. Click Change Color. 

The Color Wheel appears. The Color Wheel is illustrated in Figure 3-10. 
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• Figure 3-10 The Color Wheel 
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With the standard Apple video card, you can display a maximum of 16 colors on the 
screen. If you have the video card expansion kit installed, you can display a 
maximum of 256 colors, chosen from a palette of over 16 million. The Color Wheel 
lets you controls these different color possibilities. 

4. Click anywhere on the Color Wheel to display a new color. 

When you do this, the color you have selected appears in the top half of the small 
display box in the upper-left corner of the window. The bottom half of the display 
box continues to show the current highlight color. 

The colors at the outer edge of the wheel are the purest in hue. As you move toward 
the center of the wheel you increase the amount of white added to the pure hue 
(known as saturation). To change the brightness of the colors, use the scroll bar to 
the right of the color wheel. (Down makes colors darker; up makes them brighter.) 
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5. When you are satisfied with the color you have selected, click OK. 

The new color replaces the old. 

• Note: If you do not have the video card expansion kit installed (or choose to 
limit the number of colors displayed to fewer than 256), the results of choosing a 
color from the Color Wheel dialog box are sometimes unpredictable. The color 
you see is not necessarily the color you expected. Applications that use color 
may also impose their own definitions of the colors you can choose. 

The Keyboard Control Panel 

When you press and hold down a character key, that character appears again and again on the 
screen, filling the line of text until you release the key. You can set the rate at which the 
repeated character appears on the screen. 

Setting the Key Repeat Rate 

To set the Key Repeat Rate, do the following: 

1. Choose Control Panel from the Apple menu. 

The General Control Panel appears. 

2. Click the Keyboard icon. 

If necessary, use the scroll bar to bring the Keyboard icon into view. Figure 3-11 
shows the Keyboard Control Panel. 
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• Figure 3-11 The Keyboard Control Panel 
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3. Click any button from Slow to Fast to set the rate. 

Setting the Delay Until Repeat rate 

To the right of the Key Repeat Rate box is the Delay Until Repeat box. It controls how long a 
key can be held down before the character begins repeating. To set the Delay Until Repeat 
rate, do the following: 

1. Click the Keyboard icon if it isn't already highlighted. 

If necessary, use the scroll bar to bring the Keyboard icon into view. 

2. Click any button from Off to Short to set the rate. 

Keys will not repeat if you click the Off button. 

Keyboard Layout 

In the middle of the Keyboard Control Panel, you see the Keyboard Layout control area. This 
allows you to choose different keyboard configurations for machines running international 
system software. Click once on the configuration you want to select. 
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MacTCP network controls 

MacTCP is a utility that allows you to look at your network configuration. Although it appears 
in the Control Panel, you cannot make changes to the configuration. Figure 3-12 shows the 
MacTCP Control Panel. 

• Figure 3-12 MacTCP Control Panel 
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Changing the display mode of your monitor 

Some programs and utilities are hindered by the use of color, and you may need to turn off the 
color capabilities of your monitor at times. To adjust the characteristics of your monitor, do 
the following: 

1. Choose Control Panel from the Apple menu. 

The General Control Panel appears. 
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2. Click the Monitors icon. 

If necessary, use the scroll bar to bring the Monitors icon into view. Figure 3-13 shows 
the Monitors Control Panel. 

• Figure 3-13 Monitors Control Panel 
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3. Click either Grays or Colors. 

If you have a color monitor, you may select the number of colors to which you 
want access. 

4. Select the number of colors you want from the list on the right. 

The choices are 2, 4, or 16 colors. If you have a color monitor with an expanded 
video card installed, you also have the choice of 256 colors available in the list. 

5. Click the close box in the upper-left corner of the Control Panel. 

• Note: A/UX supports only one monitor at a time. 
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Changing the alert sound setting 

It is possible to change the sound that your computer makes when it beeps. 

To change the alert sound setting, do the following: 

1. Choose Control Panel from the Apple menu. 

The General Control Panel appears. 

2. Click the Sound icon. 

If necessary, use the scroll bar to bring the Sound icon into view. Figure 3-14 shows 
the Sound Control Panel. 

• Figure 3-14 Sound Control Panel 

o Control Panel 

Keyboard 

~-1 
MacTCP 

Monitors 

~)~ 

- K> 
3.3.2 

7 -
6 -
5 -
4 -
3-
2 
1 -
0-

Speaker 
Volume 

3-24 A/UX Essentials 
030-07S9-A 

A lert Sound Setting 

Boing 
Clink-Klank 
Monkey 
Simple Beep 



3. Click a sound in the Alert Sound Setting box. 

Your Macintosh computer comes with four sounds, Boing, Clink-Klank, Monkey, and 
Simple Beep. As you listen to each one, it is played at the volume you have selected. 

• Note: It makes no difference whether you set the speaker volume here or in the 
General Control Panel. When you adjust the volume in one, the volume is 
adjusted in the other as well. 

4. Click the close box in the upper-left corner of the Control Panel. 

Now that you have learned about customizing your work environment, you may want to go on 
to the next chapter, "Using Commando," to learn about commands and the Commando 
command-line building utility. 
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Chapter 4 Using Commando 

This chapter explains how to use the Commando command-line building 
utility to build and run command lines in A/UX 2.0. It describes commands 
and their importance to A/UX, the different parts of a command line, and 
ways to use the Commando utility to simplify working with commands. 

• What is Commando? 

• What is a command? 

• The parts of a Commando dialog box 

• Invoking Commando 
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What is Commando? 

The Commando command-line building utility lets you view and run most A/UX commands 
by means of special dialog boxes, rather than through the use of the traditional UNIX 
command line. Commando allows you to set flag options, open files, select folders, and 
access help information for commands and their options. Commando is also useful for 
building complex command lines. You can invoke Commando from either the Finder or 
the CommandS hell environment. 

What is a command? 

A/UX uses executable files called commands to accomplish specific tasks. Over 
500 executable commands are available in the A/UX operating system. 

Commands are entered on the command line, the traditional interface used in UNIX 
operating systems to issue commands or start programs. The command line includes the 
command itself and any arguments and flag options. A command line in a CommandShell 
window is illustrated in Figure 4-1. 

• Figure 4-1 A command line in a CommandShell window 
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To gain access to the command line, you must first make a CommandShell window active. 
To do so, choose CommandShell from the Apple menu. The Apple menu is at the far left 
of the menu bar. If no CommandShell window appears, choose New from the File menu, or 
press COMMAND-N. 

For instance, consider what happens when you type the command 
date 

on the command line and press RETURN. 

In this case, the computer receives the instruction to display the current date and time on the 
screen. A/UX displays the information in the following fashion: 
Tues Oct 17 17:04:00 PDT 1989 

A description of every A/UX command can be found in AlUX Command Reference. You may 
also view the on-line manual page for any A!UX command by typing 
man command-name 

and pressing the RETURN key. 

A manual page is an on-line version of the standard UNIX reference manual page that 
describes the function of a command and its options. Figure 4-2 shows part of the manual 
page for the da t e command. 
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• Figure 4-2 The date command manual page 
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NAME 
date - print and set the date 

SYNOPSIS 
date [mmddhhmm[yyll [+formatl 

DESCRIPTION 
If no argument is given, or if the argument begins with +, 
the current date and time are printed. Otherwise, the 
current date is set. The first mm is the month number; dd 
is the day number in the month; hh is the hour number (24 
hour system); the second mm is the minute number; and yy is 

the last 2 digits of the year number and is optional. If a 
number less than 70 is given, the year that results is 1970. 
For example, 

Notice the word More is highlighted in the lower-left corner of the manual page. This means 
that more information about the command remains to be viewed. Press the Space bar to see 
the next screen. If you wish to cancel viewing the manual page, type q. 

Identifying the parts of a command line 

Command lines consist of up to three different parts: the command, flag options, and 
arguments. Figure 4-3 shows the parts of a command line. 

• Figure 4-3 Parts of a command line 
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Flag options 

Flag options alter the normal execution of a command. The user controls these options either 
by typing them on the command line or selecting them from a Commando dialog box. 

For a complete list of all available flag options for every A/UX command, see 
AlUX Command Reference or check the appropriate on-line manual page. 

Command arguments 

Like flag options, command arguments are added to a command line, but they do not alter 
the command's execution. Filenames are often supplied as arguments to commands. 

For example, by entering 
cat letterl 

on the command line, you instruct the computer to display the contents of the file named 
letterl. The command cat instructs A/UX to display the contents of a file, and the 
argument let terl specifies the file on which A/UX is to operate. 
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The parts of a Commando dialog box 

Because no two A/UX commands perform the same function, no two Commando dialog 
boxes are exactly the same. However, most Commando dialog boxes have the same basic 
elements: radio buttons, check boxes, text boxes, and file buttons. In addition, all 
Commando dialog boxes have a Help box, Output and Error pop-up menus, and standard 
file buttons, such as Cancel. 

The grep Commando dialog box, shown in Figure 4-4, is an example that contains all of these 
elements. The grep command searches files for patterns. 

• Figure 4-4 The grep Commando dialog box 
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The Help box 

Although Commando is a useful tool for building command lines, it also serves as a quick 
command reference. At the bottom of every Commando dialog box you see a box labeled 
Help. This box contains a brief description of the command. The Help box also displays 
information about flag options. To see this information, click the desired flag option (either 
a radio button or a check box) and hold down the mouse button. 

Radio buttons 

Radio buttons are one way to select flag options in a Commando dialog box. Radio buttons 
are small circles organized into groups. Only one radio button in the group can be activated at 
anyone time. They work like the buttons on a car radio; clicking any button on turns off all the 
others in the group. 

Check boxes 

Check boxes are used to select flag options in a Commando dialog box. When you click a 
check box, you may add an option or affect related options. Unlike radio buttons, check 
boxes are not mutually exclusive; you may click as many check boxes as you wish. 

Text boxes 

Text boxes serve several purposes in Commando dialog boxes. You enter text into a text box 
by clicking in the box and typing the information. In the example in Figure 4-4, you type the 
text pattern you wish the grep command to search for. 

File buttons 

File buttons are found in many different forms in Commando dialog boxes. Their main 
purpose is to grant you access to files and folders in order to add arguments to command 
lines. The file button shown in Figure 4-4 is used to select the files on which you wish to 
perform a pattern search. 
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Output and Error menus 

Output and Error pop-up menus, which are available for every A/UX command, allow you to 
redirect output and error messages to a designated location. You may redirect it to a new file, 
an existing file, a null device, or choose not to redirect it at all. By default, standard output 
and error messages are sent to the active CommandShell window. Some Commando dialog 
boxes, like 1 s, shown in Figure 4-6, are equipped with dialog buttons that, when clicked, 
launch an additional dialog box containing the Output and Error pop-up menus. 

Additional buttons 

Each Commando dialog box is equipped with a Cancel button. Clicking the Cancel button will 
terminate any changes you have made in the Commando dialog box and return you to the 
active CommandS hell window. 

You may also see additional dialog buttons from time to time within Commando dialog 
boxes. Some of these dialog buttons, like the More options button in the 1 s Commando 
dialog box illustrated in Figure 4-6, contain additional flag options. 

Invoking Commando 

There are three different ways to gain access to a Commando dialog box. One method, 
double-clicking a command icon, is useful when you are working in the Finder. The most 
common method, typing the name of the command and choosing Commando from the Edit 
menu, is useful for building compound command lines when you are working in the 
CommandShell environment. Another method, typing cmdo followed by the name of the 
command, is useful when you are working in the CommandShell environment and want to 
run a command immediately. However this method of invoking Commando is not supported 
in 24-bit addressing mode. 

These three methods are described in greater detail in the next section. 
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Invoking Commando from the Finder 

You can launch a Commando dialog box from the Finder by double-clicking the appropriate 
command icon. 

When you log in to the start account and open the start folder, you will see a folder named 
Useful Commands. Inside this folder are a few of the most-commonly used A/UX commands. 
Figure 4-5 shows the Useful Commands folder. 

• Figure 4-5 The Useful Commands folder 
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• Note: When you first open the Useful Commands folder, the names of the commands 
may overlap. If this is the case, you may want to re-arrange the commands within the 
window, or view the contents of the folder by name. To do so, choose by Name from 
the View menu. 

For instance, to launch the 1 s Commando dialog box from the Finder, do the following: 

1. Log in to the start account. 

See "Logging In to the Tutorial Account" in Chapter 1 "Starting and Finishing a Work 
Session," for instructions on logging in to the start account. 

2. Open the start folder. 

You can do this by either double-clicking the folder icon or selecting the folder and 
choosing Open from the File menu. Inside the start folder you see a folder named 
Useful Commands. 

3. Open the Useful Commands folder. 

Inside the Useful Commands folder you see several commands. 

4. Double-click the ls (list files) command icon. 

The 1 s Commando dialog box, shown in Figure 4-6, appears 
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• Figure 4-6 The 1 s Commando dialog box 
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The 1 s Commando dialog box contains options that allow you to list the contents 
of folders. 

5. Click the "Is" button at the bottom-right corner of the dialog box. 

The 1 s Commando dialog box disappears, and a CommandShell window 
appears. The command runs. The results are automatically placed in the 
CommandShell window. 
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Because a simple 1 s command gives you a listing of the files in your current 
directory, the resulting list should look something like this: 
Useful Commands 
letterl 
memol 
setup 

• Note: Once you are in the CommandShell environment, you may easily return to the 
Finder by clicking the CommandShell icon at the right of the menu bar or by choosing 
Finder from the Apple menu. 

Using COMMAND-K to build simple command lines 

The most common method of invoking Commando is to type the name of the command in a 
CommandShell window and choose Commando from the Edit menu, or press COMMAND-K. This 
method of invoking Commando from a CommandShell window is very useful if you want to 
build compound command lines. This method differs from the other methods of invoking 
Commando in one significant way-the command is not immediately executed. 

To invoke Commando in this manner, type 
command-name 

in a CommandShell window and choose Commando from the Edit menu or press COMMAND-K. 

For example, to see a vertical list all of the files and directories in the start folder, do 
the following: 

• Note: You may not be familiar with the term directory. Directories are the same as 
folders in A/UX. 
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1. From the start account, open a CommandShell window by choosing 
CommandS hell from the Apple menu. 

If a CommandShell window is already open, you can use it. You can also open 
a new CommandShell window by choosing New from the File menu, or 
pressing COMMAND-N. 

2. Type 1 s at the shell prompt, but do not press RETURN. 

3. Choose Commando from the Edit menu or press COMMAND-K. 

The 1 s Commando dialog box appears. 

4. Click the "Mark directories" and "sorted vertically" radio buttons. 

Each button is organized in a different group within the dialog box, allowing you to 
choose both of them at the same time. As you click each of these buttons, hold 
down the mouse button and read the information in the Help box. This information 
will help you understand the function of each option. 

5. Click the "Is" button. 

The 1 s Commando dialog box disappears, and the CommandShell window 
re-appears. The following command line appears in the window: 
ls -p -c 

Notice, however that the command does not run. 

The flag options -p and -c are the result of clicking the Mark Directories and Sorted Vertically 
buttons. Figure 4-7 illustrates this concept further. 

• Figure 4-7 The ls -p -c command line 

List contents 
of folder 

Mark 
directories 

Sorted 
vertically 

Chapter 4 Using Commando 4-13 
030-07S9-A 



6. Press RETURN. 

The 1 s command runs, and you see a list something like this one: 
Useful Commands/ 
memol 

letterl setup 

• Note: If you misspell the name of command when attempting to invoke Commando, 
A/UX returns a dialog box warning you that a Commando dialog box is not available 
for the command you typed. For example, if you type "kat," instead of "cat," the 
dialog box in Figure 4-8 appears. Check the command name at the top of the 
Commando dialog box to make sure you typed the correct name. It may also be that 
a Commando dialog box doesn't exist for the command you are trying to access. 

• Figure 4-8 No Commando dialog box warning 
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Using the cmdo method to invoke Commando 

Another way to invoke Commando from a CommandShell window is the cmdo method. This 
method is an easy way to access the Commando dialog box of your choice when you are 
working in the CommandS hell environment and you want to run the command immediately. 
However, you can't use this method to build compound command lines. 

To invoke Commando in this manner, type 
cmdo command-name 

and press RETURN. Make sure that you type a space between cmdo and the name of the 
command you wish to access. 

Commando automatically searches the system for the appropriate Commando dialog box and 
places it on the screen. Once you select the various options you wish to add to the command, 
click the command name button (See Figure 4-4) in the lower-right corner of the Commando 
dialog box to run the command. 

D Important This method of invoking Commando will not work in 24 bit 
addressing mode. If you are working in 24-bit addressing mode, use 
the next method of invoking Commando. 6 

Using COMMAND-K to build compound command lines 

A compound command line is the linking of two or more processes into one for 
simultaneous execution. This method of linking commands is known as piping. To pipe two 
or more processes together, you type the pipe character on the command line. The pipe 
character is a vertical bar (I). 

For example, suppose you want to list all the files in the start and Guest folders and 
determine the total number of files in both folders. 
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The following tutorial shows how to use a compound command line for this purpose. 

1. From the start account, choose CommandShell from the Apple menu. 

A CommandShell window appears. 

2. Type 1 s at the shell prompt, but do not press RETURN. 

3. Choose Commando from the Edit menu or press COMMAND-K. 

The 1 s Commando dialog box appears. 

4. Click the "List all rues" check box. 

This flag option lists all of the files in the directories, including those beginning with 
a period (.), known as dot files. 

5. Click the "Choose directories/ftles" button. 

The dialog box shown in Figure 4-9 appears. 

• Figure 4-9 The Choose Directories/Files dialog box 
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6. Click the Add Current Directory button at the top of the dialog box. 

Since you logged in to the start account, the s tart directory is the 
current directory. 

7. Select the Guest directory and click Add. 

You may not see the Guest directory immediately. You may first have to open the 
users directory to select the Guest directory. To do this: 

o Click the Drive button until the / partition is showing. 

o Double-click the users directory. 

o Click once on the Gue s t directory and click Add. 

8. Click Done. 

You return to the 1 s Commando dialog box. 

9. Click the "Is" button, but do not press RETURN. 

The 1 s Commando dialog box disappears, and the CommandShell window 
re-appears. The following command line appears in the window: 
is -a /users/start /users/Guest 

Notice, however that the 1 s command does not run. 

10. Press the Space bar and type the pipe ( I) character. 

The command line now looks like this: 
is -a /users/start /users/Guest 

11. Press the Space bar and type we, but do not press RETURN. 

The we command counts the number of lines or words in a file or folder. 

12. Choose Commando from the Edit menu or press COMMAND-K. 

The Commando dialog box illustrated in Figure 4-10 appears. 
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• Figure 4-10 The we Commando dialog box 
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13. Click the "Lines only" radio button. 

This flag option counts the lines in each directory. In this example, each line is a 
separate file. 

14. Click the "wc" button. 

The we Commando dialog box disappears, and the CommandShell window 
re-appears. The following command line appears in the window: 
Is -a /users/start /users/Guest I we -1 

Notice, however, that the 1 s and we commands do not run. Figure 4-11 illustrates the 
compound command line you have just created. 
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• Figure 4-11 A compound command line 
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15. Press RETIJRN. 
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The command line runs. The number of files in the two directories is displayed. 
25 

The resulting number may be different if files have been added to or deleted from 
the start or Guest directories. 

Using Commando, you have learned how to use commands to perform specific functions. 
A/UX puts over 500 different commands at your disposal. To learn more about A/UX 
commands, see AlUX'" Command Reference, or check the appropriate on-line manual page. 
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Chapter 5 Using CommandShell 

This chapter describes how to use CommandShell to interact with A/UX. 
CommandShell displays one or more windows that provide access to the 
A/UX operating system's traditional UNIX-style command-line interface. 
However, you can still use the mouse and menu commands to operate 
CommandShell windows, as you do in a Macintosh application. You can 
open several windows, move them, size them, and so on. 

This chapter contains the following sections: 

• What is CommandShell? 

• Making CommandS hell active 

• Using the CommandShell windows 

• Using the A/UX System Console 

• Customizing CommandShell windows 

• How the system warns you of an alert 

• Using Macintosh editing tools in a CommandShell window 

• Leaving CommandShell 

Start by reading the first two sections of this chapter, ("What is 
CommandShell?" and "Making CommandShell Active"). You may 
then consult the remaining sections that describe the tasks you 
want to perform. 
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What is CommandS hell? 

When you start A/UX, you are ready to use the Finder (described in Chapter 2, "Getting 
Around in A/UX"). However, it may sometimes be useful for you to communicate with 
A/UX directly by entering A/UX commands on a command line, as is traditionally done on 
most UNIX systems. CommandShell allows you to display one or more windows in which you 
can enter A/UX commands directly. You can communicate with A/UX through anyone of 
three standard shells: 

• C shell 

• Boumeshell 

• Kom shell 

A shell is an interface between you and A/UX. It accepts the commands that you enter 
and passes them on to A/UX. Each shell interprets your commands to A/UX in its own 
way. Since the C shell is the one most commonly used in UNIX systems, that is the default 
shell available to you when you log in (unless your system administrator has changed the 
default shell). 

You can change to the Bourne or the Korn shell by using the chsh command. For further 
information on this command, see chsh(1) in AlUX Command Reference. You can change 
shells temporarily, while you are logged in, as follows: 

• To change to the Kom shell, display a CommandS hell window and 
enter ksh. 

• To change to the Bourne shell, display a CommandShell window and 
enter she 

• To change to the C shell shell, display a CommandShell window and 
enter csh. 

The three shells are described in detail in AlUX User Interface. 
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Making CommandS hell active 

Before you read this section, you should have started A/UX and logged in to your user 
account. CommandShell runs whenever you are logged into A/UX. However, when you 
log in, the A/UX Finder is active, and its menu bar appears at the top of the screen. The 
CommandShell window is invisible. 

To make CommandS hell active: 

• Choose CommandShell from the Apple menu. 

A window labeled CommandS hell 1 appears and becomes the active window (Figure 5-1). 
Instead of choosing the CommandShell command, you can simply click the MultiFinder 
icon at the upper-right corner of the menu bar. Every time you click this icon, another one 
of the applications that are running is brought to the foreground of the screen, and its front 
window is made active. 

• Figure 5-1 A CommandShell window 

o CommandShell 1 
localhost.start 1 ~ • 
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When the CommandShell window becomes active, the CommandShell menu bar appears. It 
contains commands that allow you to manage and manipulate the CommandShell windows and 
their contents. 

Using the CommandShell windows 

The following sections explain how to work with CommandShell using the menu commands. 
You can read through these sections sequentially or you can find the task you want to 
complete and go directly to the section that applies to it. 

Displaying CommandShell windows 

When you make CommandShell active, a CommandShell window appears. There are two ways 
to display more windows: 

• Choose New from the File menu. 

• Press COMMAND-N. 

A new window appears in front of the existing window or windows. The windows are 
numbered in the order in which they are created (CommandShelll, CommandShell 2, 
and so on). 

• Note: Normally you can open up to 15 windows. However, it is best to use a 
large-screen monitor when you work with many windows at the same time. 

5-4 A/UX Essentials 
030-07S9-A 



Arranging CommandS hell windows 

There are three ways to arrange CommandShell windows on the screen. 

• Standard position: When you create a new window, it appears in front (and slightly 
below and to the right) of the previously created window, obscuring the windows 
behind it (Figure 5-2). 

• Tiled: You can tile the windows to arrange them alongside each other with their edges 
touching, like tiles on a floor. For information on the different tiling patterns, see the next 
section, "Tiling Windows." 

• Resizing and dragging: You can arrange CommandShell windows on your desktop by 
using their resize boxes to resize the windows and by clicking on their title bars to drag the 
windows to new locations on the desktop. 

Tiling windows reduces the size of the windows so that they fit on the screen. 

• Figure 5-2 Windows in standard position 

CommandS hell 1 I 
r-- CommandShell 2 1 lOr--

Ie CommandShell :3 
Ie D CommandShell 4 0 

localhost.start 1 ~ • it 

- -- i -
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• Warning 

Tiling windows 

Unlike a standard Macintosh window, if a CommandShell window is 
so reduced in size (because of tiling or resizing) that its contents 
become unreadable, CommandShell erases the obscured screen 
output. You cannot retrieve it by enlarging the window. • 

Tiling positions the windows alongside one another from right to left. Successive rows are 
placed from top to bottom in the order in which they were created. More than one window 
must be displayed before you can use the Tile command. Tiling resizes the windows so that 
they are all visible on the screen. 

There are two ways to tile windows: 

• Choose Tile from the Window menu. 

• Press COMMAND-T. 

Figure 5-3 shows the results of using the Tile command with four CommandShell 
windows displayed. 
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• Figure 5-3 Tiled windows 

CommandS hell 1 CommandSheli 2 
localhost.start 1 ~ D ~ local host. start 1 ~ D Q 

l2 ~ 
CommandSheli 3 §D CommandShell 4 t!l~ 

localhost.start 1 ~ D IQ localhost.start 1 ~ I ~ 

~ ~ 
£2] 

Tiling windows horizontally 

Use the Tile Horizontal command in the Window menu to position the windows from top to 
bottom on the screen in the order in which they were created. CommandShell stretches the 
windows to fit the width of the screen and adjusts the height of the windows to 
accommodate the number of windows. 

• Choose Tile Horizontal from the Window menu. 

Figure 5-4 shows the results of using the Tile Horizontal command with four 
windows displayed. 
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• Figure 5-4 Horizontally tiled windows 

CommandShell 1 
localhost.start 1 ~ D ~ 

~ 
CommandShell 2 

localhost.start 1 ~ D tQ: 

~ 

CommandS hell 3 
localhost.start 1 ~ D Q 

Q 

0 CommandShell 4 t!l 
localhost.start 1 ~ I Q 

~ 
121 

Tiling windows vertically 

Use the Tile Vertical command in the Window menu to position windows from left to right 
on the screen in the order in which they were created. CommandShell stretches the windows 
to fit the height of the screen and adjusts the width of the windows to accommodate the 
number of windows. 

• Choose Tile Vertical from the Window menu. 

Figure 5-5 shows the results of using the Tile Vertical command with four 
windows displayed. 
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• Figure 5-5 Vertically tiled windows 

CommandSh CommandSh CommandSh ~DE CommandSh ~t!l~ 
#0 ~ #0 1£ #0 ~ #0 it 

~ Q ~ [Q 

Untiling windows 

Use the Standard Positions command in the Window menu to reposition the windows in the 
original stacked order, from front to back and from top to bottom. 

• Choose Standard Positions from the Window menu. 
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Recording the contents of a window 

As new lines are added to a CommandShell window, the top lines may scroll past the top edge 
of the window, as is shown in Figure 5-6. CommandShell automatically records a preset number 
of these lines. This allows you to review them by scrolling upward. 

• Figure 5-6 Saving window contents as they scroll off the top 

By default, CommandS hell records one thousand lines. For information on how to change this 
default, see "Customizing CommandShell Windows," later in this chapter. 

Figure 5-7 shows how the window looks after you use the scroll bar to redisplay the 
saved lines. 
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• Figure 5-7 Recorded window contents 

o R!UH System Console 0 
mc58020 caching enabled i£ 
~~~:~P~:m~~~Cs~~~~ ~~~~~~4V~~t~~4 mill 
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J.l..Q .... 8.(:;:.(:;:.~J.~.r..gJ.J..9.n.: ........ \.:'.~.r..?.J..9D ... .9.;?.L ....... I)).9.~.p..g.:7.7.A ...... !)).g.~.w.p..:7.!.'........................................................................................... l!l!!! 
Scrol I up in this window to see old console messages. !m!! 

• I 

• Note: CommandS hell does not save any lines for use after you close the window. If 
you are working with text that you don't want to lose, save the contents to a file. If 
you have been working with a text editor, use its save commands to save the text to 
a file. To save A/UX command lines to a file, see "Saving a Selection in a New File," 
later in this chapter, or use the script command. For further information, see 
script(1) in A/UX" Command Reference. 

Canceling the recording of window contents 

You can stop CommandShell from recording the top lines of the active window as follows: 
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• Choose Don't Record Lines Off Top from the Commands menu. 

This command causes CommandShell to stop recording lines as they scroll past the top 
of the active window. Any lines already recorded are saved and are available for review. 
The command name in the Commands window changes to Record Lines Off Top. Choose 
this to begin recording the lines again in this same window. 

Viewing recorded contents 

There are several ways to view the recorded contents of a window. 

• Click or press the scroll arrow that points up. 

The lines that scrolled off the top of the window come into view, one line at a time. 
Release the mouse button to stop scrolling. 

• Drag the scroll box higher in the scroll bar. 

The window adjusts to display the area you identified. For example, if the lines you 
want to see are in the middle of the recorded lines, drag the scroll box to the middle 
of the scroll bar. 

• Click the gray area of the scroll bar. 

The scrolled contents are displayed one windowful at a time. Click above the scroll 
box if you want to scroll up; click below the scroll box if you want to 
scroll down. 

For more information on using the scroll bar and on scrolling behavior, see the owner's guide 
that came with your computer. 

Erasing recorded window contents 

To erase recorded lines, do the following: 

• Choose Clear Lines Off Top from the Commands menu. 

The recorded lines are erased and are no longer available for review. The scroll bar becomes 
white. This command operates on the active window only. 
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Viewing windows 

The following sections describe the different ways of hiding and showing windows and of 
moving them to and from the foreground of the screen. 

Hiding a window 

Note the names of the windows listed in the lower section of the Window menu in Figure 5-8. 
The outlined type means that the windows are visible on the screen. 

• Figure 5-8 The Window menu Call windows displayed) 

Tile 
Tile Horizontal 
Tile Uertical 
Standard Positions 
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Full Height 
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A!UH System Console fJ€O 
(CmliilliileD[j)c!J~[})(;1~~ U fJ€ 1 
(CmliilliileD[j)c!J~[})(;1~~ ~ fJ€ 2 
(CmliilliileD[j)c!J~[})(;1~~ ~ fJ€ 3 
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There are two ways to make the active window disappear from view temporarily: 

• Choose Hide from the Window menu (illustrated in Figure 5-8). 

• Press COMMAND-H. 

Now look at the window menu again. Although the window labeled CommandShell 4 is no 
longer visible on the screen, it is still listed in the Window menu. The window name now 
appears in plain text in the Window menu (Figure 5-9), indicating that it is hidden. 

• Figure 5-9 The Window menu (window 4 hidden) 
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Showing a hidden window 

To show a window that has been hidden, do the following: 

• Choose the hidden window's name from the Window menu. 

The window reappears in front of the other windows on the desktop. The window 
name now appears in outlined type in the Window menu. 
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Showing all hidden windows 

To show all windows that have been hidden, do the following: 

• Choose Show All Windows from the Window menu. 

The windows reappear in front of any other windows on the desktop. The window 
names are outlined in the Window menu. 

Alternating two windows to and from the foreground 

There are two ways to move two windows alternately to the foreground of the screen: 

• Choose Last Window from the Window menu. 

• Press COMMAND-L. 

The previously visible window moves in front of the currently visible window. Repeating this 
command reverses them again. 

Moving a specific window to the front 

There are three ways to move a specific window in front of any other windows: 

• Choose the window name from the Window menu. 

• Click a visible part of the window. 

• Press COMMAND-windownumber (limited to numbers 1 through 9). 

The specified window moves in front of any other windows on the desktop. 

Moving the rearmost window to the front 

There are two ways to move the rearmost window in front of all the other windows: 

• Choose Rotate Windows from the Window menu. 

• Press COMMAND-R. 

The rearmost window moves to the front. 
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Closing CommandShell windows 

Before you can close an individual window, it must be the active window. 

Closing a window 

There are three ways to close an active window: 

• Choose Close from the File menu. 

• Press COMMAND-W. 

• Click the close box of the window. 

The CommandS hell window disappears from the screen. 

• Note: CommandShell does not save any lines for use after you close the window. If 
you are working with text that you don't want to lose, save the contents to a file. If 
you have been working with a text editor, use its save commands to save the text to 
a file. To save A/UX command lines to a file, see "Saving a Selection in a New File," 
later in this chapter, or use the script command. For further information, see 
scriptel) in AlUX Command Reference. 

If you close a window in which a process or a program is running, the process is halted. An alert 
box warns you of this and gives you the option of keeping the window open. 

Closing all open windows 

To close all the open windows at once: 

• Choose Close All Windows from the File menu. 

The CommandShell windows disappear from the screen. 

If you close a window in which a process or a program is running, the process is halted. An alert 
box warns you of this. 
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Using the A/UX System Console 

When you are working in A/UX, the system may generate messages regarding its status. In a 
traditional UNIX environment, these messages are sent to the console window, which displays 
them. Typically the system administrator monitors this terminal for messages and maintains 
the system according to the information. In A/UX 2.0, the system messages are shown in the 
A/UX System Console, a CommandShell window that you display by choosing its name from 
the Window menu. 

Looking at the A/ux System Console window 

To look at the contents of the A/UX System Console window, follow these steps: 

1. If you haven't already done so, choose CommandShell from the 
Apple menu. 

This action displays an active CommandShell window and makes the CommandShell 
menu commands available. 

2. Choose A/UX System Console from the Windows menu, or press COMMAND-O 
(that is, the number "zero," not the letter "Oh"). 

This action displays the A/UX System Console window. For more information on the 
messages that you might see in the window or for information on how to respond to 
a request for information, see AlLX Local System Administration. 

Clearing the A/UX System Console window 

To clear the messages from the A/UX System Console window, follow this step: 

• Choose Clear Lines Off Top from the Commands menu. 

This action clears all the information from the window. You should clear this window 
periodically so that you can tell when new messages appear. 
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Closing the System Console window 

Close the System Console window just as you do any CommandS hell window (see "Closing 
CommandShell Windows" earlier in this chapter). Note that unlike other CommandShell 
windows, when you close the System Console window, nothing in the window is lost. Closing 
the System Console window is equivalent to hiding it. 

Customizing CommandShell windows 

If you use CommandS hell windows often, you may find it convenient to establish an ideal 
arrangement of windows, so that as soon as you log in to A/UX, the windows are set up exactly 
the way you want. 

Saving the layout of your CommandShell windows 

The Save Preferences command (in the File menu) allows you to save the 
following specifications: 

• notification level preferences (see "How the System Warns You of an Alert," later 
in this chapter) 

• the positions and sizes (in rows and columns) of all CommandShell windows 

• the windows' stacking order 

• the titles of the windows 

• the fonts and point sizes of text in the windows 

• whether a given window is visible or hidden 
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• whether a given window is zoomed or not, and the sizes (in pixels) of its zoomed and 
unzoomed states 

• whether lines are to be saved off the top of the screen, and the number of lines to be saved 
(see "Recording the Contents of a Window," earlier in this chapter; see also "Presetting 
Window Defaults," later in this chapter) 

• the initial command to be run in the window (see "Presetting Window Defaults," later in 
this chapter) 

To save these settings, follow these steps: 

1. Arrange the windows just as you want them to be. 

Be sure that you have chosen any special formatting features that you want 
(such as fonts). 

2. Choose Save Preferences in the File menu. 

Restoring the window layout to the saved preference 

If you have saved your window preferences but have changed the window layout on your 
screen, you can instantly restore your preferred layout as follows: 

• Choose Restore From Preferences in the File menu. 

Presetting window defaults 

The Active Window Settings command in the Preferences menu allows you to 
do the following: 

• save an initial command to execute upon login 

• change the title of the window 

• change the number of lines to save 
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Follow these steps: 

• Choose Active Window Settings in the Preferences menu. 

The dialog box shown in Figure 5-10 appears. 

• Figure 5-10 The Active Window Settings dialog box 

RctiLle Window Settings 

Window title: 

Window position: 

Top: EJ 
left: 1483 I 

[8J Record lines off top 

Window size: 

ROWS:~ 

Columns: ~ 

MaHimum number of lines: ~ 

I nitial command: 

(cancel] ~ 

The name of the active window is highlighted in the top line. 

You can change any or all of the settings in this dialog box. After you click OK, the saved 
settings become the new defaults for displayed windows. 

Notice that the check box "Record lines off top" is selected by default. If you click it, 
the X mark disappears and recording of lines is turned off. You can also change the maximum 
number of lines recorded, but only if "Record lines off top" is selected. 

In the "Initial command" text box, you can enter a command to be run as soon as 
you log in. 
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Presetting the appearance of new windows 

You can change the default settings that control the appearance of new windows before you 
create them. Follow these steps: 

• Choose New Window Settings from the Preferences menu. 

The dialog box shown in Figure 5-11 appears. 

• Figure 5-11 The New Window Settings dialog box 

New Window Settings 

Window Title PrefiH: ~~~~~II •••• 11 
Use Rctiue Window Settings 

Window Cascade Origin: 

TOP:~ 
Left: ~ 

Font: I Monaco I Size: W 

Window Size: 

ROWS:~ 
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(cancel) ~ 

You can decide to extend the active window settings to all new windows. To do so, click 
Use Active Window Settings. 

If you wish to label new windows with a prefix other than "CommandShell," type the prefix in 
the Window Title Prefix text box. 

This dialog box also allows you to preset the window size, the screen font to be used in the 
window, and the maximum number of lines to be saved. 
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To preset a default position for the upper left corner of the first window of a group 
of stacked windows, enter the coordinates (in pixels) in the Window Cascade Origin 
text box. 

How the system warns you of an alert 

If the system needs to bring an alert to your attention (for example, if the system 
administrator is preparing to shut down the system), an icon flashes in the menu bar 
and an alert box appears. If CommandShell is not the active application, a diamond-shaped 
symbol also appears alongside CommandShell in the Apple menu. Choose this to activate 
CommandShell; then choose A/UX System Console from the Windows menu to display 
the alert message. 

You can change this default to suppress the alert box, the flashing menu-bar icon, or both. 
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To change this default, do the following: 

1. Choose Notification Levels in the Preferences menu. 

The dialog box shown in Figure 5-12 appears. 

• Figure 5-12 The Notification Levels dialog box 

Set the notification leuel to be used when 
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( Cancel ) K OK I 

2. When you have clicked the appropriate buttons, click OK. 

Using Macintosh editing tools in a CommandS hell window 

You can use some of the standard Macintosh editing procedures while working in 
CommandS hell windows. This allows you to paste a series of commands or a long, complex 
command into another window without having to retype it. When you press RETURN, A/UX 
runs the copied command. 
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The sections that follow describe how to edit a window's contents using the mouse and the 
menu commands. This material applies to command lines and system messages only. If you are 
using a text-editing application, use the application's editing tools. 

Selecting text 

You must select text before you perform the editing procedures. Select text as follows: 

• Drag across text to select a single letter, word, or section of text. 

Text is highlighted when it is selected, as shown in Figure 5-13. 

• Figure 5-13 Selected text 

I 
: setup 

"setup" 5 lines, 94 characters 
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Copying text 

To copy text, follow these steps: 

1. Select the text you want to copy. 

2. Choose Copy from the Edit menu or press COMMAND-C. 

The highlighted text is copied to the Clipboard. You can paste the Clipboard contents as 
many times as you want. For more information about the Clipboard and its contents, see the 
owner's guide that came with your computer. 

Pasting text 

Once you have copied text to the Clipboard, you can paste the text in a 
CommandS hell window. 

To paste text, do this: 

1. Place the insertion point where you want the pasted material to appear. 

2. Choose Paste from the Edit menu or press COMMAND-V. 

The text is pasted, beginning at the cursor location. You can paste the Clipboard contents 
as many times as you want, until you replace them by copying something else. For more 
information about the Clipboard and its contents, see the owner's guide that came with 
your computer. 
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Changing the font or font size 

You can change the appearance of all the text in a window by changing the font or font size. 
The choices available in the Font menu are the monospaced fonts in the System file. 

• Choose the font or font size from the Font menu. 

All text in the window changes to the new font or font size. 

Saving a selection in a new ftle 

You can save the contents of a CommandShell window in a file in AlUX. Follow these steps to 
create a new file and then write the selection to disk in the new file. When the text is present in 
a CommandShell window, follow these steps: 

1. Select the text you want to copy into a new rue. 

The text appears highlighted. 

2. Choose Save Selection from the File menu. 

The Save Selection dialog box shown in Figure 5-14 appears. 

• Figure 5-14 The Save Selection dialog box 
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3. Type a name for the new ftle. 

4. Click Save. 

Printing the contents of a CommandShell window 

You can print all or part of the contents of a CommandShell window as follows: 

1. Select the portion of the window that you wish to print. 

You can select the entire contents of the window by choosing Select All in the 
Edit menu. 

2. Choose Print Selection in the File menu. 

The Print dialog box shown in Figure 5-15 appears. 

• Figure 5-15 Print dialog box 

LaserWriter "LaserWriter" 5.2 n OK J 
cOPies:I'-1 Pages: @ nil 0 From: D To: D (Cancel) 

COller Page: @ No 0 First Page 0 Last Page Help 
Paper Source: @ Paper Cassette 0 Manual Feed 

3. Click OK to print. 

Leaving CommandShell 

Make sure that you have saved any work that you complete in CommandShell windows before 
you return to the A/UX Finder. There are two ways to leave CommandShell: 
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• Choose another application from the Apple menu. 

This action moves the CommandS hell window to the background of the screen. The 
Finder is now active. 

• Choose Hide CommandShell Windows from the Apple menu. 

This action closes all the windows and sets aside the utility until you reactivate it. 
This method reduces screen clutter while you work on other applications. 

There is no Quit command in the CommandShell's File menu, because CommandShell is an 
application that must always be running. It is needed to handle console messages that the 
system displays for your information. 

When you log out or shut down the system, if you have changed your window preferences with 
the Save Preferences command in the File menu, you are asked whether or not you want to 
save the changed preferences. 

The dialog box shown in Figure 5-16 appears. 

• Figure 5-16 The Save Changed Preferences dialog box 

Do you want to saue your 
changed preferences? 

I( Yes )) No 

Click Yes to save the changed preferences or No to abandon them. 
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Chapter 6 Writing With TextEditor 

This chapter describes how to use the TextEditor application to create 
and to edit text files. It presents tutorials with step-by-step instructions 
that show you how to accomplish simple writing and editing tasks. 

This chapter contains the following sections: 

• What is TextEditor? 

• Creating a new document 

• Saving a new document 

• Editing an existing document 

• Formatting and other features 

• Printing 

• Quitting TextEditor 

You may read through this chapter in sequence or go directly to the 
section that interests you. If you are not accustomed to Macintosh 
editing tools, work through the tutorials. 
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What is TextEditor? 

TextEditor allows you to create and edit text files using the mouse and menu commands in the 
traditional Macintosh manner. It creates a file that contains only the text characters that you 
type on your keyboard (including tab and return characters). This is called a text-only fue (or 
an ASCII text fue). When you create a document with word-processing or desktop-publishing 
software, unless you save the file as "text only," the file contains many formatting commands. 
Although these formatting commands are invisible on your screen, they confuse other 
programs that try to use your file. A text-only file can be read by any text editor or word 
processor. Moreover, you can use it to write programs or shell scripts, which should never 
contain hidden formatting characters. 

To preserve the text-only nature of TextEditor's text files and still allow you certain formatting 
choices, TextEditor gives you the option of saving the file's formatting information, but it 
saves this information in a separate file called a resource fork and saves the text characters in 
a text-only file. These formatting choices include adjusting the tab settings and choosing 
fonts, among others. These features are described later in this chapter. 

Since TextEditor reads and writes text-only files, you can use it to work with files created with 
any other text-only text editor. Thus, you can edit MacWrite® files saved with the Text-Only 
option. When you select the Open command, TextEditor's standard file dialog box displays a 
list of all text files in the folder (or the "current directory," in UNIX parlance), regardless of 
what program was used to create the file. 

The resource fork has the same filename as the text file, but it is preceded by a 
percent sign (%). 

Like most UNIX systems, A/UX 2.0 also comes with a commonly used UNIX text editor called 
vi (Visual Editor). If you are an experienced vi user, you can continue to use vi to read and 
write text files from the CommandShell command line. For information on CommandShell, see 
Chapter 5, "Using CommandShell." Naturally, TextEditor can read and edit text files created 
with vi, and vice versa. 

The fact that TextEditor is designed for the Macintosh interface makes it quick and easy to 
learn and to use. When you finish going through the tutorials in this chapter, you should have 
no trouble creating and editing text with TextEditor. 
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The default text editor 

As shipped, A/UX 2.0 uses TextEditor as its default text editor. This means that whenever you 
double-click the icon of a text-only file, TextEditor begins operating, and the text appears in 
a TextEditor window. 

To set a different editor as the default editor, you need to know where in the file system the 
editor you want is located, that is, you need to know its pathname. For information on 
pathnames, see "Pathnames in the A/UX File System," in Chapter 2, "Getting Around 
inA/UX." 

You can change the default text editor by changing an environment variable in the .login 

file in your home directory folder (assuming that you are working in the C shell). Notice that 
the name of this file begins with a period (.). It is therefore called a dot ftle. 

• Note: In A/UX, as in other versions of UNIX, dot files are used to give special 
directions to the system. Whenever you type a dot file's name in a CommandShell 
window, remember to begin the filename with a period. However, in the 
A/UX Finder, the labels of the dot files' icons are preceded by a bullet (.) instead 
of a period. 

If you are working in the C shell, whenever you log in to your account, the system reads your 
. log i n file to create your working environment (or the . pro f i 1 e file if you are working in 
the Korn shell or the Bourne shell). 

To change your default text editor in the. login file, follow these steps: 

1. The A/UX Finder should be displayed on your screen. Be sure that your 
home directory folder is open. Double-click the . login ftle icon to open 
the ftle. 

2. At the end of the ftle, add a new line as follows: 
setenv FINDER_EDITOR editorpathname 

Replace the word in italics with the full pathname of the editor you wish to set as the 
default editor. For example, if another user has changed the default editor, you can 
change it back to TextEditor by typing TextEditor's pathname as the last item on 
the line, as follows: 
setenv FINDER EDITOR /mac/bin/TextEditor 
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Note that there is a space before the editor's pathname (jmac/bin/TextEdi tor, 

in the case of TextEditor). 

3. Save the changed . login ftle. 

4. Log out and log in again, so that the system rereads the . login ftle. 

Creating a new document 

The following section teaches you how to turn TextEditor on and create a document. During 
the course of these tutorials, please be sure that you have logged in as start and are working in 
the start folder. 

Starting TextEditor 

You may start TextEditor from the A/UX Finder by double-clicking the TextEditor icon or by 
double-clicking a text-file icon (provided that TextEditor is the default editor). You may also 
start TextEditor from a CommandS hell window. 

If you are working in a CommandShell window, you can start TextEditor simply by entering the 
command TextEdi tor. An untitled TextEditor window appears. 

The following tutorials teach you how to work with TextEditor after starting it from the 
Finder. However, once you have used the tutorials and are familiar with TextEditor, you will 
have no difficulty in using it no matter how you start it. 

Starting TextEditor from the A/UX Finder 

This tutorial teaches you how to start TextEditor from the A/UX Finder by double-clicking the 
TextEditor icon. 

To find the TextEditor icon, you need to open the /mac/bin folder (for a description of 
pathnames such as /mac/bin, see "Pathnames in the A/UX File System," in Chapter 2, 
"Getting Around in A/UX"). Follow these steps: 
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1. Double-click the icon for the root folder (see Figure 6-1). 

• Figure 6-1 The root folder icon 

I· 
I 

The root folder opens, displaying the mac folder icon (see Figure 6-2). 

• Figure 6-2 The root folder with the mac folder icon selected 

12, 147K available 

• ram 

usr 

2. Double-click the mac folder icon. 

The mac folder opens, displaying the bin folder icon (see Figure 6-3). 
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• Figure 6-3 The mac folder with the bin folder icon selected 

I 
.'1Z 28 ito?ms 39,248K in disk 12, 142K avai1.ablo? 

g~D~u~~u~~q~a(~U~~III!I!!~!I!I!I!I~I~0 
.'1Z 4 ito?ms 39,248K in disk 12, 142K avai1.ablo? 

sys • 1m 

o 

I 
src 

() 

3. Double-click the bin folder icon. 

The bin folder opens, displaying the TextEditor icon (see Figure 6-4). 
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• Figure 6-4 The TextEditor icon in the bin folder 
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.'Ji.- 27 it€'ms 38,962K in disk 1 2,428K av ailab I€' 

I mac 
I .. ;:::: .... 

US.'Ji.- 4 it€'ms 38,962K in disk 12,428K availabl€' 

!!Illll!!!!!!!! 
st"c sys bin 

D bin 

- .'Ji.- 16 it€'ms 38,962K in disk 12,428K availabl€' 

-
~ 

1------1 T €'xtEditot" 
o ~ 

Login 

I 
() 

CommandShe CommandSh€' 1124 Commando 
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mac24 
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4. Select the TextEditor icon and drag it to the desktop. 

Figure 6-5 shows the TextEditor icon on the desktop. You can now use it without 
having to open folders. 
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• Figure 6-5 The TextEditor icon on the desktop 

bin 
.'ft 1 5 itE'ms 37,951 K in disk 1 O,595K av ailab 1E' 

IIIII!I!II:!III rnJ Q 0 • IIIIJ 
CommandShE'l1 Login CommandShE'1124 Commando 

~ rnJ rnJ 
SE'~fi1E' dE'fE'Z fcnv~ cmdo changE'sizE' 

rnJ 
launch ~ 

TE'x~Edi~of 

Now that you have found the TextEditor icon and moved it to the desktop, use it to create a 
new document as follows: 

• Double-click the TextEditor icon. 

An TextEditor window named "Untitled" appears. You can now begin to create your 
text file. 

Entering text 

Begin by creating an office memo. 

1. Type the following: 
Dear Phil: 

Your screen should look like the one in Figure 6-6. 
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• Figure 6-6 Starting to enter text 

D ! use rs! s ta rtf Untitled 
Dear Phi I : 

2. Press the RETURN key twice and continue typing: 
I received your letter about the purchase of land for a new 
office building. 

You have probably typed past the edge of the screen. Unlike many word processors, 
TextEditor does not automatically move to the next line when you type past the 
right edge of the screen. This is a feature that programmers find useful. 

You need to move the cursor to the beginning of a word that is near the right edge of 
the screen; then press RETURN. 

3. Move the I-beam to where you want the line break to be; then click. 

This places the insertion point on the line. You can also move the insertion point to 
the left by pressing and holding the LEFT-ARROW key. 

4. Press RETURN to move the rest of the sentence to the next line. 

5. Move the insertion point to the end of the text and press RETURN twice to 
start a new paragraph. 
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6. Continue typing (remember to press RETURN to go to the next line before 
you reach the edge of the screen again): 
It's true that the financial reports for the last quarter 
are not in yet, but there is a general feeling that the 
numbers look good. This might be the perfect time to submit 
your plan. 

7. Press RETURN twice to create a new paragraph, then type: 
I don't want to rush you, but perhaps you should get ready 
to take advantage of a real opportunity. 

Cutting and pasting text 

The sentence that you typed in step 7 might look better right before the material you typed in 
step 6. The two paragraphs would then read as follows: 

I don't want to rush you, but perhaps you should get ready 
to take advantage of a real opportunity. 

It's true that the financial reports for the last quarter 
are not in yet, but there is a general feeling that the 
numbers look good. This might be the perfect time to submit 
your plan. 

1. Place the I-beam just before the ftrst letter of the sentence beginning: "I 
don't want .... " 

2. Hold down the mouse button and move the mouse so that the I-beam 
moves past the period after the phrase "real opportunity." 

3. Release the mouse button. 

The text is now selected, as in Figure 6-7. 

6-10 A/UX Essentials 
030-0759-A 



• Figure 6-7 The selected block of text 

Dear Phi I : 

I received your letter about the purchase of land for a new 
office bui Iding. 

It's true that the financial reports for the 
last quarter are not it yet, but there is a general feel ing 
that the numbers look good. This might be the perfect time 

Ian 

You can perform various operations with a block of selected text. In this case, you 
are going to cut and paste the text. 

4. Choose Cut in the Edit menu. 

The selected text disappears. The passage you have cut is saved on the Clipboard. If 
you choose the Show Clipboard command in the Edit menu, you see a window 
showing the selected text saved in the Clipboard. For now, continue with step 5. 

5. Move the I-beam to the end of the ftrst paragraph and click RETURN twice to 
create a new paragraph. 

This places the insertion point where you are going to paste the text that you 
just cut. 

6. Choose Paste from the Edit menu. 

The selected text appears in its new location, as in Figure 6-8. 

Chapter 6 Writing With TextEditor 6-11 
030-07S9-A 



• Figure 6-8 The text pasted in place 

D ! use rs! s tart! U n tit led 
Dear Phi I: 

I received your letter about the purchase of land for a new 
off i ce bu i I ding. 

I don't want to rush you, but perhaps you should get ready 
to take advantage of a real opportunity. 

It's true that the financial reports for the 
last quarter are not it yet, but there is a general feel ing 
that the numbers look good. This might be the perfect time 
to submit your plan. 

The selected text remains on the Clipboard until you replace it with another block of 
selected text. If you wanted to, you could paste copies of it in any number of other 
places in the document. 

To save this memo to a file, see the next section, "Saving a New Document." 

Saving a new document 

Since this document is new, you must save it and give it a filename, Follow 
these directions: 
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1. Display the File menu. 

These four commands allow you to save a file: 

D Save 

D Save As 

D Save a Copy 

D Revert to Saved 

2. Choose Save As. 

The Save As dialog box, shown in Figure 6-9, asks you to select a name 
for the file. 

• Figure 6-9 The Save As dialog box 

Ie start I 

L,) $~ sb'~ 

f.'.') $L1!~mp!sn<H kOp 
L,) $~'%-hn: 

f.'.') $kgin 
L,) $kWHI~ 

SalJe document as 

Imemo2 

@ SalJe TeHt Only 

o SalJe Format Info 

~! 

DrilJe 

SalJe 

Cancel 

3. Type the name memo2 in the highlighted field, labeled 
"Save document as." 
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4. Be sure that the Save Text Only radio button is selected. 

If you had used any of the formatting options (described later in this chapter), 
you could have saved them in a separate file by selecting Save Format Info. The 
document would then be saved in two files, memo 1 and %memo 1. The second of 
these (the resource fork), would preserve the formatting information. However, 
since you haven't used the formatting options, it isn't necessary to create an 
extra file. 

5. Click Save. 

The memo is saved as a file with the filename memo 2. 

The other Save commands work as follows: 

• Save: If the file in the active window has already been given a filename, the Save command 
automatically saves it under its current name, without closing it. The original version of the 
file of that name is overwritten in the process. This menu item is dimmed (and therefore 
cannot be used) if the file hasn't been modified since it was last saved. 

• Save As: In addition to using this command to name a new file (as you have just done), 
you can use it while working on a file that already has a name. This lets you save an edited 
file under a new name, leaving the original intact. The file that you originally opened 
remains unchanged, just as it was when last saved. 

• Save a Copy: The Save a Copy command saves the file, in its current state, under a new 
filename. You can then continue editing the original file. 

• Revert to Saved: Use the Revert to Saved command to throwaway any changes you have 
made since you last saved the document. This command is dimmed if the document has 
not been modified since it was last saved. 
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Editing an existing document 

The following tutorials show how to edit or rewrite a document file that already exists. 

Opening the ftle 

Suppose you want to edit a text file that already exists. If TextEditor is running, you can open 
the file for editing by choosing Open from the File menu. This allows you to open any text-only 
file, regardless of what application was used to create the file. 

If you are in the Finder, and if TextEditor is your system's default text editor, you need 
only double-click the icon of the file to be edited (or click it once to select it and choose 
Open from the File menu). TextEditor starts running and the file you have clicked is opened 
for editing. 

If TextEditor is not still running, follow these steps: 

1. Open the start folder if it is not already open. 

2. Double-click the HIe icon labeled memol. 

The file named memo 1 is opened, and the document is displayed. You are ready to 
alter this document and to save it under a new name. 

If you have not quit TextEditor since the last tutorial, it is still running and you are working in 
the start folder. Be sure that you are logged in as start and are working in the start folder, 
which contains all the tutorial material. 

Follow these steps: 

1. Choose Open in the File menu. 

The dialog box shown in Figure 6-10 appears: 
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• Figure 6-10 The Open dialog box (filled in) 

Ie start I 
D .( lipboard rt1 
D -cshrc 
D -EHamplsBackUp 
D -kshrc 
D -login 
D -logout 
D -profile 
D letterl 
D memol 

o Open read only 

2. Double click the fue named memol. 

~I 

Driue 

Open 

Cancel 

The document appears in a window and is ready for editing. 

• Note: You can open a file to which you have read permission but not write 
permission. To do this, be sure that you have selected "Open read only" (at the 
bottom of the Open dialog box, Figure 6-10). If you open a document to which you 
do not have write permission, a lock icon appears at the bottom right of the 
window, as in Figure 6-11. You can read the document but you cannot change it. 
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• Figure 6-11 A read-only document 

D 
1'* ocshrc 
# sample of commands commonly found in ocshrc 
# The ocshrc fi Ie is run every time you invoke Csh 
# We have found the fol lowing settings to be useful 
# Feel free to moke modificotions ond odd your own 

# set the login shel I prompt 
if ($?prompt) then # interactive shel I 

# set prompt string 
switch ("$prompt") 

cose '# ': 

case '~ ': 
se t promp t=" 'hos tnome ' ° $LOGNAME \! $promp t " 

endsw 
else 

exit 
endif 

# 0 I i oses: use 0 persono I 0 I i os i n p I ace 0 f the commond i t re:o 

Write permission denied 

Deleting and rewriting text 

Notice the sentence that begins halfway through the second line of the first paragraph 
("Every salesperson who's ... "). 

1. Use your mouse to highlight the phrase "Every salesperson who's"; this is 
now the selected text. 0,,, 

If you've forgotten how to select text, place the blinking cursor just before the word 
"Every" and hold down the mouse button while moving the mouse. Drag the cursor 
just past the word "who's"; then release the mouse button. 

2. When the phrase is selected, type the following: 
The salespeople who have 

The selected text disappears as soon as you begin to type. This is the fastest way to 
replace a block of text. It saves you the trouble of first deleting text and then typing 
the new text. 
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3. Follow the same steps to select the letter "s" at the end of the word 
"knows" in the next line; then press BACKSPACE to delete the letter. 

Copying and pasting between documents 

Next, you will add the entire memo you have just edited to the bottom of a business letter. 
The letter is in the start folder, in the file named letterl. 

First you have to select the material to be copied, as follows: 

1. With the window that contains memol displayed, choose Select All in the 
Edit menu. 

This highlights the entire document. 

2. Choose Copy in the Edit menu. 

The selected text (in this case, the entire memo) is saved on the Clipboard. 

3. Choose Open in the File menu. 

This displays a list of all the files in the start folder. See Figure 6-10. 

Now prepare the document that is to receive the copied text as follows: 

1. Double-click letterl. 

2. Scroll to the end of the letter (drag down the scroll box at the right 
of the screen). 

3. Place the insertion point at the end of the signature and press RETURN twice 
to start a new paragraph; then choose Shift Left in the Edit menu to move 
the insertion point to the left margin. 

4. Type the following PS: 
ps: To give you a clear idea of our level of commitment to 
customer support, I'm appending a memo I recently sent to 
my staff. 

5. Press RETURN twice to skip two lines, then choose Paste from the 
Edit menu. 

All of the copied text appears at the insertion point. 

6-18 A/UX Essentials 
030-07S9-A 



Since other users will use these tutorials, don't save the changes. Follow these steps: 

1. Choose Revert to Saved in the File menu. 

The Revert to Saved command causes all changes to the document to be removed. 
The dialog box shown in Figure 6-12 appears. 

• Figure 6-12 The Revert to Saved dialog box 

Do you really want to discard changes to 
" luserslstart/letterl" 

n OK D Cancel 

2. Click OK. 

3. Click the close box of the window (the small square at the upper left of 
the window). 

The window that contains memo 1 is still displayed. Close it without saving the changes, 
as follows: 

1. Choose Close from the File menu. This is the same as clicking the 
close box. 

The dialog box shown in Figure 6-13 appears. 
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• Figure 6-13 The Save Changes dialog box 

Salle changes to luserslstart/letterl 

@ Salle TeHt Only 
o Salle Format Information 

n Yes J No Cancel 

2. When the dialog box asks you whether you want to save the changes, 
click No. 

This is a convenience for the next user of the start folder. Naturally, in a real-world 
work situation, you would probably click Yes to save your changes. 

Finding and changing text 

One of the most important time-saving features of a text editor is its ability to 
search through a document for a specific word, phrase, or string of characters and to 
change it automatically. 

Finding text 

To find a word, phrase, or character string, choose Find in the Find menu. Follow 
these steps: 

1. Open the start folder and double-click the memol icon to open 
the document. 

2. Choose Find in the Find menu. 

The dialog box shown in Figure 6-14 appears. 
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• Figure 6-14 The Find dialog box (filled out) 

Find what string? 

IGOOo 

o literal [8J Case Sensitiue 
@ Entire Word o Search Backwards 

o Wrap-Around Search 

t Find D Cancel 

3. Click the Entire Word button and the Case Sensitive button. 

Click the Entire Word button to tell the system to find the item only when it is an 
independent word (that is, when it is not part of another word). You would click 
Literal instead of Entire Word if you wanted to search for a string of characters even 
when they are embedded in another word. Thus, if you click Literal and search for the 
word "it," the system finds "bit," "split," "flit," and so on. 

Click the Case Sensitive button to tell the system to search only for words with the 
same uppercase and lowercase letters as the word you indicate. 

4. Type GOOD in the field labeled "Find what string?" 

5. Click Find. 

Notice that the word GOOD in line 2 is highlighted. 

The Find dialog box gives you the following options as well: 

• Search Backwards: Searches backward from the current selection to the beginning of the 
file. (Normally, the search moves forward and stops at the end of the file.) 

• Wrap-Around Search: Searches forward from the location of the cursor to the end of the 
file, then starts again at the beginning of the file and continues the search up to the starting 
cursor position. 
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D TIP 

Replacing text 

Hints on using Find: You can reverse the direction of a current 
search operation by pressing SHIFT as you select the menu item or 
pressing SHIFT as you click OK. For example, if you are in the middle 
of a file and you want to find a string that occurs earlier in the 
document, hold down the SHIFT key as you click Find. The search 
then proceeds backward through the first part of the file. The 
direction is changed for the current search only. b 

To find a word, phrase, or text string and replace it automatically with a different word, 
phrase, or text string, follow these steps: 

1. Open the start folder; then open memol. 

2. Choose Replace in the Find menu. 

The Replace dialog box appears, as in Figure 6-15: 

• Figure 6-15 The Replace dialog box (filled out) 

Find what string? 

IGOOD 

Replace with what string? 

leHcellen~ 

o Literal 
@ Entire Word 

n Replace D (Replace nil) 
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3. Click Entire Word and Case Sensitive. 

Click the Entire Word button to tell the system to find the item only when it is an 
independent word (that is, when it is not part of another word). You would click 
Literal instead of Entire Word if you wanted to search for a string of characters even 
when they are embedded in another word. Thus, if you click Literal and search for the 
word "it," the system finds "bit," "split," "flit," and so on. 

Click the Case Sensitive button to tell the system to search only for words with the 
same uppercase and lowercase letters as the word you indicate. 

4. Type GOOD in the field labeled "Find what string?" 

5. Type excellent in the field labeled "Replace with what string?" 

6. Click Find. 

Notice that the word GOOD in line 2 is highlighted. 

7. Click Replace (or press RETURN). 

The word GOOD is replaced by the word excellent, and the next occurrence of 
GOOD is highlighted after a few moments, allowing you to repeat the operation. 

If you want to skip this occurrence of the word without changing it, you could click 
Find. TextEditor would then leave the highlighted word unchanged and would search 
for its next occurrence. 

The Replace dialog box gives you these options as well: 

Replace All: Changes all occurrences of the word GOOD (or whatever string you 
indicate) automatically. 

Cancel: Removes the dialog box. No further action is taken. 

Search Backwards: Searches backward from the current selection to the beginning 
of the file. (Normally, the search moves forward and stops at the end of the file.) 

Wrap-Around Search: Searches forward from the location of the cursor to the end 
of file, then starts again at the beginning of the file and continues the search up to 
the starting cursor position. 
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Formatting and other features 

If you use any formatting features, you can save the formatting information by selecting Save 
Formatting Information in the Save As dialog box. This causes an extra file to be saved (called 
a resource fork), which contains the formatting information. 

The Edit menu and the Window menu make the following features available to you: 

• selecting fonts (for screen display and for printing) 

• selecting tab settings 

• automatically aligning text with the previous line (Auto Indent) 

• showing invisible characters, such as tabs, spaces, and returns 

• shifting a block of text left or right by one tab stop 

• aligning selected text with the top line of the selection 

• arranging multiple windows to be stacked one over the other or tiled (alongside 
one another) 

• marking a place in the file 

The sections below explain how to use these features. 
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Selecting Fonts 

To change fonts, follow these directions: 

1. Choose Format in the Edit menu. 

The Format dialog box appears (Figure 6-16), 

• Figure 6-16 The Format dialog box (changing fonts) 

Font 

Chicago 
Courier 
Geneua 
Heluetica 
Monaco 
Times 

Size 
[3] Auto Indent 
D Show Inuisibles 

Tabs: ~ 

I( OK D 
( cancel) 

2. Select the desired font and size. 

3. Click OK. 

Selecting tab settings 

To change tab settings, follow these directions: 

1. Choose Format in the Edit menu. 

The Format dialog box appears (Figure 6-17), 
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• Figure 6-17 The Format dialog box 

Font 

Chicago 
Courier 
Geneua 
Heluetica 
Mona(o 
Times 

Size 

[3J Ruto Indent 
D Show I nuisibles 

Tabs: ~ 

K OK J 
Cancel 

2. To change the tab setting, type the desired number of spaces in the 
Tabs field. 

3. Click OK. 

Automatically aligning text 

Auto Indent aligns a selected block of text or a line with the previous line. To turn Auto Indent 
on, follow these steps: 

1. Choose Format in the Edit menu. 

The Format dialog box appears (Figure 6-18). 
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• Figure 6-18 The Format dialog box 

Font 

Chicago 
Courier 
Geneua 
Heluetica 
Monaco 
Times 

Size 

[2] Ruto Indent 
o Show Inuisibles 

Tabs: ~ 

If OK D 

( Cancel 

2. Click Auto Indent so that an X shows in the check box. 

You can click it again to remove the X, thus turning Auto Indent off. 

3. Click OK. 

Showing invisible characters 

Spaces, tabs, returns, and control characters don't appear on your screen unless you click Show 
Invisibles. Follow these steps: 

1. Choose Format in the Edit menu. 

The Format dialog box appears (Figure 6-19). 

2. Click Show Invisibles so that an X shows in the check box. 

You can click it again to remove the X, thus hiding the invisible characters. 
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• Figure 6-19 The Format dialog box (show invisibles) 

Font 

Chicago 
Courier 
Genel.la 
Hell.letica 
Monaco 
Times 

3. Click OK. 

Size 

81 Auto Indent 

81 Show I nl.lisibles 

Tabs: ~ 

n OK J 
Cancel 

When you choose Show Invisibles, the invisible characters are displayed as follows: 

tab 

space 

return 

all other control characters 

-, 

Shifting a block of text left or right 

To shift an entire block of text one tab stop to the left (or the right), follow 
these directions: 

1. Select the block of text. 

2. Choose Shift Left (or Shift Right) from the Edit menu. 
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Aligning text with the top line of text 

To align a block of text with the top line of the selection, follow these directions: 

1. Select the block of text. 

2. Choose Align from the Edit menu. 

Arranging multiple windows 

If you are editing several documents at once, you have a choice of stacking or tiling the 
windows. The tutorial that follows shows you how to do this. 

Stacking and tiling windows 

To see the difference, follow these steps: 

1. Choose Open in the File menu. 

2. Double click the ftle named memol in the start folder. 

The document appears in a window and is ready for editing. 

3. Choose Open in the File menu. 
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4. Double click the ftle named letterl. 

The windows are stacked by default, as in Figure 6-20. 

• Figure 6-20 Stacked windows 

luserslstart/memo 1 

12/20r:/~89~~~~~~~~~2!~~~~~~~~~1~~~~ TO: FD luserslstart/letterl 0 
~ 

FROM: 

RE: 

There 
GOOD 
this 
of tJ
repu 

~ 

-

January 11, 1990 

:~!~~o~T~~~::~~~~~!~~ ~ 
~;~~ :~::~:::~~~~:::duct Support manager, to I d me th; s Ji~ 
about the pr inters that arr i ved damaged. We i nsli tuted iiim 
investigation immediately. We discovered that an unusua Wi!: 
thaw caused flood i ng at a maj or warehouse in the midwest mn: 
have establ ished that the flood damaged some loading equ~ 
that was being used to stack cartons stored in that (} 

KJ [ T!iiiiiiWi:iimWiimi!WHiWmiiiiiiiiiiWmmiiiiiiiiiiiWiiiifiWmWiiiiiiiiiiii!WHiWiiiiiiHmii:iiiimiiWil Q ~ 

To tile the windows, follow this step: 

• Choose Tile Windows from the Window menu. 

The windows are laid out alongside one another, as in Figure 6-21. Note that the sizes 
of the windows change so that they fit on the screen. 
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• Figure 6-21 Tiled windows 

D Istart/memo 1 

12/20/89 

TO: Sales Represnetatives 
Customer Support Representatives 

FROM: A. Greening 

RE: Customer complaints 

There are two reasons for our amazing growth in the past few years: 
GOOD PRODUCTS and GOOD SUPPORT. Every salesperson who's been with 
this company for more than a few weeks knows that a healthy portion 
of their comissions are earned from repeat business, and that our 

Alpha Publ ishing 
Ralph Jones, Director 
Purchasing Department 
1343 Grove Avenue 
Brook I yn, N. Y. 112 18 

Dear Mr. Jones: 

/start/letterl 

January 11, 1990 

EI len Grant, our Product Support manager, told me this morning 
about the printers that arrived damaged. We instituted an 

Tiling makes it easy to work with several windows at once. To use this feature most 
effectively, however, it's best to have a large monitor. On a small monitor, the windows may 
become too small. 

D Important When a window becomes too small, the text in the window 
disappears and is lost. You have to reopen the file in a 
larger window. D 
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To return the windows to a stacked layout, do as follows: 

• Choose Stack Windows in the Window menu. 

The windows are now stacked as in Figure 6-20, earlier in this chapter. 

Marking a place in the fue 

If you need to return periodically to specific locations in a long or complex document, you 
can place invisible named markers at those points. You can then jump instantly to any of the 
marked places in the document. This saves you the time and trouble of having to scroll through 
the document to find those places. 

The following tutorial teaches you how to mark and unmark a document. The tutorial uses 
letterl (in the start folder) as a sample document, although marking is most useful in 
long, complex files. 

You will place two named markers in 1 e t t e r 1, the first at the beginning of the second 
paragraph ("We have instructed ... ") and the second at the beginning of the third paragraph 
("Let me apologize ... "). 

1. Highlight the word "We" at the beginning of the second paragraph. 

This is shown in Figure 6-22. 
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• Figure 6-22 Highlighting to place a marker 

D Ius e rs 1st a rt II e t t e r 1 

Alpha Publ ishing 
Ralph Jones, Director 
Purchasing Department 
1343 Grove Avenue 
Brook I yn, N. Y. 112 18 

Dear Mr. Jones: 

January 11, 1990 

EI len Grant, our Product Support manager, told me this morning 
about the printers that arrived damaged. We instituted an 
investigation immediately. We discovered that an unusual early 
thaw caused flooding at a major warehouse in the midwest. We 
have establ ished that the flood damaged some loading equipment 
that was being used to stack cartons stored in that 
warehouse overnight for transshipment. This faulty equipment, in 
turn, put abnormal stress on the packing, which resulted in the 
damage you reported. 

mm have instructed our New York sales office to remove the damaged 
equipment from your premises and to instal I new equipment as soon as 
it arrives. We wi I I air express dupl icate equipment to you tomorrow 
afternoon. 

Let me apologize to you for this mishap. 
has not caused you any serious problem. 

I hope that the delay 

2. Choose Mark in the Mark menu (Figure 6-23). 

• Figure 6-23 The Mark menu before the markers are created 

The dialog box illustrated in Figure 6-24 appears. 

I 
() 
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• Figure 6-24 The Mark dialog box 

Mark: the selection with what name? 

L£ 
n OK l Cancel 

The text box contains the highlighted word, which you will use as the name 
of the marker. If you want to give the marker a different name, type it in the 
text box. 

3. Click OK. 

You have named the first marker "We." 

4. Place the insertion point at the beginning of the third paragraph 
of letterl. 

5. Choose Mark in the Mark menu again. 

6. Type the numeral 2. That will be the name of the second marker. 

The resulting dialog box is shown in Figure 6-25. 

• Figure 6-25 The Mark dialog box with mark 2 

Mark: the selection with what name? 

I~ 

n OK D 
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7. Click OK. 

Now display the Mark menu. It contains a list of the invisible named markers that you have 
placed in the document (Figure 6-26). 

• Figure 6-26 The Mark menu with the list of markers 

Mark... 8€M 
Unmark ... 

We 
2 

Choose We. The insertion point moves to the We marker. Choose 2 and the insertion point 
moves to the third paragraph. 

To remove markers, follow these steps: 

1. Choose Unmark in the Mark menu. 

The dialog box illustrated in Figure 6-27 appears. 

• Figure 6-27 The Unmark dialog box 

Delete which markers? 

K Delete D Cancel 
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2. Highlight the name of the marker you wish to remove. Select marker 2 (as 
shown in Figure 6-27). 

3. Click Delete. 

If you look at the Mark menu, you will see that the marker you have deleted is no 
longer on the list. 

Printing 

TextEditor allows you either to print an entire document or a selection from a document. 
Be sure that your computer is properly connected to a printer and that you have used the 
Chooser (in the Apple menu) to choose a printer. For information on printer connections, 
see Chapter 7, "Printing in A/UX." 

Printing an entire document 

To print an entire document, follow these steps: 

1. Open the document in TextEditor. 

2. Choose Print Window from the File menu. 

You see the Print dialog box, shown in Figure 6-28. 

• Figure 6-28 The Print dialog box 

LaserWriter "LaserWriter" 5.2 n OK B 
cOPies:I'-1 Pages: @ HII 0 From: D To: D (cancel) 

COLIer Page: @ No 0 First Page 0 Last Page 

Paper Source: @ Paper Cassette 0 Manual Feed 

6-36 A/UX Essentials 
030-07S9-A 

Help 



3. Click OK to begin printing. 

Printing a selection of a document 

To print a selection of the document, first select a block of text as follows: 

1. Place the insertion point at the beginning of the desired selection. 

2. Hold down the mouse button and drag to the end of the 
desired selection. 

The selected text is highlighted, as shown in Figure 6-29, 

• Figure 6-29 A selected block of text 

Dear Phi I: 

I received your letter about the purchase of land for a new 
office bui Iding. 

It's true that the financial reports for the 
last quarter are not it yet, but there is a general feel ing 
that the numbers look good. This might be the perfect time 
to submit Ian. 

3. Choose Print Selection in the File menu. 

The Print dialog box appears, as shown in Figure 6-28, earlier in this chapter. 

4. Click OK to start printing. 
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Quitting TextEditor 

You may want to quit TextEditor to perform other tasks or to take a break. If so, 
do as follows: 

• Choose Quit from the File menu. 

If you have made changes to a file, you see a Save Before Quitting dialog box (shown in 
Figure 6-30), which asks you whether you want to save those changes. 

• Figure 6-30 Save Before Quitting dialog box 

Salle changes to luserslstart/letterl 

@ Salle TeHt Only 
o Salle Format Information 

K Yes n ( No Cancel 

Click Yes to save, click No to quit without saving, or click Cancel to cancel the 
Quit command. 

To save the document as text-only file, click Save Text Only. To save a resource fork file with 
formatting information (in addition to the text file), click Save Format Information. 
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Chapter 7 Printing in A/UX 

This chapter explains how to print files using A/UX 2.0 printing utilities. 
It also gives a brief overview of the types of printers and printing 
software available. 

This chapter contains the following sections: 

• Understanding printing 

• Printing a Macintosh document from A/UX 

• Printing text files 

• Printing a selection from CommandS hell 

You can read this chapter in its entirety or go directly to those sections 
that are of use to you. 
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Understanding printing 

A/UX 2.0 provides several printing utilities, which print files created by a text editor (such 
as v i or TextEditor), a word processor, or other Macintosh or UNIX applications. 

Before you can print a document, you must have a printer connected to your system or 
to the network, and the printer must be configured to your system software. Your system 
administrator should set up the printer for you. If you are the system administrator, see 
Setting Up Accounts and Peripherals for AlUX Consult AlUX Local System Administration or 
AlUX Network System Administration for more details on connecting a printer on an AppleTalk 
network and administering networked printing. 

Printer connections 

You can connect a printer in three basic ways. 

• AppleTalk® network system printer: The printer is connected via the 
LocalTalk™ cable system andlor EtherTalk® interface card, router, and 
built-in AppleTalk software. 

Any computer on the network can send files created with a text editor or a 
Macintosh application to the printer. The files are printed in the order in which they 
are received. 

• Direct-connect ImageWriter® printer: The printer is connected directly to a 
serial port on the Macintosh computer. 

Any user with an account on the computer to which the printer is connected can print 
an A/UX file. 

• Note: A LaserWriter® IISC printer that is directly connected to the SCSI port won't 
work with A/UX 2.0. 
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• Remote UNIX printer: The printer is connected to another A!UX or UNIX 
computer by the Ipr spooler. 

Any computer on the network can send text files to the printer. The files are printed 
in the order in which they are received. 

Figure 7-1 shows the different printer configurations. 
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• Figure 7-1 Three types of printer connections 

... ---------------------------~---------------~~ 

MaCintosh 
document 

_--1... ______ ••• 

AppleTalk 
router 

EtherTalk 1 T lk Appe a 
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Printing a Macintosh document from A/UX 

To print a Macintosh file from A/UX (for example, one created by a third-party application or 
by TextEditor), you must have either a printer that is directly connected to the computer or 
else an AppleTalk network printer (or one that is compatible with AppleTalk software) 
connected via LocalTalk (or EtherTalk) cables, router, and built-in AppleTalk software. 

Printing from the Finder 

Follow these steps to print a Macintosh document from the Finder: 

1. Select the document you want to print by clicking its icon. 

2. Choose Print from the File menu. 

You see the Print dialog box, as in Figure 7-4. 

3. Click OK 

This action is the same as printing a document from the Finder in the Macintosh OS. 

You can also consult the manual that came with the application for more information 
on printing. 

Printing text files 

You can use the A/UX 1 P r ("line printer") command to print files created with text editors 
(such as vi or TextEditor). Several sample files exist in the start folder. This tutorial uses 
one of the sample files. 

A/UX spools the files to be printed, that is, it stores them in memory until the printer is ready 
for them. The spooler prints them in the order in which they are received. 

Figure 7-2 illustrates the printing queue. 
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• Figure 7-2 The printing queue 

• Note: The 1 p r spooler doesn't format documents. You must use a formatting 
command such as p r or t r 0 f f to format documents before you send the job 
to the printer. 

Selecting an AppleTalk printer 

Before A/UX can print a file, it must know which printer to use. Use the Chooser (in the Apple 
menu) to select a printer. Some applications direct you to choose Page Setup after using the 
Chooser. For further information, see the guide that came with the application. 

You can choose any printer that has been connected to your network or your computer via 
AppleTalk software and LocalTalk (or LocaITalk-compatible) and/or EtherTalk cables. 
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Follow these steps: 

1. Choose Chooser from the Apple menu. 

The Chooser dialog box appears, as shown in Figure 7-3. You see an icon representing 
each of the printer types for which you have printer resources installed in the 
currently active system file. 

• Figure 7-3 The Chooser dialog box 

o 

~ ~ 
Apple-Share- Apple-Talk I... 

.:1. --.=:I. 
LQ 'Apple-T~l... iMW-

AppleTalk Zones: 

CC3-5th/South 
CC3-7th/South 
CC 3 - Bth / Nort h 
CC3-Bth/South 

Chooser 
Select a LaserWriter: 
Gribnib 
Rear Window 
The Troubl e wi th Harry (C) 
Pai r O'Di ce Lost (NTX) 

Background Pri nt i ng: @ On 0 Off 

User Name: 

@ Active 
AppleTalk 0 inactive 

3.5 

2. Click the icon representing the type of printer you want to use. 

3. H necessary, activate the AppleTalk software by clicking 
AppleTalk Active. 

If the radio button is already selected, go on to the next step. A few seconds after 
you select the radio button, the names of any zones appear in the AppleTalk Zones 
box. If you don't have zones, skip to step 5. 

4. Select the appropriate zone from the AppleTalk Zones list. 

The zone name is highlighted. 
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5. Select the appropriate printer name in the AppleTalk printer list. 

The printer name is highlighted. 

6. Type your name in the User Name text box. 

Your name appears automatically in the Chooser box from now on, until you change 
startu p disks. 

7. Click the close box. 

The Chooser dialog box disappears, and you are ready to print. 

Sending a ftIe to a printer through AppleTalk 

To use the lpr command, follow these steps: 

1. Log in to the start account. 

2. Use the Chooser in the Apple menu to select a printer. 

3. Choose CommandS hell from the Apple menu. 

4. Enter the command: 
lpr letterl 

This command sends the file let terl to the printer. 

Sending a ftIe to a direct-connect printer 

To use the lpr command, follow these steps: 

1. Log in to the start account. 

2. Choose CommandS hell from the Apple menu. 
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3. If you are using a direct-connect ImageWriter printer, enter 
the command: 
Ipr -Piw letterl 

This command sends the file 1 e t t e r 1 to the printer. 

Sending a ftIe to a remote UNIX printer 

To use the lpr command, follow these steps: 

1. Be sure that your / etc/printcap ftle has been set up. 

For information on setting it up, see Chapter 9, "Connecting Your Computer to a 
Network," in Setting Up Accounts and Peripherals for AlUX. 

2. Log in to the start account. 

3. Choose CommandS hell from the Apple menu. 

4. Enter the command: 
Ipr -P printername letterl 

Replace the italicized word with the name of the printer that you want to use. This 
command sends the file 1 e t t e r 1 to the printer. 

Finding out how many ftIes are waiting in the printing queue 

A/UX spools printing jobs, placing them in a queue of first-come, first-served precedence. If 
you share your printer and there are other jobs ahead of yours, those jobs are printed first. 
Your file is printed when your turn comes. 

• To get a list of the print jobs in the printing queue, enter the command: Ipq 

A list appears that may look something this: 
Rank Owner 
active jrns 
1st pzp 
2nd alp 

Job Files 
3 filename 
4 filename 
5 filename 

Total size 
720 bytes 
1500 bytes 
2451 bytes 
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The first column shows the rank, the second shows the initials of the owner of the file 
sent to the printer, the third shows the identification number of the print job, the 
fourth column shows the filename (including its path), and the last column shows the 
size of the file. 

Canceling a printing job 

If you want to cancel a printing job before it's completed but after you've sent it to 
the printer, you can do so by using the lprm command with the ID number of the 
printing job. 

• Enter: 
Iprm ID-number 

Substitute the ID number of the printing job (such as lpr 398) for ID-number. 

The following message appears as A/UX cancels the job. 
ID-number dequeued 

For more information about lpr, see lpr(l) in A/UX Command Reference. For more 
information about cancel, see lp(1) in A/UX Command Reference. Refer also to 
A/UX Network System Administration. 

Printing a selection from CommandShell 

If you have a printer connected to an AppleTalk network, you can print a selection from a 
CommandS hell window. 

If you have a selection of text in your CommandShell window (for instance, a series of 
commands that you want to save in hard copy), print the selection as follows: 

1. Click and drag to select the text you want to print. 

The text appears highlighted. 
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2. Choose Print Selection from the File menu. 

The Print dialog box appears, as in Figure 7-4. 

• Figure 7-4 The Print dialog box 

LaserWriter "LaserWriter" 5.2 n OK J 
cOPies:I'_1 Pages: @ All 0 From: D To: D (cancel) 

Couer Page: @ No 0 First Page 0 Last Page Help 
Paper Source: @ Paper Cassette 0 Manual Feed 

3. Click OK to print or click Cancel to cancel the printing command. 

To set printing specifications for the selection, use the Page Setup command in the 
File menu. See the owner's guide that came with your computer for more information 
on Page Setup. 
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Chapter 8 Communicating With Others 

This chapter describes how to use the mail utility to send a message, 
how to share files with other users on a network by using Network 
File System (NFS) protocols, and how to use files on an AppleShare@ 
file server. 

With the rna i 1 utility you can send a message to yourself, to another user 
or group of users with accounts on your computer, or to an account on a 
remote computer connected by a network. 

This chapter contains the sections that follow: 

• Sending a message to another UNIX user 

• Sending mail over the Internet 

• Sending mail over UUCP 

• Receiving mail 

• Reading mail 

• Exiting mail 

• Sharing files via NFS 

• AppleShare access 

Two A/UX mail utilities exist. This chapter describes the 
/usr /bin/mailx program, but not the /bin/mail program. The 
name mail is defined in / etc/ . profile and in / etc/ . cshrc so 
that it runs the program mailx. For further information, see "Using mail" 

in AlU¥ Communications User's Guide, and mail(1) and mailx(l) in 
AlU¥ Command Reference. 
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Sending a message to another UNIX user 

You can use the rna i 1 utility to send electronic messages to and receive messages from other 
users on your machine. If your machine is connected to other machines by either the UUCP or 
the Internet network facility, you can send mail to users in other locations. 

Here are a few of the ways you can use rna i 1: 

• If you are the only user on your machine and you don't have network access, you can send 
mail to yourself. 

• If you share your computer, you can send messages to the other users of your computer and 
they can send them to you. 

• If your computer is connected to a local area network, you can send messages to and 
receive messages from the other people on the network. 

• If you are connected to large networks via the UUCP or the B-NET facility, you can send 
messages to and receive messages from the other people on the network, even from 
continents away. 

Figure 8-1 shows several ways to use mail. 
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• Figure 8-1 Using mail to communicate with other A/UX users 

A. Mail from user to user 

B. Mail from location to location. 

To send a message to another UNIX user, complete the instructions in the sections 
that follow. 
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Sending a message to a user account on your machine 

This section describes how to send a message to a user account on the same computer that 
you're using. To send a message to someone, you start up the mail utility, type the message, 
and then send the message. The following sequence of steps explains the process. If you're not 
already logged in to the system, log in using the start account. 

1. Choose CommandShell from the Apple menu. 

2. Enter the command: mail start 

A CommandShell window appears with the mail command prompt. The arguments 
you type on the command line following the rna i 1 command specify the address of 
the message you type. You can specify one name, or several names separated by 
spaces, as addresses. 

You use the login name of the person you want to receive the message. In this 
example, the message goes to the start account. Next, you see the prompt: 
% mail start 
Subject: 

3. Enter the following: sample session 

The cursor waits on the next line, ready for you to insert text. 

4. Type the following: 
Dear friend, 

This sample mail message proves that I can communicate 
electronically. 
Bye. 

5. Press RETURN. 

Doing this starts a new line. 

6. Press CONTROL-D. 

This command sends the message. The system replies with the message EOT (for end 
of transmission) below the message you typed, to signify that you've sent the 
message successfully, as shown here: 
EOT 

% 
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Because you specified the start account in the rna i I command, rna i I s tart, the 
message is sent to the account you're using. Had you specified a different user name 
as the argument, the message would have been sent to that user account. Wait a few 
minutes for the mail to arrive. 

7. Press RETURN a few times. 

When the mail has arrived, the shell prompt and the following message appear: 
You have mail. 

8. Enter this command: mail 

Using the mail command alone causes the mail utility to display a list of the 
messages you have received. You should have at least one message. You see a listing 
like this on your screen: 
A/UX Release 2.0 Type? for help. 
"usr/mail/start": 1 message 1 new 
>N 1 start Fri Apr 18 12:05 12/220 sample session 
? 

9. Enter the following: 1 

The number identifies the message you want to read. If you have several messages, 
you'll see a listing for each one with a corresponding number. The message appears 
on your screen, as shown next. You can type the number of the message you want 
to read. 
Message 1: 

From start Fri Apr 10 12:19 PDT 1987 
To: start 
Subject: sample session 
Status: R 

Dear friend, 
This sample mail message proves that I can communicate 
electronically. 
Bye. 

? 

The question mark prompt appears at the end of the message so that you can enter a 
new command when you're done reading the current message. If you type? you see a 
listing of the available commands and their meanings. 
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10. Press CONTROL-D. 

The message is automatically saved, and you exit the mail utility. While A/UX is 
saving the message, the system prints 
Held n message in /usr/rnail/start 

where n is the number of the message that was saved. 

If you exit mail by entering q or quit; the system also saves the message. 

You can repeat the steps presented here, substituting the login name of another user account 
on your machine, to send a message to that account. Use this step to try it: 

• Enter this command mail name 

Replace name with the login name of the person you're addressing. 

If you type several login names as part of the mail command, the message goes to all 
those users. For example, the command 
mail lori jeff laura linda 

will send the subsequently typed message to those four user accounts. 

Canceling a message you don't want to send 

If you decide not to send a message while you're writing it, you can cancel the message by 
doing this: 

1. Press CONTROL-C. 

Doing this sends the interrupt signal to the system. When you press CONTROL-C, ma i 1 

prints the message 
(Interrupt--one more to kill letter) 

2. Press CONTROL-C again. 

Doing this cancels the letter. A/UX stores canceled letters in the file dead. let ter 

in your home directory. You can delete these files by dragging them to the Trash and 
using the Empty Trash command in the Special menu. 
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Sending a mail message to a user on your local network 

To send a message to someone, you start up the mail utility, type the message, and then send 
the message. The following sequence of steps explains the process. The steps will work only if 
you are connected to other A/UX users on a network. If you're not already logged in to the 
system, log in using the start account. 

1. Choose CommandShell from the Apple menu. 

A CommandS hell window appears with the shell prompt. 

2. Enter the following: mail username 

Substitute the login name of someone on your network for the word in italics. 

3. Type your message. 

4. Press RETURN. 

Doing this starts a new line. 

5. Press CONTROL-D. 

The mail utility prints EOT (for end o/transmission), and you return to the shell. 
When the user to whom you sent the message logs in, this message appears in a 
CommandShell window: 
You have mail. 

The mail is the message you sent, as well as any other messages sent to that user, preceded 
by a line identifying you (your login name) as the sender, and the date and time the message 
was sent. 
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Sending mail over the Internet 

Before you can use this facility, be sure that your system administrator has connected 
your system to the network and configured it properly. For further information, see 
A/UX Network System Administration. 

The Internet is the world-wide network consisting of computers linked together by 
TCP/IP-based protocols. The A/UX implementation of Internet software is based on TCP/IP. 

Sending mail to someone over the Internet is just like sending mail to another user account on 
your system, although the form of the address is different. 

For example, if you're sending mail to the user pet e on a remote machine over the Internet, 
you start by doing this: 

• Enter the command mail pete@rhost 

Replace rhost with the name of the remote host. The rest of the process works as in the tutorial 
just presented. 

Sending mail over UUCP 

Before you can use this facility, be sure that your system administrator has connected 
your system to the network and configured it properly. For further information, see 
A/UX Network System Administration. 

Sending mail to someone over UUCP is just like sending mail to anyone else, except that the 
form of the address is different. 

For example, if you're sending mail to the user pete on a remote machine over UUCP, you start 
by doing this: 

• Enter the command mail rhost\! pete 

where rhost is the name of the remote host. 

You need the backslash (\) only if you're working in the C shell. 
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The rest of the process works the same way as in the previous tutorial. 

UUCP can use other machines that receive and forward mail to send messages all over the 
world. In this case, you need to use a "path" that specifies each machine along the way as 
shown here: 
mail rhostl \ ! rhost2 \ ! rhost3 \ ! pete 

For more information, refer to AlUX Communications User's Guide. 

Sending mail to more than one person 

To send the same message to more than one person, list each addressee's login name on the 
command line when you start up mail. 

For example, to send the same message to several people on your network whose login names 
are lori, dave, mike, and jeff, you enter: 
mail lori dave mike jeff 

Then proceed as with any ma i 1 message. 

If you want to send mail to more than one person on the same remote machine over Internet, 
you must type each person's address separately. For example, if the users with login names 
linda, tony, sharon, and laura are all on a remote machine over Internet, you enter: 
mail linda@rhost tony@rhost sharon@rhost laura@rhost 

(where rhost is the name of the remote host) and proceed as with any mail message. 

If you want to send mail to more than one person on the same remote machine over UUCP, you 
must type each person's address separately. For example, if users with the login names don, 

vicki, bob, and jackie are all on the machine rhostover UUCP, you enter 
mail rhost\! don rhost\! vicki rhost\! bob rhost\! jackie 

(where rhost is the name of the remote host) and proceed as with any mail message. 

Use the backslash (\) before the exclamation mark if you are working in the C shell. 
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Receiving mail 

The mail system collects your incoming messages in a file called the system mailbox. If you 
receive a message while you're working, the message 
You have mail. 

is stored in a CommandShell window. The next time you log in, CommandShell posts 
a message in a window. The A/UX system is automatically set to check every 60 seconds 
to see if new mail has arrived for you. This procedure is set in the / etc / pro f i Ie 

system file. 

Reading mail 

When you want to read your mail, exit any interactive program you are running (such 
as TextEditor). 

1. Choose CommandShell from the Apple menu. 

This displays a CommandShell window with a shell prompt. 

2. Enter this command: mail 

If you don't have any mail, the message 
no mail for name 

appears, where name is your login name. 

When you have mail, each message is summarized in a numbered list that shows the 
author's login name, the subject, and the date it was sent. To display this summary, 
complete step 3. 

3. Enter this command: h 
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4. Press RETURN or enter the number of the message you want to read. 

Pressing RETURN causes rna i 1 to display the first message. If you enter the number 
of a message, A/UX displays that message. For example, if you have 11 messages and 
you want to read message 7, enter 7. The header at the top of a message tells you 
who sent the message, when it was sent, and what it's about. A question mark 
prompt appears at the end of the message. After you read the message, press 
RETURN, and the next message is displayed. 

5. Repeat step 3 to read more messages. 

If you want to read a specific message from the list, do so by specifying the message number. 
If you press RETURN again, A/UX displays the next message. 

Deleting a message 

You can delete one or more messages you receive when you finish reading them. To delete all 
messages, do this: 

• Enter the following: d 

To delete a specific message: 

• Enter the following: d n 

Substitute the message number for n. The rna i 1 utility deletes the message 
or messages. 

Saving a message in a particular fue 

If you want to save a message in a file, you can tell rnai 1 to save it and give it a filename. 
If the filename you give doesn't exist, the system creates the file and puts the message 
in it. 
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• Enter the following: s messagenumber filename 

For example, if you enter s 4 rnerno.lori, the mail utility saves the fourth message on the list 
in a file named memo. lor i . 

Exiting ma i 1 

There are two ways to exit the mail utility. The first way follows any delete commands you 
have given. The second way ignores any delete commands and restores mail to the way it was 
when you started up the rnai 1 utility. 

To quit rna i 1, do this: 

• Enter the following: q 

The q command (for quit) removes messages you marked for deletion, places any 
unread messages on the unread list, and terminates the rna i 1 program. If you exit 
rna i 1 using q, you cannot restore a message you have deleted. 

If you change your mind and wish to restore a deleted message before you exit the rna i 1 

program, use the x command to leave mail. To quit mail and keep all your messages, 
do this: 

• Enter the following: x 

The x command (for exit) restores any deleted messages, places any messages you 
read back on the new message list, and terminates the rna i 1 program. 

Additional rna i 1 capabilities 

The rna i 1 utility gives you several other helpful abilities, such as editing messages, replying to 
messages, and so on. For more information about these and other rna i 1 functions, refer to 
A!UX Communications User's Guide. 
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Sharing rues via NFS 

Sharing files means that more than one user, on more than one system, can have access to 
the same files. The Network File System protocols provide a file-sharing mechanism for 
many different kinds of computers. Usually one or more "file servers" provide files for a 
number of clients. Each user on a client machine is able to access the files from the server. 
Once NFS is set up, using files from a file server on a remote machine is just like using files on 
your local machine. Check with your system or network administrator to find out more about 
NFS in your organization. For information on how to set up and mount an NFS file server, see 
AlUX Network System Administration. 

AppleShare access 

Like the Macintosh OS, A/UX allows you to be an AppleShare client. You simply choose the 
Chooser in the Apple menu, double-click the AppleShare icon, and select a server from the list 
of servers. After you log in as guest or as the registered user, the icon for the server appears on 
your desktop. You can then use the files on that volume. Server icons or file icons that are 
greyed out are not available for your use. 

See your AppleShare administrator for more information on connecting to an 
AppleShare network. 

• Note: Your A/UX machine cannot be used as an AppleShare server, that is, files on your 
machine cannot serve users on other machines. 
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Chapter 9 A/ux Reference 

This chapter provides a quick reference for the menu commands that you 
encounter while working in the Finder environment, the CommandS hell 
environment, and the TextEditor application. This chapter describes the 
function of each command in the order in which they appear in each menu. 

This chapter contains three sections: 

• The Finder environment 

• The CommandShell environment 

• The TextEditor application 
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The Finder environment 

This section describes the commands to which you have access when you are working in the 
Finder. The Finder is an application that allows you to have more than one application open 
and running at the same time. The Finder also grants you easy access to all of the files, 
applications, and utilities on your system. 

The Apple menu 

The Apple menu contains the list of available applications, desk accessories, and information 
items identifying versions of software and their developers. Figure 9-1 shows a sample Apple 
menu. Yours will contain the desk accessories and applications that you have installed on 
your system. 

• Figure 9-1 The Apple menu 

About the Finder ... 
Hide Finder Windows 

01 CommandShell 

./ ~ Finder 

rID Alarm Clock 
rID Calculator 
rID Chooser 
rID Control Panel 
rID Find File 
rID Key Caps 
rID Scrapbook 

About MultiFinder ... 
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About the Finder 

This command identifies the Finder version and the developers who wrote the Finder. When 
you change to another application, this command becomes "About application-name ... " and 
displays proprietary information about the active application. Figure 9-2 shows the About the 
Finder dialog box. 

• Figure 9-2 About the Finder dialog box 

D "bout the Macintosh® FinderTM 

Finder: 6.15 LarrllJ. John. Steve. and Bruce 
SIIJ stem: 6.0.5 @ Apple Computer. Inc _ 1 983-89 

Total MemorllJ: 5,120K Largest Unused Block: 2,694K 

o CommandShe 11 

~ Finder 

~ System 

292K 

256K 

l,615K 

Hide Finder Windows 

[JJ 
111"7':1 
IIIl:.::.:J 

This command closes all Finder windows and displays an untitled CommandShell window. 

CommandS hell 

This command displays an untitled CommandShell window like the one in Figure 9-3. 
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• Figure 9-3 A CommandShell window 

o CommandS hell 1 
# I 

Finder 

This command returns you to the Finder desktop from whatever process A/UX is running. 

Desk accessories 

Desk accessories are like mini-applications that you may want to use while you're working in 
the Finder or another application. Seven desk accessories-Alarm Clock, Calculator, Chooser, 
Control Panel, Find File, Key Caps, and Scrapbook-are shipped with your computer. See the 
owner's guide that came with your Macintosh computer for information about these seven 
desk accessories. 

List of open applications 

The next portion of the Apple menu lists the names of the open applications. A check mark 
appears next to the name of the active process. 
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The File menu 

The File menu, shown in Figure 9-4, contains the commands that manage your 
desktop environment. 

• Figure 9-4 The File menu 

:#:N 
Open ~O 

Print 
Close ~W 

bpt PriuHpl.WS )}[(P 
Get Info ~I 

Duplicate :#:0 
Put !hmHJ 

Page Setup ... 
Print Directory ... 

Eject ~E 

New Folder 

This command creates a new folder, also called a directory, in the active window. Each 
new folder is created with the name Empty Folder. You can immediately change the name 
of the folder by typing a new name while the title is still selected. The Command-key 
equivalent is COMMAND-N. 

Open 

This command opens the selected file in the Finder. This can be a folder, an application, or a 
file. The Command-key equivalent is COMMAND-O. 

Chapter 9 A/UX Reference 9-5 
030-0759-A 



Print 

This command prints whatever item is selected in the Finder. 

Close 

This command closes the active window. The Command-key equivalent is COMMAND-W. 

Get Privileges 

This command displays the privileges for each, file, folder, or application. The 
Command-key equivalent is COMMAND-P. 

Get Info 

This command displays a window that contains file information about the currently selected 
item. Figure 9-5 shows the Get Info window for the Font/DA Mover. 

• Figure 9-5 The Get Info window 

Info 

W FonUDA Mover 
Locked D 

Kind: application 
Size: 37,720 by ~es used, 37K on disk 

Yhere: John David S~u~ts, SCS I 0 (F a9ade 
by GBM) 

Created: Thu, oct 8, 1 987, 1 2 :00 PM 
Modified: Thu, Oct 8, 1 987, 1 2 :00 PM 
Yersion: F onUD A Mover Version 3.6 

© 1985,1986,1987 Apple 

Suggested MemorlJ Size (K): n I a 

App lication MemorlJ Size (K): ~ 
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You can use this command only in the Finder. The Get Info window reports the kind 
of file, its size, its location, its creation date, the date the file was last modified, 
and the version of the application that was used to create the file. The window also contains 
an editable text field in which you can store comments about the file. It is useful to store such 
information as the version of the file, other files related to this one, or the version of the 
application, if it's not reported by the application. The Command-key equivalent is 
COMMAND-I. 

-Duplicate 

This command makes a copy of a selected file, folder, or application. The Command-key 
equivalent is COMMAND-D. 

Put Away 

This command restores to its original location a file, folder, or application that was moved to 
the desktop. 

Page Setup 

This command presents the Page Setup dialog box for the printer type that you 
have selected in the Chooser. Figure 9-6 show the Page Setup dialog box for a 
LaserWriter printer. 

• Figure 9-6 The LaserWriter Page Setup dialog box 

laserWriter "Thaddis Bosley Jr." 6.0 t OK J 
cOPies:1 I Pages: @ All 0 From: D To: D (Cancel] 

Couer Page: @ No 0 First Page 0 last Page ( Help] 

Paper Source: @ Paper Cassette 0 Manual Feed 
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Print Directory 

This command prints a listing of the contents of the active window. When you choose this 
command, the Print dialog box appears. When you click OK, a directory listing is sent to the 
printer you have identified in the Chooser. 

• Note: "Directory" is a term that is used frequently in UNIX. In this case, a directory is 
a pictorial, alphabetical, or chronological list of the contents of a folder or disk. 

Eject 

This command ejects the selected disk. The Command-key equivalent is COMMAND-E. 

The Edit menu 

The Edit menu, shown in Figure 9-7, contains commands that you use to edit text in windows. 
You can also use the editing commands with most desk accessories. 

• Figure 9-7 The Edit menu 

Undo 002 

Cut ~H 

Copy ~C 

Paste ~U 

Clear 
Select HII ooH 

Show Clipboard 
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Undo 

This command nullifies the last text editing or formatting change that you made. It does not 
nullify command execution. The Command-key equivalent is COMMAND-Z. 

Cut 

This command copies any selected text to the Clipboard and removes the text from the 
window. The text is stored in the Clipboard until it's replaced by text sent there as the result of 
another Cut or Copy command. The Command-key equivalent is COMMAND-X. 

Copy 

This command copies any selected text to the Clipboard but does not remove it from the 
window. The text is stored in the Clipboard until it's replaced by text sent there as the result of 
another Cut or Copy command. The Command-key equivalent is COMMAND-C. 

Paste 

This command inserts the contents of the Clipboard into the window starting at the insertion 
point. The Command-key equivalent is COMMAND-V. 

Clear 

This command removes any selected text from the window. Text removed with the Clear 
command is no longer available. Choosing Clear is equivalent to pressing the DELETE key. 

Select All 

This command selects all of the text in the window. The Command-key equivalent 
is COMMAND-A. 

Show Clipboard 

This command displays the contents of the Clipboard in a separate window. 
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The View menu 

The View menu provides commands to alter how the contents of a disk or a folder are 
displayed in the Finder. A check mark appears next to the active listing type. The View 
menu is shown in Figure 9-8. 

• Figure 9-8 The View menu 

by Small I con 
../by Icon 

by Name 
by Date 
by Size 
by Kind 

by Small Icon 

When you view the contents of a disk or folder by small icon, you see a miniaturized 
representation of the icons of the different files, applications, and folders it contains. 
Figure 9-9 shows a folder whose contents are viewed by small icon. 
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• Figure 9-9 A folder's contents viewed by small icon 

Coop's folder 
15 iteoms 1 6,400K in disk 2 ,71 1 K av ailab leo 

~Elvis sightings ..... Thad's Gl'"eoateost Hits III Leotteol'" to MI'". Mal'"queoz 

m HoskeonF onts 1;1 Tuffy theo T 01'"0 ~Bi9 Jim's SURVIVE! 

III Bustin' Beon ~cornbl'"eoad's Reoveonge IIlngeosheov 

rID Font Squeoncheol'" II Gabeo's I'"eovieow ~Hypeol'"Cal'"d 

~Opeol'"ation POl'"kl'"ind LJ PotatoL ink discussions 

Be: Josh Ramseoy 's vil'"us deoteoctol'" 

by Icon 

When you view the contents of a disk or folder by icon, you see the full-size representation of 
the icon of each file, folder, or application, Figure 9-10 shows a folder whose contents are 
displayed by icon, 
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• Figure 9-10 A folder's contents viewed by icon 

Coop's folder 
15 itE'ms 1 5, 908K in disk 3,204K availablE' 

~ ~ ~ ----
Elvis sightings 

Thad's GrE'atE'st Hits LE'ttE'r to Mr. MarquE'z 

[AJJ [l:J ~ 
HoskE'nF onts Big Jim's SURV IVE! 

Tuffy thE' T oro 

[IJ ~ 
im§ 

----
Bustin' BE'n CornbrE'ad's RE'vE'ngE' IngE'shE'v 

~ 1\ CJ 
HYPE'rCard 

PotatoLink discussions 

Josh RamsE'Y 's virus dE'tE'ctor 

LID ~ ~ :::=-=-: 
Font SquE'nchE'r ----

OpE'r ation Porkrind 
GabE' 's rE'viE'w 

by Name 

When you view the contents of a disk or folder by name, an alphabetized list of the different 
files, applications, and folders appears in the window, Figure 9-11 shows a folder whose 
contents are displayed by name, 
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• Figure 9-11 A folder's contents viewed by name 

Coop's folder 
Name Size Kind Last Modified 

<$i Bi9 Jim's SURVIVE! 12K app lioation Thu, Apr 1 3, 1 989 11 :26 AM 

D Bustin' Ben 2K MaoWrite 4.6 doo ... Fri, Deo 8,1989 3:01 PM 

<$i Cornbread's Revenge 12K app lioation Thu, Apr 13, 1989 11 :26 AM 

D Elvis si9htin9s lK App leLink 5.0 doo ... Tue, oct 24,1989 3:57 PM 

D Font Squenoher 2K F ontiD A Mover d ... Tue, Deo 2, 1986 8:34 AM 

D Gabe's review 3K Miorosoft Word 4 ... Fri, Deo 8, 1989 10:47 AM 

D HoskenF onts 123K F ontiD A Mover d ... Wed, Jan 17, 1990 2:08 PM 

<$i Hy perCard 390K applioation Wed, Feb 8, 1989 4:09 PM 

D Ingeshev 3K Miorosoft Word 4 ... Fri, Deo 8,1989 10:51 AM 

<$i Josh Ramsey's virus de ... 62K applioation Fri, Jan 13, 1989 12:11 PM 

D Letter to Mr. Marquez 2K MaoWrite 4.6 doo ... Fri, Deo 8,1989 3:01 PM 

<$i Operation Porkrind 12K applioation Thu, Apr 1 3, 1 989 11 :26 AM 

D PotatoLink disoussions -- folder Thu, Feb 15, 1990 2:40 PM 

D Thad's Greatest Hits 19K Empty Library do ... Fri, Jan 1 9, 1990 2:22 PM 

D Tuffy the Toro 4K MaoP aint dooument Thu, Jan 18, 1990 5:23 PM 

The list you see has four columns: 

• Name: This column shows the name of the files, folders, or applications in the window, 

• Size: This column shows how much memory the item occupies on the disk. 

• Kind: This column shows whether an item is an application, folder, or file, If it is a file, the 
file type is shown, 

• Last Modified: This column shows the date and time that the file, application, or folder 
was last changed, 

• Note: You may need to enlarge the window to see all of the information, 

by Date 

When you view the contents of a disk or folder by date, the different files, applications, and 
folders in the window are displayed with the most recently created or modified one listed 
first. Figure 9-12 shows a folder's contents viewed by date. 
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• Figure 9-12 A folder's contents viewed by date 

Coop's folder 
Naml? Sizl? Kind Last Modifil?d 

D PotatoLink disoussions -- foldl?r Thu, F I?b 15, 1 990 2:40 PM 

D Thad's Grl?atl?st Hits 19K Empty Library do ... Fri, Jan 19, 1 990 2:22 PM 

D Tuffy thl? Toro 4K MaoP aint doouml?nt Thu, Jan 1 8, 1 990 5:23 PM 

D Hoskl?nFonts 123K F onUD A Movl?r d ... Wl?d, Jan 17, 1990 2:08 PM 

D Bustin' Ben 2K MacWritl? 4.6 doc ... Fri, Dl?c 8, 1989 3:01 PM 

D Ll?ttl?r to Mr. Marqul?z 2K MaoWritl? 4.6 doo ... Fri, Dl?o 8,1989 3:01 PM 

D Ingl?shl?v 3K Miorosoft Word 4 ... Fri, Dl?o 8,1989 10:51 AM 

D Gabl? 's rl?vil?w 3K Microsoft Word 4 ... Fri, Dl?c 8,1989 10:47 AM 

D Elvis sightings 1K App ll?Link 5.0 doo ... TUI? , Oot 24, 1 989 3:57 PM 

<$ Big Jim's SURVIVE! 12K applioation Thu, Apr 1 3, 1 989 11 :26 AM 

<$ Cornbrl?ad's Rl?vl?ngl? 12K app lioation Thu, Apr 13, 1989 11 :26 AM 

~ Opl?r ation Porkrind 12K application Thu, Apr 13, 1989 11 :26 AM 

~ HYPl?rCard 390K applioation Wl?d, Fl?b 8,1989 4:09 PM 

~ Josh Ramsl?Y 's virus dl? .. 62K application Fri, Jan 1 3, 1 989 12:11 PM 

D Font Squeonchl?r 2K F onUD A Movl?r d ... TUI?, Dl?c 2, 1986 8:34 AM 

by Size 

When you view the contents of a disk or folder by size, the applications, files, and folders in 
the window are listed in order, from largest to smallest. Figure 9-13 shows a folder's contents 
viewed by size. 
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• Figure 9-13 A folder's contents viewed by size 

Coop's folder 
Name Size Kind Last Modified 

~ HyperCard 390K application Wed, Feb 8,1989 4:09 PM 

D HoskenF onts 123K F on tiD A Mover d ... Wed, Jan 17, 1990 2:08 PM 

~ Josh Ramsey's virus de ... 62K app lication Fri, Jan 1 3, 1 989 12:11 PM 

D Thad's Greatest Hits 19K Empty Library do ... Fri, Jan 19, 1990 2:22 PM 

~ Big Jim's SURVIVE! 12K application Thu, Apr 1 3, 1 989 11 :26 AM 

~ Cornbread's Revenge 12K application Thu, Apr 1 3, 1 989 11 :26 AM 

~ Operation Porkrind 12K application Thu, Apr 1:3, 1 989 11 :26 AM 

D Tuffy the T oro 4K MacPaint document Thu, Jan 18, 1990 5:23 PM 

D Gabe's review 3K Microsoft Word 4 ... Fri, Dec 8, 1989 10:47 AM 

D Ingeshev 3K Microsoft Word 4 ... Fri, Dec 8, 1989 10:51 AM 

D Bustin' Ben 2K MacWrite 4.6 doc ... Fri, Dec 8, 1989 3:01 PM 

D Font Squencher 2K F ontiD A Mover d ... Tue, Dec 2, 1986 8:34 AM 

D Letter to Mr. Marquez 2K MacWrite 4.6 doc ... Fri, Dec 8, 1989 3:01 PM 

D Elvis sightings lK App leLink 5.0 doc ... Tue, Oct 24, 1 989 3:57 PM 

o Potato Link discussions -- folder Thu, Feb 1 5, 1 990 2:40 PM 

The size of a file, application, or folder is the amount of memory it occupies, After the name 
of the item you see a number followed by a K, or kilobyte, which is equal to 1024 bytes, The 
number 390K next to the application HyperCard means that it occupies 390 kilobytes of 
memory on the disk. A standard double-sided floppy disk can hold up to 800K of memory, 
The average hard disk containing A/UX can hold up to 80 megabytes of information, A 
megabyte is equal to 1024 kilobytes, 

by Kind 

When you view the contents of a disk or folder by kind, the files, folders, and applications are 
listed alphabetically by type, Figure 9-14 shows a folder's contents viewed by kind, 
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• Figure 9-14 A folder's contents viewed by kind 

Coop's folder 
Name- Size- Kind Last Modifie-d 

~ Big Jim's SURVIVE! 12K application Thu, Apr 1 3, 1 989 11 :26 AM 

~ Cornbre-ad's Re-ve-nge- 12K application Thu, Apr 1 3, 1 989 11 :26 AM 

D Elvis sigMings lK App le-L ink 5.0 doc ... Tue- , oct 24, 1 989 3:57 PM 

~ Hype-rCard 390K application 'w'e-d, Fe-b 8,1989 4:09 PM 

~ Josh Ramsey's virus de-... 62K application Fri, Jan 13, 1989 12:11 PM 

~ Ope-ration Porkrind 12K application Thu, Apr 1 3, 1 989 11 :26 AM 

D Thad's Gre-ate-st Hits 19K Empty Library do ... Fri,Jan 19, 1990 2:22 PM 

D Font Sque-nche-r 2K F onUD A Move-r d ... Tue-, De-c 2, 1986 8:34 AM 

D Hoske-nFonts 123K FonUDA Move-r d ... 'w'e-d, Jan 1 7, 1 990 2:08 PM 

D Tuffy the- Toro 4K MacP aint docume-nt Thu, Jan 18, 1990 5:23 PM 

D Bustin' Be-n 2K Mac'w'rite- 4.6 doc ... Fri, De-c 8,1989 3:01 PM 

D Le-He-r to Mr. Marque-z 2K Mac'w'rite- 4.6 doc ... Fri, De-c 8, 1989 3:01 PM 

D Gabe- 's re-vie-w 3K Microsoft 'w'ord 4 ... Fri, De-c 8, 1989 10:47 AM 

D Inge-she-v 3K Microsoft 'w'ord 4 ... Fri, De-c 8, 1989 10:51 AM 

D PotatoLink discussions -- folde-r Thu,Fe-b 15, 1990 2:40 PM 

The Special menu 

The Special menu contains the commands you use to log out, shut down the lsystem, and 
restart the computer. It also provides commands that you use for special tasks, such as 
deleting the files that you placed in the Trash. Figure 9-15 shows the Special menu. 
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• Figure 9-15 The Special menu 

Clean Up 
Empty Trash 
Erase Disk 
Set Startup ... 

Restart 
Shut Down 

Logout 

Clean Up 

This command rearranges any selected icons on a disk or in a folder so that they are easier to 
see. You may use this command only when you are viewing the contents of a disk or folder by 
icon or by small icon. 

Empty Trash 

This command deletes any items you have placed in the Trash. Once you empty the Trash, the 
items are no longer recoverable. 

Erase Disk 

This command completely eradicates any information on the selected disk. To use this 
command, you must first highlight the name of the disk you wish to erase. 

Set Startup 

This command allows you to select any applications, desk accessories, and files that you wish 
to be automatically opened when you start up your A/UX system. 
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Restart 

This command shuts down the computer and starts it up again. You must enter the root user's 
password to use this command. 

ShutDown 

This command shuts down the computer. It does not run the A/DX shutdown program. You 
must enter the root user's password to use this command. 

Logout 

This command ends the current work session. When you choose this command, all open 
applications are closed, and you return to the Login dialog box. 

The CommandShell utility 

This section describes the commands to which you have access when you're working with the 
CommandShell utility. This utility is an application that presents a window interface you use 
to communicate instructions to the computer. You access the CommandShell utility by 
choosing it from the Apple menu. 

The CommandS hell File menu 

The CommandShell File menu contains the commands that manage the CommandShell window 
environment. Figure 9-16 shows the CommandS hell File menu. 
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• Figure 9-16 The CommandShell File menu 

New 
Open ... 
Close 
Saue Selection ... 

Saue Preferences 
H~~s1ore From Pn~tHP1H:e~ 

Page Setup ... 
Print Selection ... 

Close nil Windows 

New 

This command creates a new CommandShell window and places it on the desktop. The 
Command-key equivalent is COMMAND-N. 

Open 

This command displays a dialog box that allows you to open a selected file. The 
Command-key equivalent is COMMAND-O. 

Close 

This command closes the selected item. The Command-key equivalent is COMMAND-W. 

Save Selection 

This command displays a dialog box that allows you to save, under a name you specify, any 
text you select in a CommandS hell window. 
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Save Preferences 

This command saves any changes you have made to a CommandShell window. 

Restore From Preferences 

This command causes a CommandS hell window to revert to the state it was in when you last 
saved the preferences, providing you have made any changes since then. If you have not 
altered the window, the command is dimmed on the menu. 

Page Setup 

This command displays a dialog box allowing you to alter printer settings. 

Print Selection 

This command displays a dialog box that allows you to send to the printer any data you have 
selected in a CommandShell window. 

Close All Windows 

This command closes all CommandShell windows on the desktop. 

The CommandS hell Edit menu 

The CommandShell Edit menu, shown in Figure 9-17, contains the commands that you 
use to edit text in windows. In addition, you can also access the Commando utility from 
this menu. 
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• Figure 9-17 The CommandShell Edit menu 

t ut )01 
Copy ~C 

Paste ~u 

f h~!H' 
Select RII ~R 

Commando ~K 

Undo 

This command nullifies the last text editing or formatting change that you made. It does not 
nullify command execution. The Command-key equivalent is COMMAND-Z. 

Cut 

This command copies any selected text to the Clipboard and removes the text from the 
window. The text is stored in the Clipboard until it's replaced by text sent there as a result of 
another Cut or Copy command. The Command-key equivalent is COMMAND-X. 

Copy 

This command copies any selected text to the Clipboard but does not remove it from the 
window. The text is stored in the Clipboard until it's replaced by text sent there as a result of 
another Cut or Copy command. The Command-key equivalent is COMMAND-C. 

Paste 

This command inserts the contents of the Clipboard into the window, starting at the insertion 
point. The Command-key equivalent is COMMAND-V. 
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Clear 

This command removes any selected text from the window. Text removed with the Clear 
command is no longer available. Choosing Clear is equivalent to pressing the DELETE key. 

Select All 

This command selects all of the text in the window. The Command-key equivalent 
is COMMAND-A. 

Commando 

This command invokes the Commando command-line building utility. This is especially useful 
when you are creating a compound command line in a CommandShell window. The 
Command-key equivalent is COMMAND-K. 

The CommandShell Window menu 

The CommandShell Window menu contains the commands you use to manipulate and access 
CommandS hell windows. Figure 9-18 shows the CommandShell Window menu. 
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• Figure 9-18 CommandShell Window menu 
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Tile 

This command rearranges all windows on the desktop as shown in Figure 9-19. 
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• Figure 9-19 Tiled windows 
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The Command-key equivalent is COMMAND-T. 

Tile Horizontal 

This commands rearranges all windows on the desktop as shown in Figure 9-20. 

9-24 A/UX Essentials 
030-0759-A 



• Figure 9-20 Horizontally tiled windows 
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Tile Vertical 

This command rearranges all windows on the desktop as shown in Figure 9-21. 
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• Figure 9-21 Vertically tiled windows 
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Standard Positions 

This command rearranges all windows on the desktop as shown in Figure 9-22. 
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• Figure 9-22 Standard window positioning 
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This is the standard stacking arrangement of all CommandShell windows as they 
are created. 

Standard Size 

This command returns the active window to its standard size, provided it has been changed. 
The Command-key equivalent is COMMAND-S. 

Full Height 

This command changes the size of the active window so that it is as long as the screen will 
allow. The Command-key equivalent is COMMAND-F. 
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Zoom Window 

This command increases the size of the active window so that it is as large as the screen will 
allow. Choosing Zoom Window is equivalent to clicking the zoom box in the upper-right 
corner of the window. The Command-key equivalent is COMMAND-I. 

Hide Window-Title 

This command hides the active window from view. The window is not closed but merely 
hidden from view. All accessible CommandShell windows are listed at the bottom of the 
Window menu. The Command-key equivalent is COMMAND-H. 

Show All Windows 

This command displays all of the CommandShell windows listed at the bottom of the Window 
menu, including the A/UX System Console Window, which contains system messages about all 
of the currently running A/UX system processes. 

Last Window 

This command retrieves the last window you accessed before you activated the current 
window. The Command-key equivalent is COMMAND-L. 

Rotate Windows 

This command brings the rearmost window to the front each time the command is chosen 
from the menu. The Command-key equivalent is COMMAND-R. 

A/UX System Console 

This commands activates the A/UX System Console window, which contains system messages 
about all of the currently running A/UX system processes. The Command-key equivalent is 
COMMAND-O (zero). 
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Names of all accessible CommandS hell windows 

This is not a command, but a listing of all currently accessible CommandS hell windows. This list 
includes any hidden windows as well. Choosing a window name in the list activates 
that window. 

The CommandShell Fonts menu 

The CommandShell Fonts menu, shown in Figure 9-23, contains the list of available fonts that 
you can use in CommandS hell windows. Only monos paced fonts are supported in 
CommandShell. When you choose a font, all of the text in the window, not just the selected 
text, is displayed in that font. 

• Figure 9-23 The CommandShell Fonts menu 
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The CommandS hell Fonts menu also allows you to select point sizes, which determine the size 
of the text both as displayed on the screen and as printed. The smallest size is 9 point, and the 
largest is 36 point. 
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The CommandS hell Commands menu 

The CommandShell Commands menu allows you to change the environment within 
CommandShell windows. The CommandShell Commands menu is shown in Figure 9-24. 

• Figure 9-24 The CommandShell Commands menu 
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Don't Record Lines Off Top 

This command marks the window as the barrier for text entry. Any text exceeding the 
boundaries of the active window is not recorded and thus not accessible. When this command 
is active, the menu command reads Record Lines Off Top, which allows you to scroll through 
the window and access data. 

Clear Lines Off Top 

This command erases any information that scrolls off the top of a CommandS hell window. 

Redraw Screen 

This command redraws all of the pixels that make up the screen. You use this command if at 
some point a window is not completely redrawn. 
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The CommandS hell Preferences menu 

The CommandShell Preferences menu allows you to edit some of the properties of a 
CommandShell window. Figure 9-25 shows the CommandS hell Preferences menu. 

• Figure 9-25 The CommandShell Preferences menu 
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Notification Levels 

This command displays a dialog box that allows you to control how system messages are 
displayed when CommandShell is not the active application. 

New Window Settings 

This command displays a dialog box in which you set some of the default parameters, such as 
font and font size, for a new CommandShell window. 

Active Window Settings 

This command displays a dialog box that allows you to alter some of the properties 
of the active window, such as the name of the window. The Command-key equivalent 
is COMMAND-E. 
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The TextEditor application 

TextEditor is a word-processing application with which you create text documents 
using the mouse and Macintosh-like editing techniques. TextEditor is similar to the 
popular UNIX text-editing application vi, but it is much easier to use. 

The TextEditor File menu 

The TextEditor File menu, shown in Figure 9-26, contains the commands for creating, opening, 
printing, closing, and saving TextEditor files. 

• Figure 9-26 The TextEditor File menu 
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New 

This command creates a new document. When you choose New, you see the New dialog box, 
shown in Figure 9-27. In this dialog box, you to enter a name and select a folder location for 
the document to be stored. The Command-key equivalent is COMMAND-N. 
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• Figure 9-27 New dialog box 
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This command allows you to open documents created with TextEditor and any text-only 
file stored in the A/UX file system. When you choose Open, you see an Open dialog box that 
allows you to select any text file. The Command-key equivalent is COMMAND-a. 

• Note: If you try to open a document that's already open in another window, 
that window is brought to the front. Whenever you open a file, it appears in 
a new window. 

Close 

This command closes the active window. The Command-key equivalent is COMMAND-W. 

Chapter 9 A/UX Reference 9-33 
030-07S9-A 



Save 

This command saves the file in the active window under the file's current name, without 
closing the window. This menu item is dimmed if the contents of the window haven't been 
modified since the file was last saved. The Command-key equivalent is COMMAND-S. 

Save As 

This command displays a dialog box that allows you to make a copy of the currently active 
file, which you must then save under a different name. This action saves the current contents 
of the window as the Save as file, and allows you to continue editing the new file. The old file 
is closed without saving, under its original name. 

Save a Copy 

This command displays a dialog box that allows you to save the current state of the active 
window to a new file on a disk with the name Copy Of Filename. You can then continue 
editing the old file. 

Revert to Saved 

This command throws away any changes you have made since you last saved the file in the 
active window. This command is dimmed if the file has not been modified since you last 
saved it. 

Page Setup 

This command displays a dialog box that allows you to set parameters for printing a file. The 
standard Page Setup dialog box for the type of printer that you have selected in the Chooser is 
displayed. See the owner's guide that came with your Macintosh computer for more 
information about the Page Setup dialog box. 

Print Selection 

This command prints the entire contents of the active window. 
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Quit 

This command closes the TextEditor application and returns you to the Finder, first allowing 
you to save all open files. The Command-key equivalent is COMMAND-Q. 

The TextEditor Edit menu 

The TextEditor Edit menu, shown in Figure 9-28, contains a few special menu items in addition 
to the usual Macintosh editing commands. You use these commands to edit or change the 
contents of the active window. 

• Figure 9-28 The TextEditor Edit menu 
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Undo 

This command nullifies the last text editing or formatting change that you made. The 
Command-key equivalent is COMMAND-Z. 
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Cut 

This command copies any selected text to the Clipboard and removes the text from the 
window. The text is stored in the Clipboard until it's replaced by text sent there as a result of 
another Cut or Copy command. The Command-key equivalent is COMMAND-X. 

Copy 

This command copies any selected text to the Clipboard but does not remove it from the 
window. The text is stored in the Clipboard until it's replaced by text sent there as a result of 
another Cut or Copy command. The Command-key equivalent is COMMAND-C. 

Paste 

This command inserts the contents of the Clipboard into the window at the insertion point. 
The Command-key equivalent is COMMAND-V. 

Clear 

This command removes any selected text from the window. Once text is removed using 
the Clear command, it is no longer available. Choosing Clear is equivalent to pressing the 
DELETE key. 

Select All 

This command selects all of the text in the window. The Command-key equivalent is 
COMMAND-A. 

Show Clipboard 

This command displays the contents of the Clipboard in a separate window. 

9-36 A/UX Essentials 
030-0759-A 



Format 

This command displays a dialog box offering a selection of fonts and sizes that you can apply 
to text selected in a TextEditor window. Figure 9-29 shows the TextEditor Format dialog box. 

• Figure 9-29 The TextEditor Format dialog box 
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The Command-key equivalent is COMMAND-Y. 

• Note: All of the text in the active window, not just the current selection in that 
window, is shown in the selected font and font size. 

Align 

This command aligns any selected text with the top line of the selection. 

Shift Left 

This command moves any text that you select in a TextEditor window one tab stop to the 
left. The Command-key equivalent is COMMAND-L 
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Shift Right 

This command moves any text that you select in a TextEditor window one tab stop to the 
right. The Command-key equivalent is COMMAND-]. 

• Note: If you hold down the SHIFT key while choosing Shift Left or Shift Right, the 
selected text shifts by one space rather than by one tab. 

The TextEditor Find menu 

The TextEditor Find menu, shown in Figure 9-30, contains the commands for searching for and 
replacing text. 

• Figure 9-30 The TextEditor Find menu 
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Find 

This command displays the Find dialog box and finds the string that you specify. By default, 
the editor searches forward from the currently selected text in the active window (and does 
not wrap around). The Command-key equivalent is COMMAND-F. 
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Find Same 

This command repeats the last Find operation on the active window. The Command-key 
equivalent is COMMAND-G. 

Find Selection 

This command finds the next occurrence of the search string in the active window. The 
Command-key equivalent is COMMAND-H. 

Display Selection 

This command causes the currently selected text in the active window to scroll into view. 

Replace 

This command searches for a specified string throughout a file and replaces that string with a 
different string. The Command-key equivalent is COMMAND-R. 

Replace Same 

This command repeats the last Replace operation. The Command-key equivalent 
is COMMAND-T. 

The TextEditor Mark menu 

A marker is a portion of text that has been given a name. Markers are useful for navigating 
within a window, and they can simplify many search expressions. The upper part of the 
TextEditor Mark menu contains the commands Mark and Unmark, and the lower part lists all 
existing markers. To jump to the location of a marker, you simply choose the name of the 
marker you want from the TextEditor Mark menu, shown in Figure 9-31. 
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• Figure 9-31 TextEditor Mark menu 

Mark 

This command displays a dialog box that allows you to create a new marker within a 
TextEditor file. The Command-key equivalent is COMMAND-M. 

Unmark 

This command displays a dialog box that allows you to remove a marker from a 
TextEditor file. 

The TextEditor Window menu 

The TextEditor Window menu allows you to tile or stack any TextEditor windows on the 
desktop. The TextEditor Windows menu is shown in Figure 9-32. 

• Figure 9-32 The TextEditor Window menu 
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Tile Windows 

This command tiles any open windows as shown in Figure 9-19. 

Stack Windows 

This commands stacks any open windows as shown in Figure 9-22. 

List of open windows 

This is not a command, but a listing of all of the currently open TextEditor windows. A check 
mark appears next to the active window. 
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Chapter 10 Troubleshooting 

This chapter lists some common problems users encounter and gives some 
suggested remedies. This is by no means a complete list of all the problems 
that can arise. However, the chapter describes some useful techniques to 
try when you don't know what to do and you can't find an expert in the 
next office. 

This chapter contains the following sections: 

• Startup problems 

• Problems at login 

• The monitor screen is frozen 

• Handling A/UX System Console alerts 

• The printer does not respond 

• The icons have disappeared from the A/UX Finder 

• The bell sound is deactivated in CommandS hell 

• The console emulator appears upon login 

• A Macintosh application does not open 

• Not 32-bit clean 
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Startup problems 

This section lists some signs of trouble at startup and gives some remedies to try. 

The power doesn't go on 

If the computer fails to respond when you press the POWER ON key, follow these steps: 

1. Check to see that the power cord is properly plugged in to a power source 
and to the computer itseH. 

The computer may be plugged in to an outlet that has no power or to an extension 
power strip that has no power. 

2. H the power source is functioning, check the cable that connects the 
keyboard to the computer. 

Perhaps your keypress is not being sent to the computer. 

A floppy disk icon with a question mark appears 

This icon means that the system cannot find the boot disk. Try the following: 

1. Be sure that the external hard disk is turned on. 

2. Restart the computer (with the restart switch). The computer may not have 
recognized all your disks during startup. 

3. Be sure that the SCSI cables are connected properly and that the SCSI chain 
has been terminated properly. 

This is described in Setting Up Accounts and Peripherals for AlUX. 

4. Try reinstalling your Macintosh OS system software. 

See the installation manual that came with the software. 
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Problems at Login 

When you log in to the system, several error messages might appear. A few are listed here. 

Unknown user name 

The following message appears: 
Sorry, that user name is unknown. Please retype the name or contact 
the system administrator. 

Either you have typed your login name incorrectly or your login name has not been entered 
correctly in /etc/passwd. 

Try retyping you login name; be sure to duplicate the uppercase and lowercase of the name 
exactly. A/UX is case sensitive. 

If that doesn't help, contact your system administrator. 

Incorrect password 

The following message appears: 
Sorry, your password in incorrect. Please reenter it. 

When you reenter your password, be sure to duplicate the uppercase and lowercase of the 
password exactly. A/UX is case sensitive. 

If that doesn't help, contact your system administrator. 
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Inaccessible home directory 

The following message appears: 
Your horne directory, ----, is inaccessible. Perhaps that directory 
is on a file system which is not mounted. Please contact the system 
administrator. 

Contact your system administrator. 

The monitor screen is frozen 

If the screen doesn't respond while you are working in the Finder, and you can't log out or shut 
down, try the following: 

1. Check the connections between the mouse, the keyboard, and 
the computer. 

2. If these connections are in order, press COMMAND-CONTROL-E to redisplay the 
Login dialog box. 

You can then choose Restart or Shut Down from the Special menu. 

If you are working in a CommandShell window and the screen stops accepting input from the 
keyboard, try the following: 

1. Check the connections between the mouse, the keyboard, and 
the computer. 

2. Type stty sane and press CONTROL-J. 

Although the screen doesn't respond when you type stty sane, pressing CONTROL-J 
is equivalent to pressing RETURN and should force a line break. After the line breaks, 
your screen may respond normally. 

3. If the computer is still frozen, press COMMAND-CONTROL-E to redisplay the 
Login dialog box. You can then choose Restart or Shut Down from the 
Special menu. 
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Handling A/UX System Console alerts 

When the system alerts you of a problem, a message flashes on your screen. In order to read the 
message, you need to open CommandShell and display the A/UX System Console window. 
Follow these steps: 

1. If you are working in the A/UX Finder, you will see a diamond-shaped 
icon blinking alongside the CommandShell command in the Apple menu. 
Choose CommandS hell. 

2. When CommandS hell opens, choose A/UX System Console from the 
Windows menu. 

The A/UX System Console window appears and displays the warning message. 

For further information on the A/UX System Console window, see "Using the 
A/UX System Console" and "How the System Warns you of an Alert" in Chapter 5, 
"Using CommandShell." 

Typical A/UX System Console alerts 

Shutdown warning 

Normally, when the A/UX System Console displays an alert, it also gives directions for dealing 
with the situation. The most common alert concerns the immanent shutdown of the system. 

When planning to shut down the system for maintenance, the system administrator is 
prompted to broadcast a message warning users of the fact. This gives you time to save your 
files and to log out of the system, so that your work is not damaged. 

File system full 

If the message "File system full" is blinking on and off several times a minute, a process that is 
filling up the file system may be running. If you are running the process, stop the process and 
clear the space. If you are not the sole user and you are not running the process, see the system 
administrator. 
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The printer does not respond 

If the printer does not respond when you send a file to be printed, try the following: 

1. Check the cable between the printer and the computer. Be sure that the 
connectors have been plugged in to the correct ports. 

2. Check that the printer is turned on. 

3. Be sure that the printer has paper. 

The icons have disappeared from the A/UX Finder 

If the desktop becomes corrupted (one symptom is that the icons do not appear in 
the A/UX Finder), you can often repair it by rebuilding the desktop database. 

• Note: Rebuilding the desktop database might take 20 minutes or more. If you have 
other file systems mounted in addition to A/UX, it might save a lot of time if you 
unmount them before performing this operation. 

Rebuild the desktop database as follows: 

1. Choose Logout from the AlUX Finder's Special menu. 

2. When the Login dialog box reappears, type your login name and your 
password, and click Login. 

3. A window with the message Login session for (and your login name) 
appears. When that message disappears, leaving a blank screen, press 
COMMAND-OPTION. 

4. A dialog box appears, asking you whether you want to rebuild the desktop 
database. Click OK. 
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The bell sound is deactivated in CommandShell 

If the bell doesn't ring when it should, reactivate it as follows: 

1. Choose Control Panel in the Apple menu. 

2. Select the Sound icon at the left side of the Control Panel. 

You may have to scroll down to display the Sound icon. 

3. If the volume is turned too low, raise the indicator on the Speaker 
Volume bar. 

4. Click the close box. 

The Console Emulator appears upon login 

If you log in and the Console Emulator appears instead of the A/UX Finder, it 
may mean that somebody was using your user account and changed the session 
type to Console Emulator. 

1. At the command line, enter the following: mac32 

2. If you want to display the A!UX Finder for 24-bit addressed software, 
enter: mac24 

For further information on the Console Emulator, see Chapter 5, "Using CommandShell." For 
further information on 32-bit and 24-bit addressing, see "32-Bit Address Versus 24-Bit 
Address" in Chapter 1, "Starting and Finishing a Work Session." 
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A Macintosh application does not open 

If you are trying to use a Macintosh application, and it refuses to open or to 
respond properly, it may be that you do not have the proper file access permissions 
for the application. 

Follow the directions for checking permissions given in "Checking a File's Permissions" in 
Chapter 2, "Getting Around in A/UX." 

If you do not have read permission for the application, you will not be able to open it. 

If necessary, change the permissions. See "Changing File Access Permissions" in Chapter 2, 
"Getting Around in A/UX." 

Not 32-bit clean 

There is a dialog box that warns you that the application you are about to use may not be 
32-bit clean. If it appears whenever you start an application that you know works well under 
A/UX 2.0, you can turn off the dialog box by using the changesize script. You must have 
write permission to this script. You must either be logged in as root or must have the system 
administrator change your permissions. 

Run the changesize script as follows: 

1. Open the /mac/bin folder (by double-clicking the / icon, then the mac icon, 
then the bin icon). 

2. Double-click the changesize icon. 

The Commando dialog box shown in Figure 10-1 appears. 
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• Figure 10-1 The changesize dialog box 
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3. Select "SIZE flags" at the middle right of the dialog box. 

The dialog box shown in Figure 10-2 appears, 
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• Figure 10-2 The SIZE Flags dialog box 
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4. Select "Set flag" in the 32-bit Clean box. 

5. Click Continue. 

The original changesize dialog box reappears. 

6. Select "Choose application." 

7. When the list of available fdes appears, select the application you 
plan to use. 

8. Click changesize. 
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Chapter 11 Where to Go From Here 

Congratulations! You now know the basics of the A/UX 2.0 operating 
system. This chapter presents a brief overview of the places you might 
look to learn more about A/UX and your Macintosh computer. This chapter 
contains the following sections: 

• Finding resource materials 

• Learning more about your Macintosh computer 

• Learning more about system administration 

• Learning more about commands 

• Learning about creating, formatting, and printing documents 

• Learning about developing in the A/UX environment 

You can read the entire chapter to familiarize yourself with all of the 
available resources materials, or you can read the section that directs you 
to material that you need immediately. 
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Finding resource materials 

Apple Computer, Inc. provides a variety of reference material to help you use your computer 
and its operating systems. You can find information in the places listed here: 

• A/ux Accessory Kit 

This kit contains the four guides necessary to install and configure A/UX, to use it, 
and to learn about the system and its documentation. It comes with the operating 
system software. 

• Macintosh Accessory Kit 

This kit contains the system software and guides necessary to set up, configure, and 
use a Macintosh computer. The kit comes with the computer. 

• A/ux User's Documentation Suite 

This suite is available in several different bundles addressing the needs of 
specific users. You can purchase this suite through your authorized A/UX 
dealer or representative. 

This includes the following bundles: 

D user's documentation bundle 

D system administrator's documentation bundle 

D programmer's documentation bundle 

For a complete list of the guides contained in each of these bundles, see Road Map to AlUX 

• Apple Technical Library 

This set of books describes the hardware and software of the Macintosh family of 
computers. The books are official technical publications from Apple Computer, Inc., 
and are published by Addison-Wesley Publishing Company. You can find these books 
in most well-stocked bookstores. 
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Learning more about your Macintosh computer 

To learn more about your Macintosh computer and the Macintosh as, see the set of books 
that came with it. The owner's guides describe the computer, the Macintosh as, and 
Macintosh utilities and programs. The guides also show you how to accomplish tasks with the 
Macintosh computer. In most cases, Macintosh applications and utilities work similarly in 
A/UX. For more in-depth explanation of such features as the Finder, the Control Panel, or care 
of your computer, see the Macintosh owner's guide. 

Learning more about system administration 

To help you learn about system administration tasks, Apple Computer, Inc. provides 
several guides. 

• Setting Up Accounts and Peripherals for A/UX 

This book describes how to add user accounts and peripheral devices, such as 
printers and additional hard disks, to an A/UX system. It includes a section on 
adding a computer to an existing network using the built-in AppleTalk facility or a 
compatible communications card. 

This guide comes with the A/UX software in the A/UX Accessory Kit. 

• A/UX Local System Administration 

This book describes the duties of the administrator of a single A/UX system. 
It includes information on making backups of files and maintaining a healthy 
file system. 
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• A/UX Network System Administration 

This book describes how to set up and maintain a simple network. It includes a 
discussion of TCP/IP software utilities, Yellow Pages services, and Network File 
Services (NFSTM). It also contains information on how to print using the AppleTalk 
network and AppleTalk protocol. 

• A/UX System Administrator's Reference 

This reference manual contains an entry for each system administration 
command. Each entry gives the command name, describes the syntax, lists 
the associated files, and provides cross-references. This reference includes a 
section of entries for device drivers and device interfaces and a section of 
entries for system-maintenance procedures. 

These guides are available in the System Administrator's Documentation bundle. 

Learning more about commands 

To learn about commands you have several resources. 

• Type commandname COMMAND-K in a CommandShell window. 

In response, the computer displays a Commando dialog box that describes available 
options and demonstrates the correct command syntax. For further information on 
Commando, see Chapter 4, "Using Commando." 

• Enter man commandname in a CommandShell window. 

In response, the computer displays the reference manual page that describes the 
command in detail. You can read through the entire description or find only the 
options that you need. Each manual entry presents an example of the correct syntax. 
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• A/UX Command Reference 
Section l(A-L) 

This reference manual contains an entry for each user command beginning with the 
letters A through L. Each entry lists the command name, describes the syntax, and 
lists the associated files and commands. 

• A/UX Command Reference 
Section 1 (M-Z) and 6 

This reference manual contains an entry for each user command beginning with the 
letters M through Z. Each entry lists the command name, describes the syntax, and 
lists the associated files and commands. This manual also includes similar entries 
about the game programs included in A/UX 2.0. 

• A/UX Reference Summary and Index 

This guide catalogs the other reference manuals in three ways. It presents a list of all 
A/UX commands by function, synopses of all A/UX commands organized 
alphabetically, and a keyword index of all the command reference entries. The 
command synopses and list of commands by function lead you to the information in 
A!UX Command Reference and A!UX System Administrator's Reference. The index 
serves all volumes. 

These guides are available in the programmer's documentation bundle. 

Learning about creating, formatting, and printing documents 

To learn about using the A/UX text-processing and text-formatting tools see the guides 
listed here. 

• A/UX Text Editing Tools 

This book describes the editing tools provided with A/UX. It contains detailed 
instructions and sample sessions for using vi, ex, ed, and sed. 
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• A/UX Text Processing Tools 

This book describes the text-formatting tools that make up AT&T's Documentor's 
Workbench (DWB) , version 2.0. It also describes other text-processing tools that 
come with A/UX, such as grap and TranScriptTM. 

These guides are available in the user's documentation bundle. 

To find out more about using Macintosh applications to write, design, layout, and print 
documents, see the guides that come with each application. 

To learn about printing documents with A/UX tools you can consult several guides. 

• Setting Up Accounts and Peripherals for A/UX 

This book describes how to set up a printer. It comes with the A/UX software in the 
A/UX Accessory Kit. 

• A/UX Network System Administration 

This book describes how to set up and maintain a simple network. It includes a 
discussion of using Tep /IP software utilities, Yellow Pages services, and Network 
File Services (NFS). It also includes information on how to print using the AppleTalk 
network and the AppleTalk protocol. 

• A/UX Local System Administration 

This book describes the duties of an administrator of a single A/UX system. It 
includes information on setting up and configuring the kernel for peripheral devices, 
such as printers. 

These guides are available in the system administrator's documentation bundle. 

• A/UX User Interface 

This book describes the Bourne, C, and Korn shell programs distributed with 
A/UX. You use the shell language to communicate with the operating system to 
accomplish tasks. 

This guide is available in the user's documentation bundle. 
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Learning about developing in the A/UX environment 

To find out about development platforms and tools, see these guides: 

• A/UX Toolbox: Macintosh ROM Interface 

This book describes what the A/UX Toolbox is, how to use the A/UX Toolbox 
to implement the Macintosh user interface on applications that run under the 
A/UX operating system, and how to port existing Macintosh applications to A/UX. 

• A/UX Programming Languages and Tools, Volumes 1 and 2 

These books describe the programming languages, their accompanying subroutine 
libraries, the utility programs, the compilers, and the associated program-generating 
tools provided with A/UX. 

• A/UX Programmer's Reference, Volumes 1 and 2 

These reference manuals contains information for programmers. These 
manuals consists of entries for system calls, subroutines, file formats, and 
miscellaneous facilities. 

These guides are available in the programmer's documentation bundle. 

• Building A/UX Device Drivers 

This book describes how to build A/UX device drivers and how peripheral devices 
interact with A/UX. This book is available from APDATM as part of the kit called 
A/UX Device Drivers Kit. 

• A/UX Network Applications Programming 

This book describes the A/UX programming interfaces for the programmer who 
wishes to write network applications based on AppleTalk, Network File Services 
(NFS), Yellow Pages, and Internet software. This book is available from APDA. 
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Glossary 

A/ux Startup: The Macintosh 
application that launches A/UX. If you 
cancel the automatic launch of A/UX, you 
are in MacPartition from which you can 
run some system administration 
commands. 

absolute pathname: The complete name 
of a file, given by listing all of the 
directories leading down to that file, 
starting from root (/) and concluding 
with the filename itself. The directories 
leading to the file are separated from each 
other and from the filename by slashes. 
For example, / etc/passwd is the 
absolute pathname of the system 
password file, passwd, located in the et c 

directory beneath the root (I) directory. 

access class: A designation for access 
permissions to A/UX files and directories; 
the three access classes are user, group, 
and others. The user, or owner, is the 
person who created the file; the group 
consists of people, including the owner, 
who typically work together and need to 
share files easily; the others class consists 
of all people using a local system. A file or 
directory can be set to have different 
access permissions for each class. 

active window: The frontmost window 
on the desktop; the window where the 
next action will take place. An active 
window's title bar is highlighted. 

algorithm: A step-by-step procedure for 
accomplishing a task or solving a 
problem. 

alias: An alternate name used to invoke or 
identify a command, a network host, a 
list of users, or some other applicable 
entity. 

Apple Desktop Bus (ADB): A low
speed, input -only serial bus that connects 
the keyboard, mouse, and optional input 
devices to the system bus. 

application: A program used to perform a 
particular task, such as computer-aided 
drawing, document preparation, 
accounting, or payroll management. 

archive: (1) A collection of files, plus a 
table of contents. Archives are used 
mainly as libraries to be searched by the 
link editor 1 d. (2) Any collection· of files 
saved simultaneously for backup 
purposes. 
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argument: A piece of information 
included on the command line in addition 
to the command; the shell passes this 
information to the command, which then 
modifies its execution in some particular 
way. Filenames, for example, are often 
supplied as arguments to commands, so 
that a command will operate on the 
named file. 

argument list: All of the arguments 
passed to a program. 

ARPANET: A wide area network that links 
government, academic, and industrial 
installations around the world. Primarily 
connecting research sites, the ARPANET 
was developed in the 1960s by the 
Advanced Research Projects Agency of 
the U.S. Department of Defense. See also 
Defense Data Network. 

ASCII text fde: See text fde. 

assembly code: A source file written in a 
low-level programming language that 
corresponds to a specific computer's 
binary machine language. 

asynchronous communication: A 
method of data transmission in which the 
receiving and sending devices don't share 
a timer and no timing data is transmitted. 
See also synchronous communication. 

GL-2 A/UX Essentials 
030-07S9-A 

asynchronous I/O: The capability to 
perform an I/O operation while its calling 
process continues to run. With 
synchronous I/O, the calling process 
sleeps until the I/O operation is finished. 

autoconfiguration: An A/UX facility that 
automatically configures device drivers 
into the kernel upon system startup. 

auto recovery: An A/UX facility that 
automatically repairs damaged file 
systems and rebuilds a good system if at 
all possible. 

A!UX command: The name of an 
executable file distributed with the A/UX 
operating system. For example, 1 s is a 
binary executable distributed in the I bin 

directory that prints directory 
information to the terminal; typing 
Ibinl Is as a command causes the file to 
execute. See also shell program, built-in 
shell command. 

A/UX Toolbox: Libraries, subroutines, 
and utilities that provide access from 
A/UX to the Macintosh Operating System 
and to the Macintosh User Interface 
Toolbox in the Macintosh II or IIX ROM. 



background job: A process executed by 
the shell such that the shell is not 
suspended while waiting for the process 
to finish. By default, a process starts in 
the foreground, and the shell waits until 
the process has finished executing before 
the shell returns its prompt. You run a 
process in the background by appending 
an ampersand character (&) to the end of 
a command line; the shell prompt 
reappears instantly, allowing you to run 
multiple processes simultaneously. See 
also foreground job. 

backslash: The character \, often used as 
an escape character. 

bang: The exclamation point (0, used as 
a syntactic element by the C shell, by 
uucp, and by other utilities. 

baud rate: The measure of the signal 
changes per second sent over a 
transmission line. This usually corresponds 
to the total number of bits per second 
sent over the line. 

Berkeley Software Distribution (BSD): 
A version of the UNIX operating system 
developed at the University of California 
at Berkeley. The A/UX operating system 
incorporates many of the features of 
4.2 BSD. 

binary ftle: A file, such as a machine 
language program, whose data is to be 
interpreted in binary form. See also 
text ftle. 

bit map: (1) A set of bits that represents 
the state of a corresponding set of items. 
(2) In QUickDraw™, a pointer to a bit 
image, the row width of that image, and 
its boundary rectangle. 

block: A group regarded as a unit; usually 
refers to data, or to memory in which data 
is stored. 

block device: A secondary storage 
device, such as a disk or tape drive, from 
which a file system can be mounted. 

block I/O: The transfer of data that 
consists of chunks of contiguous 
information. By default, block I/O 
consists of l024-byte chunks under A/UX. 
See also character I/O. 

B-NET: The A/UX implementation of the 
Tep /IP protocols and utilities. 

boot: To start an operating system by 
loading it into the computer's memory. 

boot block: The first block of a file 
system. The boot block contains the 
system's startup instructions. 

boot device: The peripheral device that 
reads an operating system's initial startup 
instructions. 

boot disk: The disk that contains the 
initial startup instructions for an 
operating system. 

Bourne shell: The standard UNIX System 
V command interpreter. See also shell. 
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bridge: An intelligent link between two or 
more networks, especially those 
employing the same media or protocols. 
See also gateway. 

BSD: See Berkeley Software 
Distribution. 

buffer cache: A holding area in main 
memory where read and write information 
for block I/O is temporarily stored. 

built-in shell command: A command 
written into the shell itself rather than in a 
separate executable file. Built-in shell 
commands are generally used for writing 
shell scripts. 

button: A pushbutton-like image in 
dialog boxes where you click to 
designate, confirm, or cancel an action. 

c: A portable, high-level language that 
also offers very low-level operations, 
making it a flexible and efficient language 
for both application and system 
programming. A/UX itself is written 
almost entirely in C. 

canonical: Adhering to standard, 
accepted, or authoritative procedures or 
principles. 

carriage return: See newline. 
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case sensitive: Able to distinguish 
between uppercase characters and 
lowercase characters. Programming 
languages are case sensitive if they require 
all uppercase letters, all lowercase letters, 
or proper use of uppercase and lowercase. 
For example, Applesoft BASIC recognizes 
only uppercase. Instant Pascal, however, 
is not case sensitive; you can use any 
combination of uppercase and lowercase 
letters you like. 

central processing unit (CPU): The 
"brain" of the computer; the 
microprocessor that performs the actual 
computations in machine language. 

character device: Any device other than 
a block device. Character devices include 
terminals, modems, and network 
interfaces. 

character I/O: The transfer of data one 
character at a time, rather than in blocks 
of characters. See also block I/O. 

check boxes: A small box associated 
with an option in a dialog box. When you 
click the check box, you may change the 
option or affect related options. 

checksum: The result of an arithmetic 
operation on a set of data; for example, 
the sum of bytes in a file. A checksum is 
used to help verify the integrity of data 
through stages of processing. 



child process: A copy of a process, 
submitted for execution by another 
process. The original process is called the 
parent process, and the child is created 
by the system call for k. 

choose: To pick a command by dragging 
through a menu. You often choose a 
command after you've selected 
something for the program to act on; for 
example, selecting a disk and choosing 
the Open command from the File menu. 

click: (v.) To position the pointer on 
something, and then press and quickly 
release the mouse button. (n.) The act of 
clicking. 

client: A computer that has access to 
services on a network. The computers 
that provide services are called servers. 
A user at a client may request file access, 
remote login, file transfer, printing, or 
other available services from servers. 
In X window system, a client is a program. 

close box: The small white box on the 
left side of the title bar of an active 
window. Clicking it closes the window. 

coaxial cable: A cable consisting of two 
concentric conductors: an inner wire and 
an outer, braided sleeve. 

command interface: The convention for 
interacting with A/UX by entering a 
command line. 

command line: The entire input string 
that you enter in response to the shell 
prompt to issue a command or to start a 
program. The command line includes the 
command itself and any arguments and 
flag options. 

command mode: The operating state in 
which a program (such as a text editor) 
interprets the characters you type as 
commands, rather than as data to be 
entered into a file. 

Commando: A command-building tool in 
A/UX 2.0 that displays a dialog box for 
UNIX and A/UX commands. This allows 
you to select the option flags you want 
without having to use the command line 
interface. Commandso also allows you to 
pipe commands. 

CommandS hell: An A/UX 2.0 application 
that displays a window for using the 
command line interface. You can 
manipulate CommandShell windows just 
as you do Macintosh windows. 

comment: Information that is ignored by 
a program such as a compiler. A comment 
normally includes instructions, references, 
or notes for people inspecting a source 
file. 
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Common Object File Format (COFF): 
The output file produced on A/UX 
systems by the assembler (as) and the 
link editor (ld). The term "common" 
refers to how this format is used on a 
number of processors and operating 
systems, including A/UX. 

concurrent processing: The ability of 
an operating system to execute multiple 
programs simultaneously. 

console: The main terminal (that is, 
keyboard and screen) of your system. The 
console must be connected to your 
system. The console receives log and error 
messages from the operating system that 
are not sent to any other terminal. 

control character: A nonprinting 
character that orders an action to be 
performed. For example, the interrupt 
character (by default, entered by holding 
down CONTROL and pressing C) interrupts 
a program's execution and returns you to 
the shell prompt. 

cooked input: Data that has been 
processed by a terminal driver's line 
discipline. Special characters such as the 
erase and kill characters cause the line 
discipline to convert the raw data 
accordingly. 
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cooked mode: A terminal driver's 
method of operation that converts data 
sent from the keyboard or to the terminal 
screen. This conversion is performed by a 
line discipline to accommodate 
interactive use of the system. For 
example, an erase character sent from the 
keyboard causes the line discipline to 
delete the preceding character; the 
terminal driver then sends the converted 
data to the reading process. See also 
raw mode. 

C shell: The standard BSD and A/UX 
command interpreter. See also shell. 

current directory: The last directory into 
which you moved with the cd command; 
this directory is the starting reference 
point for all relative pathnames you 
enter. Also called the working directory. 

cursor: A symbol on the screen that 
indicates your position on the command 
line or inside a file. The cursor is usually a 
small box or an underscore, and it usually 
blinks. 

daemon: A noninteractive process that 
manages services. Network daemons, for 
example, automatically handle incoming 
network connection requests. 

data bits: Data communications bits that 
encode transmitted characters or 
numbers. 

DDN: See Defense Data Network. 



decrement: In programming, to decrease 
the value of a variable used as a counter. 
See also increment. 

Defense Data Network: A single, wide 
area, packet-switching network that 
integrates the ARPANET research network 
and the MILNET defense network. 

demand memory paging: An A/UX 
facility that allows the kernel to use 
secondary storage (usually a hard disk) to 
store inactive portions of processes while 
main memory holds active portions. 

demon: See daemon. 

demount: See unmount. 

dereference: In programming, to obtain a 
value referenced by a pointer. 

device: A part of the computer, or a piece 
of external equipment, that can transfer 
information. 

device driver: Kernel-level software that 
controls the exchange of information 
between a process and a device. 

device ftle: A file that represents a 
device. For example, an A/UX process 
reading from or writing to the device file 
/ dev / rfloppyO is actually reading from 
or writing to the first 3.5-inch disk drive 
on the Macintosh II. Also called 
special file. 

device number: A number that contains 
both the major number and the minor 
number of a device. See major number 
and minor number. 

device switch: A data structure 
composed of the addresses of routines 
that manage I/O for a device. 

dialog: In reference to the Macintosh user 
interface, this is the same as dialog box. 

dialog box: A box that contains a 
message requesting more information 
from you. Sometimes the message warns 
you that you're asking your computer to 
do something it can't do or that you're 
about to destroy some of your 
information. In these cases, the message 
is often accompanied by a beep. 

directory: A file that contains a list of 
other files; similar to a folder in a 
Macintosh hierarchical file system. 

directory hierarchy: The collection of all 
files on the currently mounted file 
systems. See also hierarchy. 

Documentor's Workbench (DWB): A 
group of utilities used for formatting 
files. Files formatted by DWB utilities can 
be printed on a wide variety of output 
devices. 
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dot fUe: A file whose filename begins with 
a period. UNIX reads these files for 
specific information concerning login and 
configuration of the environment, the 
shell, etc. 

double click: (n.) Two mouse clicks in 
quick succession, interpreted as a single 
command. The action of a double click is 
different from that of a single click: for 
example, clicking an icon selects the icon; 
double-clicking an icon opens it. 

double-click: (v.) To position the 
pointer where you want an action to take 
place, and then press and release the 
mouse button twice in quick succession 
without moving the mouse. 

drag: To position the pointer on 
something, press and hold the mouse 
button, move the mouse, and release the 
mouse button. When you release the 
mouse button, you either confirm a 
selection or move an object to a new 
location. 

DWB: See Documentor's Workbench. 

effective user 10: One of two user IDs 
associated by the kernel with a process 
(see also real user ID). When necessary 
for execution, the effective user ID for a 
process can be changed by programs to 
temporarily allow different permissions. 

. After completing the task that required 
the different permissions, the effective 
user ID is set back to its original 
permissions. See also user ID. 
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end-of-fue (EOF): Under A/UX, the 
position of one byte past the last byte in 
a file; this is equal to the actual number of 
bytes in the file and is also known as the 
logical end-of file. If a program calls a 
routine that uses the physical end-of-file 
convention, the logical end-of-file is used 
instead. 

environment: A list of characteristics 
that identifies you to the system and 
influences and constrains your access to 
it. You can modify many of these 
characteristics. See environment variable. 

environment variable: A characteristic 
controlling your use and access of the 
system that is available to the current shell 
and all of the child processes invoked 
from that shell. See also shell variable. 

EOF: See end-of-fue. 

erase character: The keyboard character 
that, when pressed, erases the last 
character you typed. By default, this 
character is entered by pressing the 
DELETE key. 

escape character: A character that 
causes a program to interpret the 
following character or characters in a 
special way. For the nroff and troff 

utilities, for example, the escape 
character is a backslash (\), a nonprinting 
character that allows you to insert a 
command in a line of text. 



Ethernet: A standard network 
communications specification generally 
using a type of coaxial cable to connect 
computers in a local area network. The 
Ethernet specification was developed by 
Digital Equipment Corporation, Intel 
Corporation, and Xerox Corporation. 

exec: A system call and a built-in shell 
command that loads a program file and 
execute it by overlaying the address space 
of the calling process. 

export: (1) To pass the value of a shell 
variable to a child process. (2) To make 
local file systems available to remote 
users. 

export: The built-in shell command for 
the Korn or Bourne shell that passes the 
values of shell variables to child processes. 

field: A data item separated from other 
data by blanks, tabs, or other specific 
delimiters. 

fde: For UNIX operating systems, an array 
of bytes; no other structure is implied by 
UNIX systems, which even treat peripheral 
devices like files. 

fde descriptor: A number used to 
identify a file. 

fde handling system: The set of data 
structures, commands, and subroutines 
used to manipulate files and data stored 
on physical devices. 

fde mode: See permissions. 

fdename: On UNIX System V operating 
systems, the name of a file, consisting of 
up to 14 characters and specified without 
listing the directory under which the file is 
located. For example, passwd is the 
filename for the system password file. See 
also pathname. 

fdename expansion: A procedure 
performed by the shell that derives a list 
of files from a single, shorthand filename 
containing metacharacters. Also called 
globbing. 

fde system: A logical device (such as a 
disk partition) that contains the data 
structures that implement all or part of the 
directory hierarchy. 

fdter: A utility that transforms its input in 
some way and writes this transformed 
data to the standard output. Lines 
submitted as input to the so r t 

command, for example, are reordered so 
that the lines in the output are arranged 
alphabetically or numerically. 

Finder: The application that maintains 
the Macintosh desktop and starts up 
other programs at the request of the user. 
You use it to manage documents and 
applications, and to get information to 
and from disks. It's the desktop you see 
upon starting up your computer, unless 
you have specified a different startup 
application. 
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flag option: An argument included on the 
command line that instructs a program to 
alter its output or to change its mode of 
execution. A flag option is usually a 
hyphen followed by one or more 
characters. For example, the -1 flag 
option to the 1 s command makes this 
utility print extra information, such as the 
date a file was last saved. Flag options are 
sometimes referred to as keyletters. 

floating-point notation: A method of 
representing numbers inside the computer 
by which the decimal point (or more 
correctly, the binary point) is permitted 
to "float" to different positions within 
the number. Some of the bits within the 
number itself are used to keep track of 
the point's position. This method is useful 
for quickly calculating complex 
mathematical operations. 

folder: (1) For the BSD mai1x program, a 
file that you create for saving similar mail 
messages. (2) A holder of documents and 
applications on the Macintosh desktop. 
Macintosh folders, like UNIX file system 
directories, allow you to organize 
information in a hierarchical fashion. 

font: A collection of print characters 
unified by a distinctive look. Times 
Roman, for example, is the default font 
for troff. 
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foreground job: The process attached to 
the terminal. The shell waits until the 
foreground job has finished executing 
before the shell returns its prompt and 
gives you control again of the terminal. 
See also background job. 

fork: (n.) One of the two parts of a 
Macintosh file; the data fork contains 
data accessed via the Macintosh File 
Manager, and the resource fork contains 
data used by the application, such as 
menus, fonts, and icons. (v.) To create a 
new process with the for k system call. 

fork: A system call that creates a new 
process. 

format: (1) To divide a disk into tracks 
and sectors where information can be 
stored. Blank disks must be formatted 
before you can save information on them. 
(2) To process a text file for output with a 
utility such as nroff or troff. See also 
formatter. 

formatter: A utility that processes text 
for output to a device. The nroff and 
t ro f f utilities, for example, are 
formatters that justify the margins, center 
the titles, number the pages, and perform 
other enhancements that improve the 
printed appearance of text files. 

Fortran-77: A high-level programming 
language especially useful for 
mathematical and scientific applications. 



frame: The time elapsed from the start bit 
to the last stop bit during serial 
communication. 

full-duplex communication: A method 
of data transmission where two devices 
transmit data simultaneously. 

full pathname: See absolute pathname. 

function: A subroutine-that is, a 
preprogrammed calculation-that can be 
carried out on request from any point in a 
program. 

gateway: A computer that connects two 
or more networks, especially those using 
different media or protocols. See also 
bridge. 

GID: See group ID. 

globbing: See ftlename expansion. 

group ID (GID): A number that indicates 
a group to which you belong at login time. 
As a member of a group, you have access 
to certain files and directories shared by 
other members of your group. Each user 
login name has at least one group ID 
associated with it. 

group permission: Permission for the 
designated group of users to use a file or a 
directory. 

header ftle: A file whose contents will be 
included with the source file at compile 
time-it contains function declarations, 
macros, types, and defines used by the 
compiler. Also called include file. 

here document: Input to a shell script 
command that is embedded inside the 
script itself. 

Hierarchical File System (HFS): A 
method of organization in which disk 
files are grouped together within 
directories and subdirectories (folders 
within folders). HFS is used on hard disks 
and on BOOK disks. In a hierarchical file 
system, a file is specified by its 
pathname, rather than by a single 
filename. 

hierarchy: A directory and any files or 
subdirectories residing under it. See also 
directory hierarchy. 

highlight: To make something visually 
distinct. For example, when you select a 
block of text using MacWrite, the 
selected text is highlighted-it appears as 
light letters on a dark background, rather 
than dark-on-light. 

home directory: The directory named by 
your environment variable $HOME. The 
home directory is usually the first 
directory you enter upon login, as 
designated in the file /etc/passwd. You 
can tailor your environment by modifying 
various files in your home directory. 
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home directory folder: The folder that 
represents the user's home directory on 
the A/UX Finder. 

host: A computer connected to a 
network. 

icon: An image that graphically represents 
an object, a concept, or a message. 

include ftIe: See header ftIe. 

increment: In programming, to increase 
the value of a variable used as a counter. 
See also decrement. 

inode: A data structure that defines a file 
by describing the disk layout of the file 
data, its permissions, and its access 
times. 

input mode: See insert mode. 

insert mode: The state whereby a 
program (such as a text editor) accepts 
the characters you type as data rather 
than as commands. Also called 
input mode. 

interactive editor: A utility for entering 
and manipulating text while you view the 
text. TextEditor and v i are both 
interactive. See also stream editor. 
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interactive program: A program that 
allows you to enter additional commands 
and data during its execution instead of 
making you enter all of your commands 
and data as flag options and arguments on 
the command line. The vi and mail 

utilities are examples of interactive 
programs. 

International Standards Organization 
(ISO): A standards organization 
composed of representatives from the 
national standards bodies of 63 member· 
countries. This organization has 
developed standards for pin assignments 
in data communication plugs, has 
promulgated the layered model of 
communications protocols, and has 
specified and approved protocols for 
many of the layers in the layered model. 

internet: (1) A group of networks 
interconnected by bridges or gateways. 
(2) The Internet, used as a proper noun, 
usually refers to the Tep lIP-based 
Defense Data Network (DDN), 
descendent of the DARPA (Defense 
Advanced Research Projects Agency) 
Internet (also called the ARPANET). (3) 
When the proper noun is used as an 
adjective (for example, Internet domain) 
this refers to a networking standard used 
by the DDN. 



internet address: An address for a 
computer on a network. The internet 
address consists of a network number and 
a host number that is unique for that 
network. 

interprocess communication: A 
mechanism for transmitting information 
between processes. Interprocess 
communication mechanisms supported 
by A/UX include semaphores, messages, 
shared memory, signals, and sockets. 

interrupt: An exception signaled to the 
processor by a device or by software to 
notify the processor of a change in 
condition; for example, an interrupt is 
signaled at the completion of an I/O 
request. 

interrupt character: The keyboard 
character that, when pressed, interrupts 
execution of a program and returns you to 
the shell prompt. By default, CONTROL-C is 
the A/UX interrupt character (issued by 
holding down CONTROL while pressing C). 

interrupt handler: A routine that services 
interrupts. 

interrupt priority level: A number 
identifying the importance of the 
interrupt. It indicates which device is 
interrupting and which interrupt handler 
should be executed. 

interrupt vector: A pointer to an 
interrupt handler. 

i-number: The offset of a particular 
inode within the i-list. 

I/O redirection: See redirection. 

I/O request: A request for input from or 
output to a file or a device. 

ISO: See International Standards 
Organization. 

job: A process that can be stopped, 
restarted, and moved between 
foreground and background processing 
from the C shell. 

job number: The identification number 
of a process executed in the background 
under the C shell. The job number appears 
next to the command name when you 
execute the job s command. 

Kermit: A remote terminal and file
transfer software program used for 
connecting microcomputers and 
mainframe computers across modems 
and serial lines. 

kernel: A UNIX program that manages the 
system hardware. For example, the kernel 
manages files, communicates with 
peripherals, and handles other low-level 
resource management tasks. 

keyletter: See flag option. 
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kill character: The keyboard character 
that, when pressed, erases the current 
command line from the shell. After you 
press the line kill character, the cursor 
moves to a new line, and you can enter a 
new command. CONTROL-U is the A/UX 
default kill character (issued by holding 
CONTROL down while pressing U). 

Korn shell: A command interpreter that 
combines many of the best features 
found in the standard System V shell (the 
Bourne shell) and the standard BSD shell 
(the C shell). See also shell. 

LAN: See Local Area Network. 

library: A collection of related functions 
or declarations available to a program for 
linking at compile time. 

line editor: A utility for entering and 
manipulating text. The commands to add 
or change text are entered from a 
command prompt, they only operate on 
the lines you specify, and you cannot 
always see the results of your changes right 
away. The ed and ex utilities are line 
editors. See also screen editor. 

link: (1) To give an alternative name to a 
file. See also unlink. (2) In programming, 
to collect one or more routines into an 
executable program. 

list: To display on a monitor, or print on a 
printer, the contents of memory or of a 
file. 
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local area network (LAN): A group of 
computers connected for the purpose of 
sharing resources. The computers on a 
LAN are typically joined by a single 
transmission cable, and are located within 
a small area such as a single building or 
section of a building. 

local system: The computer from which 
a user originates a network command. See 
also remote system. 

local system administration: 
Management of a single computer. This 
includes such functions as starting up and 
shutting down the system, adding and 
removing user accounts, and backing up 
and restoring data. See also network 
administration. 

logical disk: A disk partition that is 
treated by the operating system as a 
separate disk. See also partition. 

log in: To identify yourself to the system 
by entering the login name of your 
account and your account password. 

login name: The name of a user's 
account. Used for identification 
purposes. 

login prompt: The prompt (usually 
login: on UNIX systems) by which a 
system tells you that it is ready to accept 
your login name. 



login shell: The shell that automatically 
runs after you successfully log in. See also 
shell. 

long listing (Is -1): A listing of the 
files in a directory. This is called a long 
listing because it lists more information 
than a simple listing, including the 
permissions, the size of each file, owner, 
the number of links, and the date on 
which the file was last modified. 

Ipr system: A collection of programs 
and files that are used to manage UNIX 
printer operations. These include the print 
spooler and a series of maintenance 
commands. 

Macintosh Operating System: The 
lowest-level software in the Macintosh. It 
does basic tasks such as I/O, memory 
management, and interrupt handling. 

Macintosh User Interface: The standard 
conventions for interacting with 
Macintosh computers. The interface 
ensures users a consistent means of 
interacting with all Macintosh computers 
and the applications designed to run on 
them. 

MacPartition: The name of the hard disk 
that contains a Macintosh partition with 
the A/UX Startup application. 

macro: A collection of instructions or 
requests invoked by a single name. 

mainframe computer: A central 
processing unit or computer that is larger 
and more powerful than a minicomputer 
or a personal computer (microcomputer). 
Frequently called mainframe for short. 

main logic board: A large circuit board 
that holds RAM, ROM, the 
microprocessor, custom-integrated 
circuits, and other components that make 
up the computer. 

main memory: The part of a computer's 
memory whose contents are directly 
accessible to the microprocessor. 
Programs and data are usually loaded into 
main memory, where the computer keeps 
information while you're working. 
Secondary memory stores the information 
when you are not using it. See also 
secondary memory. 

major number: One of two numbers 
contained in the inode for a device. The 
major number identifies a particular 
device driver (terminal, disk, and so on). 
See also minor number. 

makeflle: A file containing a collection of 
operations used by the make utility to 
construct related files. 
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menu: A list of choices presented by a 
program, from which you can select an 
action. With Macintosh-style programs, 
menus appear when you use the mouse to 
point to and press on titles in the menu 
bar at the top of the screen. Dragging 
through the menu and releasing the mouse 
button while a command is highlighted 
chooses that command. 

message list: An argument that allows 
you to specify a group of mail messages 
by number or name to various mail 

commands. 

message name: The login name of a user 
who sent you a message. The message 
name can be used as an argument to many 
mail commands. 

messages: A group of system calls that 
allow processes to communicate by 
sending formatted data streams to each 
other. 

metacharacter: A character interpreted 
by a program as standing for other 
characters or as designating a special 
function. For example, the ampersand (&) 
metacharacter at the end of a command 
line causes the shell to run the command as 
a background job. 

microcomputer: A computer, such as any 
of the Apple II or Macintosh computers, 
whose processor is a microprocessor. 

GL-16 A/UX Essentials 
030-0759-A 

minor number: One of two numbers 
contained in the inode for a device. The 
minor number provides a unit number for 
the device. See also major number. 

mode: See permissions. 

mount: To install a file system onto the 
directory hierarchy. See also unmount. 

mouse: A small device you move around 
on a flat surface next to your computer. 
The mouse controls a pointer on the 
screen whose movements correspond to 
those of the mouse . You use the pointer 
to select operations, to move data, and 
to draw with in graphics programs. 

mouse button: The button on the top of 
the mouse. In general, pressing the mouse 
button initiates some action on whatever 
is under the pointer, and releasing the 
button confirms the action. 

multitasking: The ability of an operating 
system like A/UX to execute multiple 
processes simultaneously by sharing its 
central processor and peripherals among 
processes. 

multi-user: A mode or ability of an 
operating system to support several 
people using the same computer 
simultaneously. 



network: A collection of interconnected, 
individually controlled computers, along 
with the hardware and software used to 
connect them. A network allows users to 
share data and peripheral devices and to 
exchange electronic mail. 

network administration: Management 
of the software and hardware that 
connects computers in a network. This 
includes such functions as assigning 
addresses to hosts, maintaining network 
data files across the network, and setting 
up internetwork routing. See also local 
system administration. 

Network File System (NFS): A protocol 
suite developed and licensed by Sun 
Microsystems that allows different makes 
of computers running different operating 
systems to easily share files and disk 
storage. 

newline: A character that indicates the 
end of a sequence of bytes. 
Conventionally, the UNIX operating 
system interprets the line feed character, 
the carriage return character, and both 
together, as a newline character. On the 
terminal, this character starts a new line by 
moving the cursor to the first position of 
the next line. From A/UX, the newline can 
be entered by pressing RETURN or by 
holding down CONTROL while pressing J. 

NFS: See Network File System. 

object ftle: The form of a routine 
produced by a language translator such as 
a compiler or assembler. An object file can 
be linked to other object files to build a 
program. See also source ftle. 

Open System Interconnection (OSI): A 
logical structure for network operations 
standardized within the ISO. OSI 
provides a network design framework to 
allow equipment from different vendors 
to be able to communicate. 

operating system: Low-level software 
that controls a computer by performing 
such basic tasks as I/O, memory 
management, and interrupt handling. 

OSI: See Open System Interconnection. 

packet: A unit of data and its control 
information transmitted across a 
network. A single message may be carried 
by one or more packets. 

page: In A/UX, a 4-kilobyte portion of a 
program that is defined by the kernel for 
transfer between main memory and disk 
storage. See paging. 

page fault: An interrupt that causes the 
page of data or code needed by a 
program to be read from disk storage into 
main memory. See also page and paging. 

page offset: The left margin of a printed 
page. The default page offset for both 
nroff and troff is 1 inch. 

page swapping: See paging. 
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paging: A method by which some 
operating systems (including A/UX) use 
secondary memory to store inactive 
portions of processes while active 
portions are held in main memory. When a 
process is executing, a portion of its code 
and data resides in main memory. Other 
portions, divided into pages, are 
automatically read in from disk storage as 
needed. When the system runs low on free 
main memory, the kernel makes more 
available by writing unneeded pages back 
out to disk. The kernel shuffles pages in 
and out of main memory and disk storage 
until the process has executed. Also called 
page swapping. 

parent process: A process that has 
forked a child process. See also 
child process. 

parity bit: A data communications bit 
used to verify that data bits received by 
one device match the data bits 
transmitted from another device. 

parity error: The condition resulting 
when the parity bit received by a device 
isn't what was expected. 

partition: A set of contiguous blocks on 
a physical disk. 
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pathname: A filename prefixed by its 
directory location. A pathname may 
contain a list of directories, separated 
from the filename and from each other by 
slashes. Each item in a pathname is 
located in the directory named to its left. 
For example, /etc/passwd is a 
pathname for the system password file, 
passwd, located in the et c directory 
beneath root (/). See also absolute 
pathname and relative pathname. 

peripheral device: A piece of hardware, 
such as a disk drive, modem, printer, or 
terminal, that is connected to a computer 
and used for reading or writing data. 

permissions: Authorization to read, 
write, or execute a file or directory. Under 
UNIX operating systems, each capability 
is assigned on an individual, group, and 
system-wide basis. Also called the 
file mode. 

physical disk: The entire set of disk 
blocks that exist on the actual disk drive 
hardware. 

PID: See process ID. 

pipe: (n.) (1) A command line that 
connects two or more commands in a 
series so that the output of one command 
becomes the input to the next. (2) An 
intermediate file in which data is passed 
from one process to another. (v.) To 
connect two or more commands in a 
series so that the output of one command 
becomes the input to the next. 



pipeline: See pipe. 

pointer: (1) A small shape on the screen 
that follows the movement of the mouse 
or shows where your next action will take 
place. The pointer can be an arrow, an 1-
beam, a crossbar, or a wristwatch. (2) An 
item of information consisting of the 
memory address of some other item. For 
example, Applesoft BASIC maintains 
internal pointers to the most recently 
stored variable, the most recently typed 
program line, and the most recently read 
data item, among other things. The 6502 
uses one of its internal registers as a 
pointer to the top of the stack. 

port: (n.) (1) A socket on the back panel 
of a computer where you plug in a cable 
for connection to a network or a 
peripheral device. (2) A connection 
between the central processor unit and 
main memory or a device (such as a 
terminal) for transferring data. (v.) To 
move software from one computer 
environment to another. 

positional parameter: A variable set on 
the command line of a shell script and 
operating as an argument to the script. 
This variable is called by number, usually 0 
through 9, within the shell script. The 
number refers to the position of the 
parameter on the command line. 

postftx notation: In programming 
languages, a type of notation in which the 
variable is followed by the operator (in C, 
for example, either ++ to increment the 
variable or - - to decrement the variable). 
Postfix notation changes the value of the 
variable after the value has been used. See 
also preftx notation. 

postftx operators: See postfix 
notation. 

postprocessor: A utility that accepts as 
its input the output from another utility. 
For example, p s di t is a postprocessor 
that accepts t r 0 f f output and 
transforms it into a form suitable for 
printing on Apple LaserWriters and other 
PostScript-supported printers. 

preftx notation: In programming 
languages, a type of notation in which the 
variable is preceded by the operator (in C, 
for example, either ++ to increment the 
variable or - - to decrement the variable). 
Prefix notation changes the value of the 
variable before using its value. See also 
postftx notation. 
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preprocessor: (1) A utility used to 
transform data that is then written to 
another utility. For example, tbl is a 
preprocessor that formats tables from 
properly coded text files; the output of 
this processor is usually piped to a more 
general text formatter like t ro f f. (2) A 
function of certain compilers that 
provides file inclusion, comment 
deletion, and macro substitution. 

print spooler: A utility that writes a 
representation of a document's printed 
image to disk or to memory, schedules it 
to print in a queue of other jobs, and then 
prints it. 

process: An instance of a program in 
execution. Usually one copy of a program 
is stored on a UNIX system like A/UX, but 
multiple instances of the program-each 
having its own address space-can be 
executed simultaneously as separate 
processes. 

process ID (PID): A unique number 
assigned to each process being executed 
on the system. The PID is listed with its 
associated command when you enter the 
p s command. The PID is sometimes 
called the process number. 
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process scheduling: Multitasking 
process management performed by the 
kernel. The central processor unit (CPU) 
can only execute processes one at a time. 
By equitably scheduling their execution, 
the kernel lets multiple processes share the 
CPU efficiently. 

process status: The names, states, and 
process numbers of commands submitted 
for execution; the p s command displays 
this information. 

program: A file containing coded 
instructions to the computer. A compiled 
program is a file created first in source 
code, then transformed by the compiler 
into object code. A shell script is a 
program that does not need to be 
compiled because it is interpreted by the 
shell. 

prompt: A character or string of 
characters displayed on the terminal when 
a program is waiting for input from you. 
The Bourne and Korn shells, for example, 
are set by default to display the dollar sign 
($) as their prompt; the C shell is set by 
default to display the percentage sign (%) 
as its prompt. 

protocol: A set of defined 
communications rules. 

pull-down menu: A menu that is hidden 
until you move the pointer to its title and 
press the mouse button. 



QuickDraw: The part of the Macintosh 
User Interface Toolbox that performs all 
graphic operations on the Macintosh 
screen. 

quoting mechanism: Special syntax in 
the command line that tells the shell to 
interpret metacharacters literally, or to 
control the type of substitution allowed 
in the command. 

radio button: A common type of control 
in dialog boxes. Radio buttons are small 
circles organized into families-clicking 
any button on turns off all of the others in 
the family, like the buttons on a car radio. 

raw I/O: Data transferred directly 
between a device and user address space. 
Raw I/O bypasses kernel buffers, resulting 
in faster data transfer. 

raw mode: A method of device driver 
operation that passes data between a 
terminal and a process without 
performing any conversions on the data. 
See also cooked mode. 

read permission: permission to read a 
file. 

real user ID: One of two user IDs 
associated by the kernel with a process 
(see also effective user ID). The real user 
ID identifies the user who is responsible 
for the process. 

record: A string of data whose structure 
and interpretation is determined by an 
application program. 

redirection: A feature of the shell that 
allows you to pass the output of a 
command to a file or device instead of to 
the terminal screen, and to supply a 
command with input from a file or device 
instead of from the keyboard. 

regular expression: A notation that uses 
a special set of metacharacters for 
specifying a text pattern. For example, 
the v i and e x editors use the A 

metacharacter at the beginning of a 
regular expression to stand for the 
beginning of a line; therefore the regular 
expression A A stands for the set of all lines 
that begin with an uppercase A. 

relative pathname: The name of a file, 
given by listing the directories leading to 
that file in relation to the current working 
directory. Directories common to both 
the working directory and the file are not 
included in the relative pathname. See 
also absolute pathname. 

remote system: On a network, any 
computer other than the local system. 

resource: (1) Synonymous with device 
driver. A printing resource is a system file 
that lets you print on a corresponding 
printer attached to the computer. 
(2) Data or code stored in a resource file 
and managed by the Resource Manager. 
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resource fork: The part of a file that 
contains data used by an application, 
such as menus, fonts, and icons. An 
executable file's code is also stored in the 
resource fork. Sometimes called a 
resource file. 

restricted shell (rsh): A program that 
confines a user to a subset of the A/UX 
system commands. 

ROM: An acronym for read-only memory, 
which is memory whose contents can be 
read, but not changed, and is used for 
storing permanent information. For 
example, the ROM in the Macintosh II 
contains the routines for the Macintosh 
user interface. 

root: (1) The top directory in a UNIX 
directory hierarchy. Written as a slash (/), 
it is the first element in every absolute 
pathname. (2) The user with unlimited 
system privileges. Also called the 
supernser. 

root directory: See root (1). 

root fue system: The file system that is 
always present on a UNIX system; the root 
file system can never be unmounted. 

root user: See root (2). 

routine: A part of a program that 
accomplishes some task subordinate to 
the overall task of the program. 

SCC: See Serial Communications 
Controller. 
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SCCS: See Source Code Control 
System. 

screen editor: A utility for entering and 
manipulating text. A screen editor 
displays the contents of a file by a full 
screen at a time. The commands to add or 
change text are entered anywhere on the 
screen, and the screen changes 
immediately to reflect the changes. The 
v i utility, for example, is a screen editor. 
See also line editor. 

script: A file containing commands. See 
also shell script. 

scroll bar: A rectangular bar that may be 
along the right or bottom of a window. 
Clicking or dragging in the scroll bar 
causes your view of the document to 
change. 

SCSI: See Small Computer System 
Interface. 

secondary memory: Data and program 
storage for a computer. Secondary 
melliory stores its information on physical 
media such as disk or tape. Secondary 
memory offers slower access time to data 
than main memory, but provides more 
capacity. See also main memory. 



secondary shell prompt: A character 
displayed by the shell when the shell 
expects further input from you. For the 
Bourne and Korn shells, this character is 
set by default to be the greater-than sign 
(> ), while for the C shell it is set as the 
question mark (?). The prompt appears, 
for example, when you use a multiline 
construct at the initial shell prompt. The 
secondary shell prompt reappears on each 
line until the final delimiter or the 
interrupt character is entered. 

select: (v.) To designate where the next 
action will take place. To select using a 
mouse, you click an icon or drag across 
information. In some applications, you 
can select items in menus by typing a 
letter or number at a prompt, by using a 
combination keypress, or by using arrow 
keys. (n.) A command to a device such as 
a printer to place it into a condition to 
receive data. 

semaphores: A group of system calls that 
allow processes to synchronize execution. 

serial communication: Data 
communicated over a single-path 
communication line, one bit at a time. 

Serial Communications Controller 
(SCC): The chip on the Macintosh II main 
logic board that handles serial I/O through 
the modem and printer ports. 

serial lines: Data transmission lines over 
which information is transmitted 
sequentially, one bit at a time. 

server: A computer that provides a 
particular service across a network. The 
service may be file access, login access, 
file transfer, printing, and so on. 
Computers from which users initiate the 
service are called clients. 

setuid: A subroutine for setting the real 
and effective user ID. 

shared memory: A mechanism that 
allows processes to share parts of their 
virtual address space with each other. 

shell: A utility that accepts your 
commands, interprets them, and passes 
them on to the appropriate programs for 
execution. A/UX provides three shells: 
Bourne, C, and Korn. Each can be used as 
an interpreted programming language. 
Through shell variables and 
environment variables, you can tailor 
the environment of your shell for your own 
needs. 

shell command: See built-in shell 
command. 

shell layer: An instance of a shell, 
invoked by the s h 1 program. Through 
this program, you can simultaneously run 
up to seven shell layers. 
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shell program: A series of commands to 
be executed by the shell. A shell program 
may be entered at the shell prompt or 
stored in a file. Shell programs that are 
stored in files are referred to as shell 
scripts. Shell programs are sometimes 
called user-defined commands. 

shell prompt: A character or string of 
characters displayed on the terminal to 
show that the shell is waiting for input 
from the user. The Bourne and Korn shells, 
for example, are set by default to display 
the dollar sign ($) as their prompt; the C 
shell is set by default to display the 
percentage sign (%) as its prompt. 

shell script: A shell program contained in 
a text file. Entering the name of the shell 
script from the command line executes 
the commands listed in the shell script. 

shell variable: A variable local to the 
shell. A shell variable is available only to 
the current invocation of the shell, not to 
any of its subshells or spawned processes. 
See also environment variable. 

Shift-click: A technique that allows you to 
extend or shorten a selection by 
positioning the pointer at the end of what 
you want to select and holding down the 
Shift key while clicking the mouse button. 

shutdown permission: Access granted 
to the root user to run the shutdown 
program. The shutdown program brings 
the system to an almost inactive state 
before you turn off its power. 
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signal: A software interrupt that causes a 
program to be temporarily diverted from 
its normal execution sequence. A/UX uses 
both System V and BSD signals. Signals 
can be issued, handled, and otherwise I 

manipulated via a set of system calls. 

signal catcher: A function that detects 
the interrupt sent from a signal system 
call. See also signal. 

signal handler: A function that performs 
the required processing upon receipt of a 
signal. See also signal. 

size box: A box in the lower-right corner 
of some active windows. Dragging the 
size box resizes the window. 

Small Computer System Interface 
(SCSI): A specification of mechanical, 
electrical, and functional standards for 
connecting small computers with 
intelligent peripherals such as hard disks, 
printers, and optical disks. 

socket: On a network, a communication 
mechanism originally implemented on the 
BSD version of the UNIX operating 
system. Sockets are used as endpoints for 
sending and receiving data between 
computers. 



Source Code Control System (SCCS): 
A collection of commands used to control 
changes to text files, such as source code 
and documentation. sees protects files 
by controlling access and update 
privileges, and by preventing more than 
one user at a time from updating a file. 
sees also maintains an audit trail of 
revisions. 

source fue: A text file containing coded 
instructions to the computer. A source file 
generally cannot be executed by the 
computer; instead, the source file must be 
compiled and linked to produce an 
executable program. 

spawn: To create and execute a new 
process with the fork and exec system 
calls. 

special fue: See device fue. 

spooler: See print spooler. 

Stand-Alone Shell: The sash application 
that launches NUX. You can run a limited 
number of system administration 
commands from the Stand-Alone Shell. 

standard error output: The data stream 
used for error messages returned by a 
program. By default, the shell directs error 
output to your terminal screen. 

standard input: The data stream used 
for input to a command. By default, the 
shell accepts as input the characters you 
type from your keyboard. The less-than 
sign «) directs the shell to accept input 
from a file or device. 

standard output: The data stream used 
for output from a command. By default, 
the shell directs this to the terminal 
screen. The greater-than sign (» directs 
the shell to write the output to a file or 
device. 

start bit: A serial communications bit 
that signals that the next bits transmitted 
are data bits. 

stop bit: A serial communications bit 
that signals the end of data bits. 

stream editor: A utility for manipulating 
text. Rather than allowing you to move 
back and forth within a file interactively, 
a stream editor processes the text in a 
single pass. The sed utility, for example, 
is a stream editor. See also interactive 
editor. 

Streams: A collection of tools that assist 
programmers to modularize data transfer 
between device drivers and processes. 

string option: A setting specified by a 
set of characters. 

subdirectory: A directory that is 
subordinate to another directory. 
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subshell: A new shell that is created from 
an existing shell. The subshell, or "child" 
shell, inherits the environment of its 
parent. 

substitute user (su): The substitute user 
command (su) allows you to work in an 
account other than the one you are 
currently logged in to. 

superblock: The block following the 
boot block on every file system. The 
superblock contains the main information 
about the file system, such as its name, its 
size, and lists of the free blocks and free i
nodes. 

superuser: The user with unlimited 
system privileges. Also called root. 

suspend character: From the shell, a 
character (by default, CONTROL-Z under 
A/UX) that stops the foreground job and 
returns you to the shell. Entering the 
command f g brings the suspended job 
back to the foreground, where it resumes 
execution. 

SVID: See System V Interface 
Deftnition. 

swap space: A disk partition used for 
temporarily storing unneeded pages of 
code and data. See also page and paging. 
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synchronous communication: A 
method of data transmission that uses a 
docking signal on both the sending and 
the receiving device to ensure an integral 
number of time intervals between 
characters. See also asynchronous 
communication. 

system call: A kernel-level procedure 
that can be invoked by any application. 
System calls are documented in Section 2 
of A!UX Programmer's Reference. 

System V: The AT&T standard UNIX 
operating system. System V Release 2 
forms the foundation of the A/UX system. 

System V Interface Defmition (SVID): 
AT&T's formal specification for 
compatibility with the UNIX operating 
system. A/UX adheres fully to the SVID. 

System Folder: The Macintosh folder 
containing the System file and related 
utilities. 

system mailbox: A file in Ius rima i 1 

for holding your incoming electronic mail 
messages until you read them, at which 
time they are appended by default to the 
file mbox in your home directory and 
deleted from lusr Imail. 

TCP /IP: See Transmission Control 
Protocol/Internet Protocol. 



terminal: A device through which you 
interact with the computer; namely, the 
keyboard, mouse, or other input device 
and the monitor. See also console. 

terminal emulation: An imitation of a 
terminal type. 

text box: The place or places in any 
dialog box where you can type 
information. 

text ftle: A file containing information 
expressed in text form and whose 
contents are interpreted as characters 
using the American Standard Code for 
Information Interchange (ASCII) format. 
See also binary ftle. 

text only ftle: See text ftle. 

32-bit clean: Macintosh applications 
whose mamory addressing is completely 
compatible with A/UX 2.0. Software that 
is not 32-bit clean is referred to as 24-bit 
addressed. A/UX 2.0 allows you to select a 
24-bit addressed session type if you need 
to use older Macintosh applications that 
are not 32-bit clean. 

tilde escape: The tilde character (~), 
used as an escape character to signal that 
the next input string is a command. 

tile: To arrange a group of windows so 
that their edges are touching one another 
(like the tiles on a tiled floor), rather than 
overlapping one another. 

title bar: The horizontal bar at the top of 
a window that shows the name of the 
window's contents. You can move the 
window by dragging the title bar. 

toggle option: See toggle variable. 

toggle variable: A setting for the shell 
environment that may be turned ON or 
OFF with the set or unset command. 
For example, the set noclobber 

command entered from the C shell turns 
on a toggle variable that helps ensure 
existing files are not accidentally 
overwritten. 

token: A sequence of characters 
delimited so as to be identified by a 
compiler. 

Transmission Control 
ProtocoVInternet Protocol 
(TCP lIP): A suite of networking 
protocols developed initially for the U.S. 
Department of Defense. 

tree structure: The layout of a UNIX 
directory hierarchy. Organized like an 
inverted tree, the directory hierarchy 
begins with the root directory at the top. 
Branching downward from the root are 
the rest of the directories and files in the 
system. 

tty: A terminal; tty is abbreviated from 
teletypewriter) which was the first terminal 
device used on the UNIX operating 
system. 
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UFS: UNIX file system, a synonym for 4.2 
or BSD file system .. 

uid: See user ID. 

umount: A system-administration 
command that removes a local file 
system. 

24-bit addressed: See 32-bit clean. 

UNIX operating system: A general
purpose time-sharing system and related 
set of utilities, originally developed at 
AT&T Bell Laboratories. A/UX is an 
enhanced version of the UNIX operating 
system for the Macintosh SE/30 and 
Macintosh II family of computers. 

unlink: To remove a directory entry for a 
file. See also link. 

unmount: To remove a file system from 
the directory hierarchy. See also mount. 

user-defmed command: See shell 
program. 

user ID: A number that identifies a user 
at the time of login. Often called u i d. 

user interface: The rules and conventions 
by which a computer system 
communicates with the person 
operating it. 

user name: See login name. 
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user permission: Permission for the 
ower of the file to use it. If a file has only 
user permission, no other users may read 
it, write to ir, or run it. 

utility: A software tool used for building 
or maintaining systems or applications. 
UNIX provides hundreds of utilities, 
including compilers, editors, and text 
formatters. 

volume: A piece of storage medium 
formatted to contain files. A volume can 
be an entire disk or only part of a disk. 

wide area network (WAN): A system of 
interconnected local area networks that 
spans a wide geographical area. 

window: (1) The area that displays 
information on a desktop; you view a 
document through a window. You can 
open or close a window, move it around 
on the desktop, and sometimes change 
its size, scroll through it, and edit its 
contents. (2) The portion of a collection 
of information (such as a document, 
picture, or worksheet) that is visible in a 
viewport on the display screen. Each 
window is internally represented in a 
window record. 

word: (1) The computer's native unit of 
data. The Macintosh II uses a 32-bit word. 
(2) For the shell and other programs, a 
string of nonblank characters bounded by 
the space character, the tab character, or 
the beginning or the end of the input line. 



working directory: See current 
directory. 

world permission: Permission for all the 
users of a system to use a file. 

write permission: Permission to write to 
a file. 

Yellow Pages: A network database 
facility for sharing a common database of 
user information across a local area 
network. 

zoom box: A small box with a smaller box 
enclosed in it found on the right side of 
the title bar of some windows. Clicking 
the zoom box expands the window to its 
maximum size; clicking it again returns 
the window to its original size. 
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Index 

I (vertical bar) pipe character 4-15 

A 

absolute pathnames 2-55 
access permissions, default settings 2-29 
active window 2-3 
Active Window Settings command 5-19 
Active Window Settings dialog box 5-20 
addcmd command 2-15 
Add Command dialog box 2-17 
adduser command 2-16 
alerts, AlUX System Console 5-17, 5-22, 10-5 
Align command 6-29 
AppleShare access 8-13 
AppleTalk, printing through 7-8 
AppleTalk printer, selecting 7-6 to 7-8 
application icon 2-12 
apropos command 2-15 
Auto Indent check box 6-27 
AlUX file hierarchy icon 2-12 
AlUX Finder 1-12 
AlUX Startup application 1-3, 1-4 
AlUX System Console command 5-17, 1-22 
AlUX System Console window 5-17 to 5-18 

alerts 5-17, 5-22, 10-5 
AlUX text files, printing 7-5, 7-8 

B 

backing up files 
cpio (copy in and out) 2-50, 2-52 
drag-copying to disk 2-49 

Bourne shell 5-2 
bullets in icon names 6-3 
By Name command 2-14 

c 
C shell 5-2 
Cancel button 4-8 
cancel command 7-10 
cat command 4-5 
cd command 2-21 
Change Password command 1-14 
Change Session Type command 1-14, 1-15 
Change Session Type dialog box 1-16 
changesize dialog box 10-9 
changesize icon 10-8 
changing default shell 5-2 
changing shells 5-2 
check boxes 4-7 
chmod command 2-15, 2-24 
chmod dialog box 2-25 
Chooser command 7-7 
Chooser dialog box 7-7 
chown command 2-20 
chsh command 5-2 
Clear Lines Off Top command 5-12, 5-17 
clipboard 6-11 
Close All Windows command 5-16 
Close command (in CommandShell) 5-16 
command arguments 4-5 
command line 4-2 

chmod 2-24 
commands 

about A/UX commands 4-2 to 4-5 
AlUX System Console 5-17, 5-22 
Active Window Settings 5-19 
addcmd 2-15 
adduser 2-16 
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commands (continued) 
Align 6-29 
apropos 2-15 
By Name 2-14 
cancel 7-10 
cd 2-21 
Change Password 1-14 
Change Session Type 1-14, 1-15 
chmod 2-15, 2-24 
Chooser 7-7 
chown 2-20 
chsh 5-2 
Clear Lines Off Top 5-12, 5-17 
Close (in CommandShell) 5-16 
Close All Windows 5-16 
CommandShell 5-3 
Copy (in CommandS hell) 5-25 
csh 5-2 
Cut 6-11 
d 8-11 
da te 2-16, 4-3 
df 2-16 
diff 2-15 
Don't Record Lines Off Top 5-12 
Duplicate 2-35, 2-36 
Empty Trash 2-34, 2-38, 8-6 
Find (in TextEditor) 6-20 
find 2-15, 2-41 
Finder 1-20, 1-23 
Find File 2-39 
Format 6-25 to 6-28 
fsentry 2-16 
grep 2-15 
h 8-10 
Hide 5-14 
Hide CommandS hell Windows 5-28 
ksh 5-2 
Last Window 5-15 
Logout 1-17 
lpq 7-9 
lpr 2-15,7-5, 7-8, 7-9 
lprm 7-10 
1 s 2-15 

IN-2 A/UX Essentials 
030-07S9-A 

commands (continued) 
ls -1 2-22 
mail 8-4 to 8-11 
man 1-18, 2-15, 4-3 
Mark 6-33, 6-34 
mount 2-16 
New (in CommandShell) 5-4 
newconf ig 2-16 
New Folder 2-33 
New Window Settings 5-21 
Notification Levels 5-23 
Open (in TextEditor) 6-15 
Open (in Finder) 1-20 
Open (in CommandShell) 2-21 
Page Setup 7-11 
Paste (in CommandShell) 5-25 
Paste (in TextEditor) 6-11 
Print 7-5 
Print Selection 5-27, 7-11 
ps 2-15 
Put Away 1-13 
q 8-12 
Quit Gn TextEditor) 6-38 
Quit (at startup) 1-21, 1-22 
Replace 6-22 
Restart 1-22, 1-27 
Restore from Preferences 5-19 
Revert to Saved Gn TextEditor) 6-14,6-19 
Rotate Windows 5-15 
Save Gn TextEditor) 6-14 
Save a Copy Gn TextEditor) 6-14 
Save As Gn TextEditor) 6-13,6-14 
Save Preferences 5-18, 5-19 
Save Selection (in CommandShell) 5-26 
Save Window Layout 5-18 
Search Here 2-40 
Select All (in CommandShell) 5-27 
Set Startup 1-3 
setport 2-16 
settimezone 2-16 
sh 5-2 
shell script 3-4 
Shift Left/Right 6-28 



commands (continued) 
Show All Windows 5-15 
Show Clipboard 6-11 
Show Invisibles 6-28 
Shut Down 1-26 
sort 2-15 
Stack Windows 6-31 
Standard Positions (in CommandShell) 5-9 
su 1-25 
Tile (in CommandS hell) 5-6 
Tile Horizontal 5-7 
Tile Vertical 5-8 
Tile Windows 6-30 
umask 2-30 
umount 2-16 
Unmark 6-35 
in Useful Commands folder 2-15 to 2-16 
w 2-15 
whereis 2-15 
whoami 1-23 
x 8-12 

CommandShell 
leaving 5-27 
presetting defaults for new windows 5-21 
printing from a window 5-27, 7-10 
saving the window layout 5-18 
showing hidden windows 5-14 

CommandShell command 5-3 
CommandShell windows 

changing default settings 5-20 
displaying 5-4 
erasing recorded lines 5-12 
hiding 5-13 to 5-14, 5-28 
horizontal tiling 5-7 
moving to foreground 5-15 
printing from 5-27, 7-9 
recording lines scrolled off top 5-10 
tiling 5-5 
untiling (standard position) 5-9 
vertical tiling 5-8 
viewing recorded lines 5-12 

compound command line 4-15 
Console Emulator option 1-16 

copying between documents (TextEditor) 6-18 
Copy command (in CommandS hell) 5-25 
cpio (copy in and out) utility 2-50 to 2-52 
c s h command 5-2 
C shell 5-2 
current system folder icon 2-8 
Cut command 6-11 
cutting and pasting text (TextEditor) 6-10 to 6-12 

D 

d command 8-11 
datafile icon, nonexecutable 2-10 
date command 2-16, 4-3 
default file access permissions 2-29 to 2-30 
default text editor, changing 6-3 
deleting mail messages 8-11 
desk accessories 3-9, 9-4 
desktop database, rebuilding 10-6 
d f command 2-16 
di f f command 2-15 
directories 

defined 4-12 
printing 9-8 
root 2-53 

directory and folder access permissions 
2-27 to 2-28 

changing 2-28 
checking 2-7 to 2-8 
default settings 2-29 to 2-30 
types of 2-28 

disks, floppy, using to make backups 2-46 to 2-51 
disk initialization dialog boxes 2-48, 2-49 
displaying CommandShell windows 5-4 
Don't Record Lines Off Top command 5-12 
dot files 6-3 
drop box folder, permissions 28 
drop box icon 2-8 
Duplicate command 2-35, 2-36 

E 

editing an existing file (TextEditor) 6-15 to 6-24 
Empty Trash command 2-34, 8-6 
entering text (Text Editor) 6-8 to 6-10 
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error redirection 4-8 
execute permission 

for files 2-19 
for folders 2-27, 2-28 

exiting from mail utility 8-12 

F 

file access permissions 
changing 2-23 
checking 2-20 
default settings 2-29 
types of 2-19 

file buttons 4-7 
file icons 2-9 to 2-11 
File system full message 10-5 
files 

copying 2-36 
creating 2-35 
icons 2-8 to 2-12 
locating 2-39 
moving 2-37 
opening 2-35 
removing 2-38 
renaming 2-37 

Files to Change dialog box 2-26 
file systems 

icons 2-12 
moving Macintosh and AlUX files between 

systems 2-45 
Find command (in TextEditor) 6-20 
find command 2-15, 2-41 to 2-45 
Find dialog box 6-21 
Finder 

AlUX 2.0 2-2 
menus in 2-5, 9-2 to 9-18 
using 2-3 to 2-4 

Finder command 1-20 
Find File command 2-39 
Find File dialog box 2-39 
finding text (TextEditor) 6-20 to 6-22 
flag options 4-5 
floppy disks, using to make backups 2-46 to 2-51 
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folder access permissions 2-27 to 2-28 
changing 2-28 
checking 2-7 to 2-8 
default settings 2-29 to 2-30 
type of 2-28 

folder icons 2-7 to 2-8 
folders 

creating a new folder 2-32 
icons 2-7 to 2-8 
moving from one to another 2-32 
removing 2-34 
selecting 2-31 

fonts 3-5 to 3-9 
installing 3-6 to 3-8 
removing 3-8 to 3-9 
selecting in Text Editor 6-25 

Format command 6-25 to 6-28 
Format dialog box 6-25 to 6-28 
fsentry 2-16 

G 

global System Folder 3-2 
grep command 2-15, 4-6 
group permission for file access 2-20 
Guest account, logging in 1-9 

H 

h command 8-10 
Help box 4-7 
Hide command 5-14 
Hide CommandShell Windows command 5-28 
hiding CommandShell windows 

active window 5-13 to 5-14 
all windows 5-28 

highlight 3-17 
home directory folder 1-13 

I, J 
icons (Finder) 2-5 to 2-13 

not appearing 10-6 
incorrect password 10-3 



Internet 8-8 
invisible characters in TextEditor 6-27 to 6-28 

K 

Korn shell 5-2 
ksh command 5-2 

L 

lack of power 10-2 
Last Window command 5-15 
logging in 

Guest account 1-9 
Options menu 1-13 
problems 10-3 
root account 1-10 
tutorials 1-7 
user account 1-10 to 1-11 

logging out 1-18 
Login dialog box 1-7, 1-14 

for Guest account 1-9 
login name 1-6 

for tutorial account 1-8 
Logout command 1-17 
long listing 2-20 
1 p q command 7-9 
lpr command 2-15, 7-5, 7-8, 7-9 
lprm command 7-10 
ls command 2-15, 4-11 
ls -1 command 2-22 

M 

Macintosh file systems and programs 1-19 
Macintosh floppy disk icon 2-13 
Macintosh hard disk icon 2-13 
Macintosh OS 

switching to 1-21 to 1-23 
MacPartition folder 1-4 
ma i 1 command 8-4 to 8-11 

mail utility 
canceling a message 8-6 
deleting a message 8-11 
exiting 8-12 
reading mail 8-10 
receiving mail 8-10 
saving a message 8-11 
sending to several users 8-9 
using Internet 8-8 
using UUCP 8-8 

man command 1-18, 2-15, 4-3 
manual page 4-3 
Mark command 6-34 
Mark dialog box 6-34 
markers 6-32 to 6-36, 9-39 
Mark menu 6-33 
mount command 2-16 
moving Macintosh and A/UX files between 

systems 2-45 
MultiFinder 2-3 

N 

New command (in CommandS hell) 5-4 
newconfig command 2-16 
New Folder command 2-33 
New Window Settings command 5-21 
New Window Settings dialog box 5-21 
NFS (Network File System), sharing files 8-13 
Notification Levels command 5-23 

o 
on-line manual pages 1-18 
Open command (in CommandShell) 2-21 
Open command (in Finder) 1-20 
Open dialog box (in TextEditor) 6-16 
output and error redirection 4-8 
owner permission for file access 2-20 
ownership, file or folder 2-20 
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p 

Page Setup command 7-11 
password 1-6, 1-9, 1-11 

changing 1-14 
start account 1-8 

Paste command (in CommandShell) 5-25 
Paste command (in TextEditor) 6-11 
pathnames 

absolute 2-55 
definitions 2-53 
relative 2-55 

permissions (directory and folder access) 
2-27 to 2-28 

changing 2-28 
checking 2-7 to 2-8 
default settings 2-29 to 2-30 
type of 2-28 

permissions (file access) 
changing 2-23 
checking 2-20 
default settings 2-24 
types of 2-19 

personal System Folder 3-2, 3-4 
pipe character (I) 4-15 
piping commands 4-15 
power, lack of 10-2 
POWER ON 1-2 
Print command 7-5 
Print dialog box (in CommandShell) 5-27, 7-11 
Print dialog box (in TextEditor) 6-36 
print queue 7 -5 
Print Selection command (in 

CommandShell) 5-27, 7-11 
print spooler 7-5 
printers 

failing to respond 10-6 
selecting with the Chooser 7-6 
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printing 7-1 to 7-11 
NUX test files 7-5 to 7-10 
cancelling 7-10 
CommandShell window contents 5-27, 7-9 
destinations 7-8 to 7-9 
Macintosh documents from A/UX 7-4 
from TextEditor 6-33 to 6-34 

printing queues 7-9 to 7-10 
ps command 2-15 
Put Away command 1-13 

Q 
q command 8-12 
Quit command (in TextEditor) 6-38 
Quit command (at startup) 1-21, 1-22 

R 

radio buttons 4-7 
reading mail 8-10 
read-only icon (in TextEditor) 6-17 
read permission 

directory and folder access 2-28 
file access 2-19 

receiving mail 8-10 
recording lines scrolled off CommandS hell 

windows 5-10 
relative path names 2-55 
Replace command 6-22 
Replace dialog box 6-22 
resource fork (for saving formatting information) 

6-2,6-14 
Restart command 1-22, 1-27 
Restart dialog box 1-22 
restarting 1-22 
Restore From Preferences command 5-19 
restoring from backups 

clicking and dragging 2-50 
cpio (copy in and out) 2-51, 2-52 

Revert to Saved command (in 
TextEditor) 6-14, 6-19 



Revert to Saved dialog box 6-19 
root account, logging in 1-10 
root directory 2-53 
Rotate Windows command 5-15 

s 
Save a Copy command (in TextEditor) 6-14 
Save As command (in TextEditor) 6-13, 6-14 
Save As dialog box (in TextEditor) 6-13 
Save Before Quitting dialog box 6-38 
Save Changes dialog box 6-20 
Save command (in TextEditor) 6-14 
Saved Changed Preferences dialog box 5-28 
Save Preferences command 5-18, 5-19 
Save Selection command (in 

CommandShell) 5-26 
Save Selection dialog box 5-26 
Save Window Layout command 5-18 
saving 

files in TextEditor 6-12 to 6-14 
mail messages 8-11 

screen or computer frozen 10-4 
Search Here command 2-40 
Search Here dialog box 2-40 
searching for text (TextEditor) 6-20 to 6-22 
Select All command (in CommandShell) 5-27 
session types 1-16 
Set Startup command 1-3 
setport command 2-16 
settimezone command 2-16 
sh command 5-2 
shells 5-2 
shell script icon 2-11 
shell scripts, default permissions 2-29 
Shift Left/Right command 6-28 
Show All Windows command 5-15 
Show Clipboard command 6-11 
showing hidden CommandS hell windows 5-14 
Show Invisibles check box 6-28 
Shut Down command 1-26 
Shut Down dialog box 1-27 
shutdown procedure 1-26 to 1-27 
shutdown warning 10-5 

SIZE Flags dialog box 10-10 
sort command 2-15 
Stack Windows command 6-31 
standard file dialog box (in TextEditor) 6-2 
Standard Positions command (in 

CommandS hell) 5-9 
Starting directory(s) dialog box 2-42 
su command 1-25 
substitute user (su) 1-25 
superuser 2-19 
system administration 1-28 
System Console window 5-17 to 5-18 
systemfolder shell script 3-4 

T 

tab settings in TextEditor 6-25 to 6-26 
terminology conventions xxx 
TextEditor 6-1 to 6-38 

aligning text 6-29 
Auto Indent check box 6-26 
changing tab settings 6-25 to 6-26 
Clipboard 6-11 
copying between documents 6-18 
cutting and pasting text 6-10 to 6-12 
description of 6-2 
editing an existing file 6-15 to 6-23 
entering text 6-8 
fonts, selecting 6-25 
invisible characters, showing 6-27 
marking text 6-32 to 6-36 
printing a document 6-36 to 6-37 
quitting 6-38 
replacing text 6-22 
resource fork (for saving formatting 

information) 6-2, 6-14 
saving a new document 6-12 to 6-13 
searching for text 6-20 to 6-23 
shifting text left or right 6-28 
tiling and stacking windows 6-30, 6-31 
unmarking text 6-35 

text fields 4-7 
text file icon 2-9 
text files, printing 7-9 
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the da t e command 3-17 
Tile command (in CommandShell) 5-6 
Tile Horizontal command 5-7 
Tile Vertical command 5-8 
Tile Windows command 6-30 
tiling CommandShell windows 5-6 to 5-9 

horizontal 5-7 
vertical 5-8 

troubleshooting 10-1 to 10-10 
tutorials, logging in for 1-7 

u 
uma s k command 2-30 
umount command 2-16 
UNIX command icon 2-10 
Unmark command 6-35 
Unmark dialog box 6-35 
untiling CommandShell windows (standard 

position) 5-9 
Useful Commands folder 4-9 

adding new commands 2-16 
using 2-13 to 2-18 

user accounts 3-5 
changing 1-25 
logging in 1-10 to 1-11 

UUCP 8-8 

v 
vi (visual editor) 6-2, 9-32 

w 
we command 4-17 
w command 2-15 
whereis command 2-15 
whoami command 1-23 
windows 

closing 5-16 
hiding 5-13 to 5-14, 5-28 
tiling 5-6 to 5-9 

world permission for file access 2-20 
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write permission 
directory and folder access 2-27, 2-28 
file access 2-19 

X,Y,Z 

x command 8-12 
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